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Welcome to Merging Technologies Ovation!

Introduction

Thank you!

Congratulations on your purchase of the Ovation Media Server & Sequencer.

Ovation is a ground-breaking Media Server and Sequencer with the tools you need to produce and run shows in
many spheres of activity. For example:

Theatres

Theme Parks
Museums

TV Game Shows
Trade Shows

AV Presentations
Radio stations
Retail Outlets

are just a few of the possible applications for Ovation.

Note: IMPORTANT! - The first thing you need to do is register your software to acquire
your security key(s) and to be included in our user support list.

Please also subscribe to the User Forum at:

http://www.merging.com/forum/

PLEASE DO NOT PRINT THIS DOCUMENT UNLESS ABSOLUTELY NECESSARY
SAVE TREES AND INK BY USING THE HYPERLINKS

‘ Welcome to Merging Technologies Ovation! : Introduction
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Contacting Merging

International Office:

UK:

USA:

‘AMERGING

Merging Technologies S.A.

Le Verney 4

CH-1070 Puidoux

Switzerland

Phone: +41 21 946 0444
Fax: +41 21 946 0445

Merging UK (Emerging Ltd)

23 Campbell Court

Campbell Road

Bramley

Hampshire

RG26 5EG

UK

Phone: +44 (0) 118 402 5090
Fax: +44 (0) 870 123 1747

Email: sales@merginguk.com

Merging USA (Independent Audio)

43 Deerfield Road

Portland,

ME 04101-1805

United States of America

Phone: +1(207) 773 2424
Fax: +1(207) 773 2422

For all documentation inquiries or suggestions for improvement:
http://www.merging.com

Welcome to Merging Technologies Ovation! : Contacting Merging
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Overview

Ovation enables the user to run Cues of many Media and Command types, either manually like a spot player / car-
tridge machine or automatically against Run-time, Time-of-day or external LTC or MIDI TimeCode. The Ovation
Sequencer can be controlled from a hardware controller, touch screens, GPIs, Sony 9-pin (P2) Protocol commands
and MIDI.

Audio recording is also possible.

Scope

Ovation can control Audio, GPOs, MIDI Files, MIDI Commands, Sony 9-pin (P2 protocol commands over RS422 or
ethernet (IP), IP commands, MMC, MTC TimeCode and Shell Commands/Scripts/batch Files. The Ovation Mixer can
be automated under Ovation control.

Ovation can be controlled via a dedicated Hardware Controller, Touch Screens, MIDI and GPIs. The Ovation Mixer
can be remote controlled via EMC or Eucon. The Merging Technologies ISIS remote controller is not supported.

Evaluation Mode

If you have not entered a valid key Ovation will run in Evaluation Mode.

Everything works in the same way as the full version but only one Cue List can be saved or loaded with a Show.

Latency

Minimum latency will only be achieved in systems running in Native or MassCore™ modes. Under MassCore™
the fire latency will be between 45ms and 66ms, plus the time required by the triggering device (USB, GPI/O,
etc...). The dedicated Ovation hardware controller typically gives rise to an additional 10ms latency.

Note: All automatically triggered events are sample accurate. For example when a rule
fires a Cue.

Audio Formats Supported

For the full list of supported audio formats please see the Pyramix User Manual.

‘ Welcome to Merging Technologies Ovation! : Overview
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Ovation Documentation and Help

ToolTips

Ovation Software is equipped with “ToolTips. Hovering the mouse cursor over a tool icon pops-up a box with the
name of the function.

Documentation
All the documentation is in the Adobe Acrobat pdf format. (.pdf file extension)

In order to read the documentation you will need to have Adobe Acrobat Reader V6 or later installed on your
computer.

Note: All Contents entries, Index entries and Cross-references are hyperlinks for rapid
navigation.

This Ovation User Guide and the Pyramix User Manual may be opened from the Help menu. Other documenta-
tion can be found in the Windows Start menu in All Programs > Pyramix > Docs. Please check for the most
recent versions at:

http://www.merging.com/downloads
Support
If you cannot find an answer to a query in the documentation, please consult the on-line support at:

http://www.merging.com/contact/tech-support
where you will find answers to F.A.Q.s (Frequently Asked Questions) and further support.

Assumptions

This Ovation User Guide and other documentation assume you are thoroughly familiar with PCs and Windows
terms and concepts. If self installing to a new PC, please ensure the machine is working correctly before attempt-
ing to install Ovation.

Conventions
Conventions used in Merging Technologies Documents:

Names found on screens and in menus are shown in bold. E.g. Information & Settings

Menu and sub-menu selections are shown like this:

Show > Recent Shows : Quickstart

Which means:

Go to the Show pull-down menu, mouse down to the Recent Shows sub-menu and choose Quickstart.

The Settings dialog Has its own hierarchical tree structure in the left hand pane with folders leading to pages.

‘ Welcome to Merging Technologies Ovation! : Ovation Documentation and Help
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QUICKSTART

Overview
This section provides a step-by-step guide to creating a simple new Show and configuring the mixer. It includes:

adding Cues to Cue Lists, several different types of Cue List, Running the Show and Firing Cues and Cue Lists.
Note: This section is not intended as a substitute for the more detailed information to be

found elsewhere in this guide.

A First Simple Show

The following prior steps are assumed:

Ovation hardware and software installation has been completed.

A means of monitoring has been connected to the physical I/0.

The software has been registered, the registration key(s) entered and the initial settings entered in the
VS3 Control Panel.

Launch Ovation
Double-click the Ovation icon:

TrrEsRTERRTTEEY,

|_Ovation_|

Alternatively, click on Start > All Programs > Merging Technologies > Ovation : Ovation

Ovation will open with an empty main window and the New Show dialog opens.

‘ QUICKSTART : A First Simple Show
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New Show

e

Start with a Template Show @ OV AV Default Show  192% -

-
,.

@) Start with a single Cue List : Standard Cue List - |

7| Setup & new Show Workspace
Chow Mame
A First Simphe Showd

Show & Media Location

F:Owvation First

New Show dialog

Start with a template show When selected you can choose a preexisting template from the list in the right-
hand pane.

Start with a single Cue List When selected the Show will open with a single Cue List ready created. The combo
box shows the type of Cue List which will be created. The arrow drops down the
list of types available.

Standard Cue List

Timed Cue List

Hot Keys

Custom Keys

Cue Browser

Hot Browser
Set up a new Show Workspace : When ticked a new Show Workspace will be created for the new Show.
Show Name Type a suitable name for the new Show in this field.

Show & Media Location The field shows the path to where the Show and associated files will be stored.

‘ QUICKSTART : A First Simple Show
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Clicking on the ... button opens a Browse For Folder dialog :

Choose a Location for your new Show

Bl Desktop
* = Libraries
i& Hormegroup
| B Rob
1M Computer
E‘li Metwark
-8 Control Panel

£ Recycle Bin

Adobe Reader 9 Installer

Ok ] | Cancel

Browse For Folder dialog

The Browse For Folder dialog functions the same way as other Windows browsers. navigate to the location you
wish to store the new project and select the desired folder or use the Make New Folder button to create and
name a new one. Click on OK to create the new folder and close the dialog. The Cancel button closes the dialog
without selecting a new location.

For the purposes of this first simple Show select:

Start with a single Cue List: Standard Cue List

Tick Setup a new Show Workspace (If not already ticked (default).

Type a suitable name for the Show

Navigate to a suitable location to store the Show (Create a new folder if necessary.)
Click on OK to create the Show

The Show opens in Compose Mode. |.e. the mode for adding Cues and designing your Show and a new Standard
Cue List will appear in the otherwise empty main window.

‘ QUICKSTART : A First Simple Show
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Configure the Mixer

The default mixer will be displayed. If this does not happen check that View > View Mixer is highlighted

(enabled).

On first launch the default 8 into 2 mixer will be loaded with NO output routing selected.

Solo Muie Solo Muie

PF  SF @ PF

Dlay O

Input

oM 4

Solo

Dlay 0

Input

+M: 6

Sple Mule Solo Mute
5F @ PF iF @ PF
Dlay 0

Input

oM 8

Default Mixer with Output Routing Circled

‘ QUICKSTART : A First Simple Show
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Output Routing
Click on the L: XLR icon near the bottom of the ST1 output Bus Mixer Strip to pop-up the Connect Output menu.

Connect Ot
Mo

L1 b =

Ly I o

m

|

Default Mixer Output Routing

Click on the appropriate daughter board output for your hardware (In this case an ADAT daughter board is fitted
so there are two entries, one for each physical connector.) Click on the desired output to route it for the Left side of
the stereo output.

Repeat for the R: XLR icon choosing a second output channel for the Right side of the stereo output.
Set Panning
For this exercise stereo material is assumed and the panning needs to be set to suit:

Click on Strip One’s pan slider and drag to the left until Left is shown in the alphanumeric panel above the fader.

bl i |
W« Busses
Cn

Default Mixer Stereo Panning
Now click and drag Strip Two’s pan slider to the right until Right shows in the display. (The display reverts to peak
level a second or two after the mouse pointer moves away.) Repeat for the remaining six strips in Left Right pairs.
Note: For detailed information about the mixer please see the Pyramix User Manual.
Saving Mixer Configurations

The mixer configuration is saved with the Show. Mixer configurations can also be saved and loaded independently
via the mixer Organize tab. (Please see the Pyramix User Manual for full details.)

‘ QUICKSTART : A First Simple Show
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Building the Show

1 - Cue List 1 (Standard Cue List)

Add Cues

Select Add > Load Audio File from the right-click context menu or select from the Cue menu Add > Load Audio
File to open the Open Audio Files Browser.

Cue List Pane - Compose Mode

Select, say, five Audio Media Files and click on Open to load them as Cues into the Cue List created with the Show.

Notice that the Cue names in the Browser include the UIDs (Unique IDentifiers(

Look in:

L
=

Recent Places

Desktop

=
Libraries

i l.
|-~

=

Computer

@

Metwaork

| Sound Effects - @' ¥ HERg
Mame : Date modified Type Size v
o sawing-0053-423E-930B-0896A9799385})....  19/03/2009 15:37 Pyramix Media 4771 Kl
@ siriusvoice- CDEE-436F-B698-29CA0AS83...  19/03/2009 15:37 Pyramix Media 5,411 Kl
g slideguitar-6795-4670-91DE-080602E4 A6...  19/03/2009 15:37 Pyramix Media 2,208 KI
el snoring-9831-4969-4311-63908A4397A4A...  19/03/2009 15:37 Pyramix Media 3,360 KI
o cplash-759C-409F-9355-06E4TERS1EADY.,..  19/03/2009 15:37 Pyramix Media 1,696 Kl
& station-D2F0-4647-80C2-640BFESGEDTF}... 19/03/2009 15:37 Pyramix Media 8,011 Kl
G steam pass2-D564A-448E-BFFC-EB5E398D...  19/03,/2009 15:37 Pyramix Media 6,051 Kl
ﬂ steampasses-5536-4005-A847-02F6F438..,  19/03/200915:37  Pyramix Media 4 899 K]
e strangechoir-ABAE-4DE1-B366-38C41B4...  19/03/2009 15:37 Pyramix Media 3,360 Kl
ﬂ' strangeveoices-06C9-4009-9560-CF3480...  19/03,/2009 15:37 Pyramix Media 5923 Kl 3
g streamlarge-483F-4648-BAD9-566FFCT0...  19/03/2000 15:37 Pyramix Media 5411 Kl
@ streamsmall-6EBC-4679-A721-261891EE...  19/03/2009 15:37 Pyramix Media 5,155 Kl
B tan-FOFC-4222-953F-937036DB466BL.omf  19/03/2009 15:37 Pvrarmix Media 4384 K1 T
1 m P
Fle name: steampasses-5536-40D5-A347-D2F6F 4388006} prf -
Files of type: [Pudiu Files [ pmf;” bwf;” wav;™aif ;" mod;~ sd2;” mp3) - ] [ Cancel ]

QUICKSTART : A First Simple Show

Open Audio Files Browser

‘AMERGING



You should now have a Cue List that looks something like this:

1 - Cue List 1 (Standard Cue List) *

steampasses Wi
00:00:24 A1

station Wi
00:00:44 Al

e
00:00:42 A1

steampass2 Wi
00:00:30 A1

Cue List Pane - Compose Mode

Notice that Ovation has abbreviated the Media File names intelligently to generate Cue Names. The Cue Name
can be changed in the Cue Properties pane and the Media File(s) can be changed without changing the Cue
Name by using the Replace Audio Media function.

Experiment with the Move Up and Move Down buttons (in the right-click context menu), but for the present
leave everything else as it is.

First Run

Initialize Show
In the main window Click on the Init Show button:

i I I Start Pavse Slop
Sho '; Show Show Show

Main Window

‘ QUICKSTART : First Run
ANVIERGING



vation

MEDIA SERVER & SEQUENCER

(Or select Show > Init) to Initialize the Show. Note that the Main Window may well contain the Cue List(s) you've
created. Notice also that the Cue List pane changes to Normal Show Mode with the first Cue selected :

1 - Cue List 1

station
Azleep

W)

00:00:44 Ad

trainwhistle
Asleep

Wi

00:00:06 Al

bell
Azleep

e
00:00:42 A1

steampass2
Aszleep

”
00:00:30 A1

Cue List Pane - Show Mode

The Green bar highlighting 1 - Cue List 1 shows that this Cue List is selected and will be affected by the Show

Control buttons. Notice that the Cue status labels all read Asleep.
Play

Start Click on the Start Show button to begin.
Show

The selected Cue is highlighted in Purple indicating that it is selected and Ready is shown in below the Cue Name.

l.e. prepared for Firing. (buffer loaded)

1-Cue List 1

station
Aszleep

”
00:00:44 A1

trainwhistle
Azleep

W)

00:00:06 Al

bell
Asleep

Wi

00:00:42 A1

steampass2
Azleep

e
00:00:30 A1

Cue List Pane with Cue Ready - Show Mode

Notice also that a red border has appeared around the Cue. This flashes slowly and indicates that this is the Cue
which will be affected by the next initiation of any of the Fire, Pause and Stop Buttons, Keyboard Shortcuts and
remote control.

‘ QUICKSTART : First Run
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Click on the Fire Selected Cue button. The selected Cue plays and it's colour changes
to Green with an elapsed time bar running across the Cue and two counters showing
time elapsed and time remaining.

1 - Cue List 1

station Wi
Azleep 00:00:44 A4

trainwhistle Wi
Asleep 000008 Al

bell Wi
Azleep 00:00:42 A1

steampass2 Wi
Aszleep 00:00:30 A1

Cue List Pane with Cue Playing - Show Mode

Notice that the same Cue remains selected in the Cue List. Notice also that when the Cue has finished Playing, it
stops and is highlighted in grey to show that it is selected.

Stop the Show and re-initialize. (Show > Stop and click OK in the Are you sure you really want to Stop the
Show? dialog.

Start the Show. As before, the selected Cue is readied for playout.

Click on the Fire Sequence button. The selected Cue plays. Notice that this time, the
next Cue in the list is now highlighted and Ready for Firing.

1-Cue List 1

41 steampasses Wi
Playing ] | 00:00:08 - 00:00:18 Al

trainwhistle Wil
Azleep 00:00:068 A1

bell Wi
Aszleep 00:00:42 A1

steampass2 Wi
Azleep 00:00:30 Ad

Cue List Pane with Cue Playing & Next Cue Ready - Show Mode

‘ QUICKSTART : First Run
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Notice also that the red border has moved to Cue 2. This is because it is now the Cue which will be affected by the
next initiation of any of the Fire, Pause and Stop Buttons, Keyboard Shortcuts and remote control.

Click on the Fire Sequence button again. The next Cue Plays. Notice that the original
Cue (if it hasn’t ended) is still playing and the next Cue is now highlighted and Ready
for Firing.

1-Cue List 1

steampasses Wi
Playing ] 0000018 - 000006 Al

station Wi
Playing ] 00:00:08 - 00:00:35 A1

W

Azleep 00:00:42 A1

steampass2 Wi
Asleep 00:00:30 A1

Cue List Pane with Two Cues Playing & Next Cue Ready - Show Mode

Notice also that the red border has now moved to Cue 3.
Play with the Show Control “Transport” buttons until you are familiar with their operation.
Click on Show > Stop and OK in the Stop Show dialog to return to Compose Mode.

Hot Keys Mode

Create a second Cue List, this time choosing CueList > New > Hot Keys, and add some Cues.

2 - Cue List 2 (Hot Keys)

1 castlefootsteps Wil
00:00:27F Al

2 strangechoir Wi
00:00:16 A1

3 dungeondoor Wi
00:00:19 A4

Hot Keys Cue List Pane - Compose Mode - normal

‘ QUICKSTART : First Run
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Note: In normal Compose mode, apart from the orange header and the (Hot Keys) label
in the title bar there is no difference between the standard Cue List and the Hot Keys Cue
list until the Show is initialized.

Click on the Init Show button to Initialize the Show:

The original Cue List will appear as before and the new, Hot Keys, Cue List will appear thus:

2-Cuelist2

1 castlefootsteps 2 strangechoir

00:00:16

000021

Hot Keys Cue List Pane - Show Mode

If the new Cue List is not selected (no Orange bar) either click on the title bar to select it or click on the

Show Controls Toggle Cue Lists button until it is selected.

Start the Show and experiment with the on screen Hot Keys in the 2-Cue List 2 Pane and the Show Control Fire
and Fire Sequence buttons.

Experiment with the Hot Keys. (Number keys on the PC Keyboard, NOT the Numeric keypad) and notice that they
toggle Fire and Stop. (This behavior can be changed later if you wish.)

Select the first Cue List, 1-Cue List 1, either by clicking on its Title Bar or clicking on the
Show Control Toggle Cue Lists button until the list is selected (Green Title bar).

Select a Cue in the first Cue List and Fire it using the Show Control Fire Selected Cue or Fire Sequence buttons.
Now use the keyboard Hotkeys to Fire and Stop Cues in the second list.

Click on Stop Show and OK in the Stop Show dialog to return to Compose Mode.

‘ QUICKSTART : First Run
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Timed Cue List

Create a third Cue List, this time using Cue List > New > Timed Cue List and add three Cues.

J - Cue List 3 (Timed Cue List)

2 30sguitar

e
00:00:09 A1

3 glissade

‘AMERGING
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”
00:00:06 A1

Timed Cue List Pane - Compose Mode
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Select the first Cue in the list right-click and select Cue Properties button to open the Cue Properties Pane for the
selected Cue. Float the Pane and resize to convenient dimensions:

Cue Propertiez

= Cue
Mumber

Mame accordion
Comments

Length 00:00:06:000
FadeIn 0 [ms]
Fade In Curve Linear
Fade Qut 0 [ms]
Fade Qut Curve Linear

Stop Fade Out < Default>

Interaction Rules

Ignore Parent Rules

Qutput Player

Markers

Timed Cue

Go Time

Hot Key

Custom Key

Audio

Offzet +00:00:00:000
Gain 0.00 dB
Audio Output Slot 1

Audio Media accordion-ACET-4EB5-ATBE-OF855AR2 CECCLpmf

Sampling Rate 44100 Hz

Cue Properties Pane

Click in the Go Time field:

B Timed Cue

g | ﬂ

S Hat Ko
Time Entry Box - Cue Properties Pane

A Time entry box appears. This takes the form of Hours Minutes Seconds and Milliseconds.

Click to position the entry cursor in the seconds section and type 10. Click elsewhere in the Cue Properties pane
to enter the value. Notice that the Go Time field value changes to 00:00:10:000

In the third Cue List Pane select the next Cue and enter a Go Time of 00:00:20:000

Repeat for the third Cue, entering a Go Time of 00:00:30:000.

‘ QUICKSTART : First Run
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Notice that the Cue List 3 pane has changed to include the Go: times.

3 - Cue List 3 (Timed Cue List) ¥

1 accordion Wi
Go: 00:00:10:000 000008 Al

2 30sguitar Wil
Go: 00:00:20:000 00:00:09 A1

Timed Cue List Pane with Cue Start Times - Compose Mode

Select Show > View Show Properties and click in the Show Time Mode field and choose Duration. (If not
already showing.)

Initialize the Show

Notice that Cue list 3 now has a Time Toolbar:

J-CueList 3 *

ooco00ff O f IR

92 30sguitar Wi
Aszleep Go: 00:00:20:000 00:00:09 A1

3 glissade Wi
Azleep Go: 00:00:30:000 00:00:06 Ad

Timed Cue List Pane -Show Mode

Chase Timed List

m Click on the Chase Timed List button to instruct the list to follow the Show Time.

Note: The Chase Timed List button is Latching. l.e. its state is remembered when the
show is stopped and re-started.

‘ QUICKSTART : First Run
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In Show mode the Chase Timed List button is lit green when engaged.

Note: Once selected this function persists when the show is stopped and re-started until
manually cancelled by clicking on the button again.

Click on Start Show. Cue List 3's Time Counter follows the Show Time Counter. The Timed Cues in List 3 fire as the
Show Time reaches their Go Times. (If the Cues you chose are longer than 10 seconds each then the next Cue will
be Fired while the earlier one continues to play.)

Notice that the Hot Keys are still active for List 2 Cues and that List 1 Cues can still be controlled by the Show Con-
trols once List 1 has been selected. Now Stop the Show.

Start Timed List

Initialize the Show and click on the Chase Timed List button in Cue List 3 to cancel the function. Start the Show
and allow it to run beyond 10 seconds.

E Click on the Start Timed List button. The first Timed Cue Fires when the Timed List
Counter reaches its Go Time i.e. 10 seconds.

Start Timed List introduces an Offset between Show Time and Timed List Time. The entire list is played from the
beginning including the time before the first Cue. Stop the Show

Fire/Start Timed List
Initialize and Start the Show.

@ Click on the Fire/Start Timed List button. The first Timed Cue Fires Immediately and
the others follow in their proper timed sequence.

Fire/Start Timed List introduces an offset between Show Time and Timed List Time. The entire list is played from
the beginning of the first Cue disregarding any List time before the first Cue.

Note: If the Showtime is past the start time of the first Cue then the Cue fires immedi-
ately the button is pressed.

Pause Timed List
Only available when list has been initiated with Fire/Start Timed List.

Click to Pause the Timed List. A second click resumes.

Stop Timed List
Only available when list has been initiated with Fire/Start Timed List.

@ Click to Stop the Timed List. Resets list to the start.

Conclusion

‘AMERGING

Congratulations! You have just designed and run your first Show using examples of each of three main types of
Cue List.

Ovation has many, many more possibilities including Fades and Interaction Rules. Detailed information on using
these are to be found elsewhere in this Guide.

QUICKSTART : First Run




Ovation Concepts

Launching Ovation

Launch Ovation
Double-click the Ovation shortcut icon:

sEarERTTEEEy

|_Ovation |

Alternatively, click on Start > All Programs > Merging Technologies > Ovation : Ovation

Application Delay Launch
This function enables Ovation to be launched automatically at machine startup with a delay to ensure all drivers
and services etc. required are available.

To enable automatic launch simply drag the Ovation icon into the Startup folder and set the required delay value
(in seconds) in the Show Properties pane, Show section in the Application Delay Launch field.

Ovation Media and Commands

Audio

Ovation reproduces Audio Cues via a configurable Mixer through a Horus, a Mykerinos board or a sound card if
using Native

MIDI

Ovation outputs MIDI (MMC, MIDI Files and MIDI Commands to other applications on the same machine or to
external devices.

IP Commands

Ovation outputs IP Commands per Cue.

Sony P2/ RS422

Ovation outputs Sony P2 protocol, RS422 commands. (or over ethernet)

GPO
Ovation outputs GPO commands to COM ports.

Shell Commands/Scripts/Batch files
Ovation output Shell Commands/Scripts/Batch files

Automation

Ovation Mixer Snapshots can be triggered.

DMX 512 / CMX Lighting Control
Please see: DMX Commands on page 224

Ovation Concepts : Launching Ovation
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Media Management

Ovation uses media files on local storage, removable storage and network storage.
When a new Show is created a folder Audio Files is created in the same location.

When a Show is Consolidated (please see: The Consolidation Process on page 116) files on the network, files
on removable storage or all files used in the show will be collected and copied to the Audio Files folder in the
Show file location.

Whenever an audio file or files present on removable storage or in a network location are added to a Cue List (by
dragging and dropping, using Load Audio File, Replace Audio etc. a dialog appears asking if the user would like
the files copied to the Audio Files folder associated with the Show.

The Show packaging process collects all the Audio Media and other files associated with a Show (including the
Show file and copies them to a new location for back-up purposes or so that a show can be moved to a different
Ovation workstation. Please see: The Packaging Process on page 117.

Remote Control

Remote Control OF Ovation

Ovation Sequencer & Media Servers can be controlled using:

. The Merging Technologies Hardware Controller

and, via the OVController module:

. General MIDI

. 9-pin Sony P2 (RS422 protocol) commands
. IP commands

. GPlIs.

Remote Control BY Ovation

The Ovation Sequencer and Media Server can control other devices using:

. MMC

. MIDI files

. MIDI Commands

. Sony P2 (RS422 protocol) commands
. COM Commands

. IP Commands

. GPOs

. Shell Commands/Scripts/Batch Files

Remote Control of Ovation Mixer

The Ovation Mixer can be controlled by a hardware control surface via EMC or Oasis. The Merging Technologies
ISIS controller is not supported.

Multi-Sequencer Synchronization

Multiple Ovations can be synchronized in a variety of ways. Cues on one Ovation can control another Ovation. One
Ovation can be mirrored completely on another for full, near instant redundancy.

Ovation Concepts : Media Management

‘AMERGING



MEDIA SERVER & SEQUENCER

Creative Possibilities

If, for example an installation requires multiple Ovation sequencers to be set up, typically one for each of various
zones where the audience may be moving freely between the zones then it may be desirable to have all the
sequencers playing certain Cues in perfect sync. E.g. background music. To achieve the Cue(s) on one Ovation are
set as the Master and the identical Cue(s) on all others as Slaves. A common source of time base must be provided
to each Ovation, e.g. from GPS TimeCode generators. Any Cue that must be in sync on all machines is set as Master
in the Master system and as Slave with the same token in the Slaves. All other Cues can be triggered indepen-
dently in each system providing different event in each zones, but the baseline audio will be in sync across all sys-
tems.

Redundancy for Backup

To achieve redundancy with a backup Ovation running an identical show in mission critical situations, it is possible
to use the Controller > Mirror all Commands to Remote Ovation Sequencers feature. However, this does not
ensure sample accurate sync. If sample accurate backup is required some key Cues in both systems can be set as
Master/Slave. Typically identical Shows will be running in the Main and Backup machine and any Cues which are
to be manually triggered during the show are set as Master in the Main Ovation and as Slave in the Backup. All
other Cues which are triggered via rules or timed events do not required to be Master/Slaved, they will be trig-
gered automatically in both systems at the same time by the sequencer engines. However, you can ensure that
Cues triggered manually will be synced in the Backup machine by this using the Multi-Sequencer Synchronization
feature. If there is a problem with the Main machine and it is necessary to switch to the Backup machine, the audio
outputs are simply switched manually to the Backup machine. Subsequent manual control of Cues is done on this
machine. It will be in the exact same state as the Master.

Note: The Master Show should be stopped after changeover to the Backup in order to
avoid contradictory commands.

Using Multi-Sequencer Synchronization

Before Multi-Sequencer Synchronization can be used IP communication must be configured in both the Master
and Slave sequencers.
Please see: TCP/IP Connections on page 157

Multi-Sequencer Synchronization is switched on and global parameters set in Show Properties.
Please see: Multi-Sequencer Synchronization Section on page 93.

Parameters for individual Cues are set in Cue Properties for each Cue you wish to synchronize.
Please see: REMOTE CONTROL: Multi-Sequencer Synchronization on page 109

Ovation Modes

Compose Mode

Shows are designed and assembled in Ovation's Compose Mode.

Show Mode
Shows are run in Ovation’s Show Mode. Clicking on the Initialize Show button puts Ovation into Show Mode.
Start Show
Clicking on Start Show or pressing the Start Show button on the Ovation Keyboard does a number of things:
. Hot Cues and Custom Cues are now available for firing
. Timed lists set to Show Time will fire their Cues at the times specified.
. Standard Cue Lists are available for firing.

‘ Ovation Concepts : Ovation Modes
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MEDIA SERVER & SEQUENCER

A Show is the top level of organization. Shows are saved with the file extension .ovs. A Show controls and keeps
track of all the various elements you are assembling at a given time. A viable Show always contains one or more
Cue Lists which contain one or more Cues pointing to Media Files or containing MIDI, GPO, DMX or IP etc. Com-
mands.

Cue Lists

Cue List displays are Modal. l.e. when the Show is not Initialized they are in Compose Mode. Once the Show has
been Initialized Cue List displays switch to Show Mode.

When Ovation is in Compose Mode the main area of a Cue List displays a tree structure of all Cues and Child-Cues
added to the list. In Show Mode the display will depend on the type of Cue List and on choices made in Compose
Mode.

Note: If a Cue List is Closed without saving it separately it will be lost. If you try to close a
Cue List the following dialog will appear:

EEE

Closing a Cue List will remove it fram the Show and discard its content

This operation is not Undoable !

You may prefer saving it independently first using the Cuelist > Save As menu

Sure you want to dosefremove Cue List 'Cue List 3' 2

[ 0K ] | Cancel

Close Cue List Dialog

Multiple Cue Lists

Ovation handles multiple Cue Lists in Shows. The Main window Show Control operates on the currently selected
list of whatever type. When the Main window Show Control is controlling a selected Cue list of any type a second
Hot Key Cue List can be controlled simultaneously via keyboard shortcuts or an external hardware controller.
Timed Cue Lists will follow the Interaction Rules set-up in Compose Mode unless otherwise affected by the Main
window Show Control when a particular Timed List is selected.

Audition

Audio auditions are played via the Output Slot(s) chosen in Settings > Application > General > Audition.

Selected Cue

The currently selected Cue can be auditioned by clicking on the Cue List Audition button or Cue > Audition/PFL.
Clicking on the small down arrow adjacent to the Audition button gives access to the full range of Audition trans-
port controls which are the same as those available in the Audition Toolbar. Please see Audition Toolbar on
page 67

Any Cue can be also Auditioned by double-clicking it. A second double-click stops the Audition.

‘ Ovation Concepts : Show
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Audition Jump

There are six Audition Jump commands. These commands are available only when Auditioning a Cue and via Key-
board Shortcuts or with a modifier key when clicking on the Rewind and Fast Forward buttons in any Audition
Toolbar or on the Ovation Keyboard:

Audition Jump Forward 1: Jump 1 Second later in time (Ctrl + -> Key or Fast Forward Button)
Audition Jump Forward 2: Jump 5 Seconds later in time (Ctrl + Shift + -> Key or Fast Forward Button)

Audition Jump Forward 3: Jump 15 Seconds later in time (Ctrl + Shift + Alt + -> Key or Fast Forward But-
ton)

Audition Jump Back 1: Jump 1 Second earlier in time (Ctrl + <- Key or Rewind Button)
Audition Jump Back 2: Jump 5 Seconds earlier in time (Ctrl + Shift + <- Key or Rewind Button)

Audition Jump Back 3: Jump 15 Seconds earlier in time (Ctrl + Shift + Alt + <- Key or Rewind Button)

Cue List Pane

To open a new, empty Cue List pane select Cue List > New > (required type) from the menu in the main Ovation
window.

1 - Cue List 1 (Standard Cue List) *

Empty Cue List Pane - Compose Mode

The Title bar is highlighted in pale green when the Cue List is selected. The Top Hat Pin Icon toggles Auto Hide
mode when the pane is docked.

Edit Toolbar

For people who prefer working with Toolbars an Edit Toolbar is provided. By default it is only visible in Compose
Mode and only when the Cue List > View Edit Toolbar entry is toggled to show the Toolbar.

Note: The >> button to the right of the Toolbar accesses further Toolbar buttons. If the
pane is re-sized to a sufficient width, all the Toolbar buttons will be visible thus:

3 Gt it 3 (el Dom Lars

T St Priqpirtont | 11 S Pl | o Clmgen g G 20 gl - | 25 i Loy Bty o - | . P |,

Empty Cue List Pane. Full width Toolbar - Compose Mode

Cue Properties Opens the Cue Properties pane with details of the currently selected Cue

‘AMERGING
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Cue Rules Opens the Cue Rules pane

Cue Gain Opens the Cue Gain dialog. Enables the overall Cue Gain to be set
Add Adds a new Empty Cue to the list. Clicking on the adjacent Down Arrow offers a
choice of:

Add Short Empty Cue Adds a 1S long empty Cue. Used for triggering.
Add Long Empty Cue  Adds a 24H long empty Cue. Used for implementing conditional rules.

Load MTInterChange XML
Load Audio File
Import CD Tracks

Load MIDI File

Add Long Empty Cue Adds a 24H long empty Cue. Used for implementing conditional rules.

Remove Deletes the selected Cue for the Cue List

Edit in Pyramix Opens the selected audio Cue in Pyramix.

Replace Audio Media Opens a browser window. Choose the Audio Media file you wish to use in place of
the current one and click on Open.

Snapshot Automation Opens the Filter Mixer Controls to Snapshot dialog for the selected Cue.

Paste Automation Pastes the Automation Snapshot from the last Cue Copied to the selected Cue.

Audition Plays the selected Cue via the Output Slot chosen in Settings > Application Set-
tings > Audition. The drop down gives the standard audition options.

Move Down Moves the selected Cue Down one position in the Cue List

Move Up Moves the selected Cue Up one position in the Cue List

Nest Makes the selected Cue a Child-Cue of the one above it in the list. Cues can be

nested as deep as you might reasonably wish. |.e Child-Child Cues etc.

Un-Nest Moves the selected Cue up a nesting level. If it is a simple Child-Cue then restores
this to the top, Cue level.

Cues in Cue Lists

1 - Cue List 1 b4

1 steampasses Wi
Paused | I | O0:00:21 - C0:00:03 A

9 station Wi
Playing | | 00:00:34 - 00:00:11 A

4 bell Wi
Azleep 00:00:42 A1

B steampass2 Wi
Azleep 00:00:31 A1

Cue Colours - Show Mode

Cue Status
When in Show Mode a Cue in a Standard Cue List can be in one of four states.

Asleep

‘ Ovation Concepts : Cue List Pane
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Ready

Playing
Paused

Cue Status is indicated by a label and the highlight color.

Asleep Asleep No highlight
Ready Ready Purple highlight
Playing Playing Green highlight
Paused Paused Yellow highlight
Red Border

The Cue which has the focus has a flashing red border. l.e. this is the Cue which will be affected by the next initia-
tion of any of the Fire, Pause and Stop Buttons, Keyboard Shortcuts and remote control.

Cue Progress
When a Cue is Fired its list entry or (Hot Key Button) displays its progress in three ways.

The left-hand counter shows elapsed time from the start of the Cue.
The right-hand counter shows time remaining to the end of the Cue.
A black progress bar moves from left to right as the Cue plays.

When a Cue has been paused and then resumed the progress bar shows progress since the last pause. (As shown
above)

Cue Fire Buttons

Cues can each display Fire/Pause and Stop buttons when in Show Mode:

1-Cue List 1

station :
tati Wi
Azleep 00:00:46 A1

trainwhistle Wi
Asleep 00:00:06 Ad

bell Wi
Azleep 000042 A1

steampass2 Wil
Agleep 00:00:31 A1

Cue List with Fire Buttons - Show Mode

Cue Fire Buttons are shown in Show Mode when the Cue Fire Buttons field is set to Yes in the Show Time
Options section of Show Properties.

Ovation Concepts : Cue List Pane
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Fire Toolbar

If the Fire Toolbar is selected for a Standard Cue List (View > View Fire Toolbar) the Cue List Pane will appear like
this in Show Mode when the Show is Ready and Started:

1-Cue List 1

station
Aszleep

e
00:00:46 A1

trainwhistle
Azleep

W)

00:00:06 Al

bell
Asleep

Wi

00:00:42 A1l

steampass2
Azleep

| [<][>] B [~][2]

Cue List Types

Standard Cue Lists:

Select Previous Child-Cue in Cue List

Select Next Child-Cue in Cue List

e
00:00:31 A1

Cue List with Fire Toolbar - Show Mode

Fire Selected Cue in currently selected Cue List and select next Cue and make Ready

to Fire

Select Previous Cue in Cue List

Select Next Cue in Cue List

Fire Selected Cue in Cue List. Cue remains Ready to be Fired Again

Pause Selected Cue in Cue List

Stop Selected Cue in Cue List

Ovation Concepts : Cue List Types
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Lists with sequential events manually triggered

Timed Cue Lists:

Lists with Cues that can be automatically triggered at a given time or manually.

Hot Keys Cue Lists:

Lists with Cues that can be triggered anytime with a given Hot Key mode.

Custom Keys Cue Lists:

Lists acting like Hot Keys Lists but where Cues buttons can be customized.

Cue Browser Lists:

Lists showing only Cues reflecting the content of a folder in the file system or network.

Hot Browser Cue Lists:

Lists acting like Browser Lists but Cues are fired with a single click and Cues cannot be dragged out to other Cue
Lists. Typically to be used as an Audio file player.

Cue List Detail

Selecting Cue Lists
Cue Lists can be selected by:

Clicking on them

Using the Tab key to cycle through all available Cue Lists (Or the Select Cue List button on the Ovation
keyboard.

In Show Mode by holding down a Ctrl key and pressing a Hot Key trigger button. (1-48 on the Ovation
Keyboard, 1-0 on the PC Keyboard with standard mapping.)

Standard Cue List

1-Cue List 1

station
Azleep

00:00:25 A1

W)
00:00:46 A1

trainwhistle
Asleep

Wi
00:00:06 A1

bell
Azleep

e
00:00:42 A1

steampass2
Aszleep

e
00:00:31 A1

Cue List Pane with Show Control - Show Mode

This can be thought of as the “basic” mode. Cues can be Fired and Paused or Stopped from the main panel Show
Control buttons when the Cue List is selected, from the Active Cue panel buttons and from the Toolbar buttons in
the Cue List pane itself.

Ovation Concepts : Cue List Types
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Timed Cue List

J - Cue List 3 *

oooo00ff O f IR

2 30sguitar Wi
Azleep Go: 00:00:20:000 00:00:09 A

3 glissade Wi
Asleep Go: 00:00;30:000 00:00:08 A1

Timed Cue List - Show Mode

Once started, Cues with Go Times defined will follow a pre-determined time sequence. Cues can still be manually
Fired or started from the Show Controls.

Hot Keys Cue List

2-Cue List 2

1 castlefootsteps 2 strangechoir

00:00:18

00:00:21

Hot Keys Cue List Pane - Show Mode

This Cue List presents each Cue as a Fire button when in Show Mode. Used for spot effects this mode is commonly
used with keyboard short-cuts or an external hardware controller. Cues in a Hot Key Cue List can also be fired from
the Show Controls.

Stopping Hot Cues
To Stop a Hot Cue while playing Alt + Click it. Double-Click would be too dangerous!

Hot Keys Cue List Design Mode

Hot Keys Cue Lists have a Hot/Custom Keys Design Mode to enable Cues to be arranged in the Hot Keys View (see
details below). To enter this mode either right-click on the Cue List to open the context menu and choose Hot/
Custom Keys > Hot/Custom Keys Design Mode or, if you prefer, select it on the Cue List menu.

‘ Ovation Concepts : Cue List Types
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The Hot Keys slots are always displayed on a grid whether they contain a Cue or not:

4_Cue List 4 {Hot Keys) X

Hot Keys Cue List Pane - Design Mode

Note: Slots are kept square automatically whenever possible.

. Hot Keys Numbers follow the Hot/Custom Keys Design Mode setting:

. If the Cue List is in Automatic Cue Numbering Mode then all Cues are displayed in the Hot Key view one
after another reflecting their standard Cue List ordering. In this mode the Cues arrangement is automati-
cally computed and cannot be manually changed in Hot/Custom Keys Design Mode.

. If the Cue List is NOT in Automatic Cue Numbering mode then the Cues are displayed in the Hot Key slot
corresponding to their Cue Number. The Cue Number can be changed in the Cue Properties pane or by
drag and dropping Cues directly in the Hot Keys view when in Hot/Custom Keys Design Mode.

Hot Keys Columns
The Number of Columns displayed in the Hot Key View can be set manually:
This setting is available in the Cue List Properties pane in the Hot Keys section.

When the Number of Columns is set to Auto then the system automatically adjusts the number of columns
depending on the size of the Cue List pane, but still follows the Automatic Cues Numbering setting and leaves
empty slots if necessary.

Hot Keys Column to Audio Slot Mapping
Hot Keys Columns can be Mapped to Audio Slots Mapping in the Cue List Properties Hot keys section:

. If set to No all Cues are played back in the Audio Output Slot defined in their Cue Properties.

. If set to a number (1, 2 or 6) then the Cues are played back in an Audio Slot corresponding to the Hot Keys
Column. In this way Hot Keys Cues can be assigned to Audio Output by the Column in which they are
placed.

Note: In this mode the actual Audio Output Slot(s) is computed as Cue Column Number
multiplied by the number selected in the Hot Keys Column to Audio Slot Mapping
field. This enables Mono (1), Stereo (2), Surround (6) Cues to be handled.

Ovation Concepts : Cue List Types
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Triggering Hot Keys
The Hot Keys that can be triggered either by the Ovation dedicated Keyboard, any installed Controllers or the Key-
board ShortCuts (Hot Key 01 to 48)

Note: If the Ctrl key is pressed with the trigger button then the Cue is selected rather
than fired. If Ctrl + Shift is pressed with the trigger button then the Cue List with this
number is selected.

Only Selects the given Cue (no Fire) if Ctrl is pressed

Selects the Cue List having this number if the Ctrl + SHIFT key is pressed when called.

Custom Keys Cue List

5-Cue List 5 (Custom Keys) b4

Custom Keys Cue List Pane - Design Mode

Functionally identical to the Hot Keys Cue List but you can custom design the fire buttons in terms of shape, color,
text color, font and font size as well as position. Like Hot Keys Cue Lists when in Show Edit Mode the Custom Keys
Cue Lists are still displayed as standard Cue lists for simple Cue management. However, there is the further option
of Custom Keys Design Mode:

Custom Keys Design Mode
To enter this mode either right-click on the Cue List to open the context menu and choose Hot/Custom Keys >
Hot/Custom Keys Design Mode or, if you prefer, select it on the Cue List menu.

Click on a button to modify it. Click and drag the black boxes to re-size the button and click and drag anywhere on
the button to move it to a new location. The dots on the background represent a grid and all re-sizes an moves
snap to the grid. On the Custom Keys sub-menu you will find commands to Snap all Keys on Grid, Reset all Keys
Position and Reset all Keys Size and Position. (Snap all Keys on Grid is provided for quick alignment if the grid
size is changed.)

Note: Cues in standard Cue Lists can have the font and label background customized.

Grid Size

To adjust the grid size open the Cue List Properties pane and change the value in the Custom Keys Grid Size
field in the Custom Keys section.

Color and Font

To change colors or the font for the selected button open the Cue Properties pane. Locate the Custom Key sec-
tion. In the Custom Color field Colors can be changed directly by entering RGB color values numerically. Or click
on the ... button on the right of the field to open a color picker. Standard and custom colors are provided. Similarly,

Ovation Concepts : Cue List Types
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to change the font color use the Custom Font Color field. Click in the Custom Font field to change the font attri-
butes. Clicking on the ... button opens a standard font dialog where any font installed on the system can be
selected, the font style, Regular, Italic, Bold or Bold Italic can be set and the font size selected.

Justification

When no Custom Font is defined the button text is Left justified as with all other Cues. When a Custom Font is set,
then there is a high probability that the button will have a “graphical meaning”. Therefore the text is automatically
centered and multiple lines are allowed to attempt to fit as much text as possible in a large button.

Typically this is used for Cues such as:

6 - Cue List & (Custom Keys) b4

Custom Keys Cue List - Show Mode Custom text

Note: If the Cue List is set to non-Automatic Cue Numbering Mode (Cue List Proper-
ties : Automatic Cue Numbering field set to No) then the Numbers of all Cues in the
Custom Keys Cue List can be set to nothing if irrelevant as in the example above. This is
the default condition for Custom Cue Lists.

Ovation Concepts : Cue List Types
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MEDIA SERVER & SEQUENCER

BBC CD 5FX 045 - EMERGENCY_Fire Brigade-fire enigine arrives with two-tone horns, idle, off il
00:00:52 A1

BBC CD 5FX 045 - EMERGENCY_Fire Brigade-general activity at scene of fire [indistinct voices] Wi

00:03:45 A1

BBC CD SFX 045 - EMERGENCY _Fire Brigade-hoses run out and ladders erected [indistinct voices] Wi

00:01:32 A1

BBC CD SFX 045 - EMERGENCY_Fire Brigade-hoses used on fire [distant voices] ]

00:01:58 A1

BBC CD 5FX 045 - EMERGENCY_Fire Brigade-ladder loaded onto engine il

00:00:12 A1

BBC CD 5FX 045 - EMERGENCY Housebreaking, front glass door smashed Wi
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Cue Browser Cue List

This special type of Cue List enables Media Files to be browsed, auditioned, copied and pasted as Cues into other
Cue Lists from within the main Ovation interface. The chunky scroll bars are to facilitate touch-screen use.

t Parent| Parent moves up one level in the folder hierarchy.

Refresh refreshes the list as with a normal Windows Browser.

Double-clicking a Media File in the list plays the file.

Cues are always played in Audition mode regardless of whether the Show is running. All other Toolbars are dis-
abled for this type of Cue List.

The Cue Browser is very useful for searching Cues then copying/pasting them into other (standard) Cue Lists. The
right-click context menu enables copy and paste.

Search Cues Function

The Browser and Hot Browser Cue Lists have a <Search> text box on the right side of the path name to
search/filter files. This operates in the same fashion as search in Vista Explorer:

. If nothing is typed in, the content of the current folder is displayed, including sub-folder names.

. If something is typed in, all files containing this text in their names are displayed, INCLUDING those in sub-
folders recursively, but the sub-folder names are not displayed.

. When searching for files, the Comment field is automatically populated with the Path Name where the
files have been found.
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hailstorm ]
Ready 00:00:45 A1

hammermetal Wi
Ready 00013 A

handbell Wi
Ready o001z Al

insects
Read

Hot Browser Cue List

The Hot Browser Cue List is very similar to the Browser Cue List with these important differences:

. A SINGLE click fires the Cue.

. A single click on a Playing Cue Pauses the Cue

. A single click on a Paused Cue Restarts the Cue from the point at which it was paused
. Double-clicking a Playing Cue Stops the Cue

. Cues cannot be dragged to other lists or be copied and pasted.

. The Parent and Refresh buttons are bigger to facilitate touch screen operation.

Parent moves up one level in the folder hierarchy.

Refresh refreshes the list as with a normal Windows Browser.

Note: The Hot Browser Cue List type will typically be used as an Audio file player.

Cues

A Cue is a set of instructions to perform actions. These actions can be on a Media file (or files if multi-channel/
multi-media, Pyramix Compositions etc.) or can send instructions to external or internal devices. For example to
turn mic inputs on and off or to change a Mixer Snapshot. A Cue does not have to play an entire Media File. Via the
Cue Properties Pane the Length can be set to anything up to the entire Cue and the starting point can be Offset
to any point within the Media File.

The Cue Trimmer option in the Active Cue window provides a quick and easy method of adjusting In point, Out
point and In and Out fades. Please see: Cue Trimmer on page 79
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Cuelcons
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Cue Type Icons

Cues have dedicated icons when each of the Audio, Microphone Input, TimeCode Generator, MMC, MIDI File, MIDI
Command, Sony P2/RS422, GPO, Shell Command and Mixer Snapshot options are enabled for the Cue.

Selecting Cues

Cues are selected by clicking on them. Multiple Cues are selecting in the usual Windows fashion. Ctrl + Click tog-
gles selection of individual Cues while retaining previous selections. To select a contiguous range Click on the first
Cue then Shift + Click on the last to select a contiguous block.

Cues can also be selected by holding down the Ctrl key and pressing one of the Hot Key buttons on the Ovation
Keyboard or the PC keyboard.

Moving and Copying Cues

Once selected Cues can be moved or copied using the standard Windows shortcuts. e.g. Ctrl + C copies, Ctrl + V
pastes etc. Cues can also be moved between Cue Lists by simple ‘drag and drop’ Drag and drop with Ctrl copies.
Drag and drop with Alt replaces the audio in the target Cue with the audio in the source Cue. Audio files can be
dragged and dropped from Windows Explorer for easy Cue insertion.

Cue / Cue List Context Menu

‘AMERGING

Right-clicking on a Cue or blank area in a Cue List opens a context menu with the following options:

Undo (last undoable action)
Cut

Copy
Paste

Cue Properties Toggles the Cue Properties pane open or closed
Cue Rules Opens the Interaction Rules dialog

Cue Audio Gain Opens a window with an Audio fader. This adjusts the gain for the entire Cue. Click
OK to accept the change or Cancel to reject.

Add Cue>
Add Short Empty Cue
Add Long Empty Cue

Load MTInterChange XML
Load Audio File
Import CD Tracks Opens the Import CD dialog. Please see: CD Tracks Import on page 47

Record Audio as New Cue Opens the Record Audio dialog. Please see: Recording on page 58

Load MIDI File
Remove

Edit in Pyramix Opens the Cue in Pyramix ready for editing.

Record Audio Opens the Record Audio dialog. Please see: Recording on page 58

Replace Audio Media (Only present for a Cue containing Audio.) Opens a Browser window to select an
alternative Audio Media file to replace the current one for the selected Cue.
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Snapshot Automation

Paste Automation

Change Audio Gain

Edit Rules
Add Rule >

Takes a snapshot of the mixer state. This will be recalled by the Cue.

Applies the automation snapshot on the Clipboard to the selected Cue.

Opens the Cue Gain fader window
Opens the Cue Interaction Rules dialog

Drops down a list of Rules which can be applied to the Cue directly

Fire Next Cue when Ending

Fire Next Cue when Stopping
Fire All Child Cues when Starting

Stop Previous Cue when Starting

Loop (Fire Itself when Ending

Loop between Markers (Fire Itself between Markers

Dim All Cues when Starting

Select Next Cue when Starting

Audition/PFL

Audition >

Start

Rewind

Stop
Play/Pause
Fast-Forward
End

Jump Forward 1
Jump Forward 2
Jump Forward 3
Jump Back 1
Jump Back 2
Jump Back 3

Plays Cue through selected Audition output(s) For non media Cues behavior var-
ies.

Pin/Unpin to Active Cue Window Sets the Cue Pinned or Unpinned. With Pin active in the Active Cue Window-

Lock in Active Cue Window

Move Down

Move Up
Nest

Unnest

Hot/Custom Keys

when Pinned the Cue will appear in the Active Cue Window when selected. When
unpinned it won't.

When Lock is active in the Active Cue Window selecting this will substitute the
selected Cue for the locked Cue in the Active Cue Window. (Alt + Click on a Cue
has the same effect.)

Hot/Custom Keys Design Mode

Snap all Keys on Grid

Ovation Concepts : Cue / Cue List Context Menu
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Reset all Keys Position
Reset all Keys Size and Position

Fire
Pause

Stop

Cue Properties

‘ Ovation Concepts : Cue / Cue List Context Menu
AVIERGING




MEDIA SERVER & SEQUENCER

CD Tracks Import

Ovation has comprehensive CD import functions.

Selecting Cue > Add Cue > Import CD Tracks from the Cue Menu or the Cue / Cue List context menu opens the
Import CD dialog.

o

Device Sethings

CD: SONY DYD Rw/ DRU-B705 1.60 v | | Geftings.. | Feady

Dige: Content

Fead TOC... Read ISRC. UPCEAM & CD Text Query Database | | D atabase Setings
Track, Start Length [SAC i
Space Fantasy, Beaming Down 5440 00:21:60
Space Fantazy, Cedric The CO Robot JE1E25 005467
Space Fantazy, Space Battle A7 01:41:55
Horror, Stretched On The Rack eV 004323
Harrar, Branding lron 33620 00:EF42
| Harrar, Whiplashes [4] AT1362 001305
Horror, Cackling Hags A0:26:67  00:.43:55
| Horror, Pendulum Torture M achine 41:15:47  00:54:33
| Legendsz, Thunderbalt And Thunderclap 421010 001215
Legends, Unicorm 422225 001340 o
Import &ll Tracks @) Import Selected Track[z] | Select A | | Dezelect Al
Target File

Destination drive: | G 40wation Projects\Audio Files

Farmat; |BWF v| “Waveform: | Generate 'WHILE recording -
Sampling Rate: | 42000 - | | Prefie: BBC Sound Effects Library - dizc 03
Track: [ [mpart Tracks l

Dige:
| Cancel |

K.eep window apen after [mport

CD Import dialog

Device Settings
The combo box drop-down list shows all suitable drives on the machine.
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Settings

The Settings button opens a dialog box with specific drive settings. These settings may be altered if required by
clicking on an entry and typing a new value in the box.

R — -
e . =
& General oK

] CD Read Speed Data: 40
2] CO-RW Read Speed Data: 40 Cancel

] CD Read Speed Audio: 40

L] CO-RW Read Speed Audio: 40
[Z Advanced

2] Image Read Buffer Size: 131072
j Image Write Buffer Size: 131072
| Fixaton: True

-] Disc Info Retries: 4

-] C2Read Error Retries: 25

| Scan Indexes: True

] Scan Indexes Chedk ATime: True
] Scan Indexes Chedk CRC: True

i

B

;

j Driver Type: Cydic Buffering
] Buffer Size: 85536

2] Double Buffering: True

j Mumber of Cydic Buffers: 16
2] Disable Screen Saver: True
j Force Speed Detection: True

CD Import Settings dialog

Status

The field to the right of the Settings button shows pertinent information about the CD import process.

Disc Content

Read TOC... Click the Read TOC to read the Table Of Contents on the CD. The tracks are listed in
the pane below.

Read ISRC, UPCEAN & CDtext When checked this information will also be read, if present.

‘ Ovation Concepts : CD Tracks Import
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Query Database

Click to use an online database to obtain track names and other data about com-
mercial CDs. Results are shown in a dialog :

Artist
Guthrie, Arlo
Arlo Guthrie

Category

Alice's Restaurant folk
Alice's Restaurant rock

CD Import Query Database results dialog

If multiple disc titles are shown, click on the appropriate one to select it then click on OK to import the data. The
disc name is automatically entered in the Clip Prefix: field.

Database Settings

Click to access a dialog where the database address and other settings can be
changed:

SR )

|I [Z Server

] Port: 80
roxy

j Server:

W

=]

j Password:
2] Port: 80

] Server: freedb. freedb.arg
] Address: [~cddb/cddb.cgi Cancel

j User Mame:

Defaults

b

CD Import Database Settings dialog

Default settings are shown above. To change a setting, click on the entry and type. Click OK to save the edited set-
tings. Defaults restores the default settings and Cancel closes the dialog without making changes..

Import All Tracks

Import Selected Track(s)
Select All
Deselect All

Target File
Destination Drive:

Format:

When active all tracks on the CD will be imported regardless of individual selec-
tions in the track list check boxes.

When active only the tracks selected (ticked in the track list) will be imported.
Click the button to select all tracks in the list.
Click the button to deselect all tracks in the list.

Information only. Shows the folder where the resulting files will be placed.

Shows the format selected and offers the choice of :

PMF, SD2, AIFF, FLAC, Ogg Vorbis, MP3/MPEG-1/2 Audio, MP4/AAC, DSDIFF, DSDIFF Edited Master, Virtual
Tape, Wave, BWF, CD Image, MTFF, Digital Release, OMF.

Ovation Concepts : CD Tracks Import
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Waveform: Offers the choice of Generate WHILE recording, Generate AFTER recording or

None.

Sampling Rate Offers an extensive choice of sampling rates for the imported tracks. CD tracks are
saple rate converted automatically on import if anything other than 44.1kHz is
selected.

Prefix When checked a prefix will be added to each imported track. This defaults to the

CD title but any desired prefix may be typed in the field when the box is checked.

Track Bar illustrates progress bar for each imported track

Disc Bar illustrates import progress of all selected tracks or the entire disc.

Import Tracks Click to initiate the import process.

Cancel Click to abort an import in progress or to close the dialog without importing.

Keep window open after Import When checked the CD Import window remains open, e.g. for further imports,
after the import is completed. The Prefix label field will be grayed out when this
option is selected.

Keep open keeps the CD Import window open after the import is completed and grays out the Prefix field.

Cue Capabilities

A Cue is a container object for commands to initiate or respond to actions, e.g. Play a Media file or run a Batch File
etc. Cues can have single or multiple functions. There is only one Cue type covering all capabilities.

Audio

A Cue can trigger playback of mono, stereo or multi-channel audio media files. It can also trigger playback of Pyra-
mix Compositions which may contain many elements.

TimeCode Generator
A Cue can output LTC to any suitably equipped device.

Choose a suitable Serial Port in the TimeCode generator section of the Properties panes.

MTC
A Cue can send MTC (MIDI TimeCode) to any suitably equipped hardware or software device.

Choose a suitable MIDI Port in the TimeCode generator section of the Properties panes. (Remember, the Cue set-
ting overrides the Cuelist setting which, in turn, overrides the Show setting.)

MMC

A Cue can send MMC (MIDI Machine Control) commands to any suitably equipped hardware or software device.
Choose a suitable MIDI Port in the MMC section of the Cue Properties pane and enter the start time.

Fire sends an MMC Play command, Pause an MMC Pause command and Stop an MMC Stop command.

MIDI File

A Cue can transmit a MIDI file to any suitably equipped hardware or software device.

Choose a suitable MIDI Port in the MIDI File section of the Cue Properties pane and enter a path to the MIDI file you
wish to transmit.

When the Cue is made Ready the MIDI file is loaded. Fire Plays the MIDI file, Pause will Pause the MIDI file and
Stop will Stop playing the MIDI file.

MIDI Command

A Cue can send General MIDI Commands to any suitably equipped hardware or software device.

‘ Ovation Concepts : Cue Capabilities
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Sony P2 /RS422

A Cue can send Sony P2 / RS422 commands to any suitably equipped hardware device. This includes a VCube
either running in the same machine as Ovation or on a remote machine. Please see: Sony P2 over IP 0 on
page 162

Fire sends a Sony P2 Play command, Pause sends a Sony P2 Jog(0) command and Stop sends a Sony P2 Stop
command.

IP Command

Data to be output can be added in the filled in the Cue Properties pane (unique to every Cue). IP command for-
mat can be ASCIl or HEXA (Hexadecimal). The IP Output port can be selected.

GPO

A Cue can send GPO commands via a serial port and adaptor to any suitably equipped hardware device.

Please see: GPO on page 164 and GPO Section on page 105

Shell Commands/Scripts/Batch files
Please see: Shell Command / Script / Batch Section on page 106

Microphone Switch

A Cue can switch mixer inputs from replay to mic for the duration of the Cue. This operates within a 24 hour win-
dow. Please see: Microphone Switch Section on page 102

Mixer Automation
A Cue can trigger an automation snapshot which is applied to the Ovation mixer. Please see: Snapshot

Automation on page 52

REMOTE CONTROL: General MIDI Command

Individual Cues can be remote controlled from General MIDI Commands. Please see: REMOTE CONTROL: Gen-
eral MIDI Command on page 107.

REMOTE CONTROL: IP Command

Individual Cues can be remote controlled from IP Commands

REMOTE CONTROL: Multi-Sequencer Synchronization

Individual Cues can be synchronized on secondary Slave or Master machines. Please see: Multi-Sequencer
Synchronization on page 30

REMOTE CONTROL: Dataton Synchronization

Individual Cues can be synchronized with Dataton video player timelines.

Empty Cues

Empty Cues can be created by clicking on the Add button or from the menu Cue > Add > Add or from the right-
click Cue context menu. Empty Cues can have Media or Commands added subsequently so that Cue Lists can be
constructed before the media is available. Empty Cues can also be used in conjunction with Cue Rules to construct
complex interactions.

Compound Cues

A single Cue can contain instructions to do many things at once. For example, play an Audio Media file and dim
the lights. To add functions to a Cue simply set the required options in the various sections of the Cue Properties
pane.

‘ Ovation Concepts : Cue Capabilities
AVIERGING



MEDIA SERVER & SEQUENCER

Scenes

Cues can be nested, many layers deep if required. For operational convenience the top level is referred to as a
Scene. In, for example, theatre work, if all the Cues and Child-Cues associated with scenes are nested under single
top-level Cues then the Scene buttons enable quick changes between these Scenes whereas the Cue navigation
buttons will step through each Child-Cue.

Mixer

Each Show on each Ovation has an Audio Mixer associated with it. This is configurable to suit local requirements.
Cue based Snapshot Automation is available. Please see: Snapshot Automation on page 52
Please see the Mixer Chapter in the Pyramix User Manual for details of all the manifold configuration options.

Note: For the present, before you can add Strips and effects etc. you may have to Initial-
ize the current Show, Start it and Stop it before the mixer can be rebuilt to reflect the
required configuration.

Snapshot Automation

Any Cue can store a Mixer Snapshot and recall it when the Cue is fired. The snapshot changes to the mixer can be
implemented when the Cue is fired instantly, over the entire length of the Cue linearly or over a user-defined time
period linearly.

Store a Snapshot

. Select the Cue to which you wish to add a Snapshot.
. Set the mixer control(s) to be affected by the Snapshot to the required values.
. Open the Cue Properties pane (if not already visible)
. In the Mixer Automation > Type field click in the ComboBox and select Snapshot, or

. Cue > Snapshot Automation, or

. In the right mouse button Cue context menu choose Snapshot Automation.

‘ Ovation Concepts : Scenes
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Any of these actions will open the Filter Mixer Controls to Snapshot dialog:

Filter Mixer Controls to Snapshot h I& Filter Mixer Controls to Snapshot h ﬁ

By Types By Strips
> > Ui
o ono (Strip 1 - Mono) =-{/|[Eg Sterec Mix Bus 1
2-[V|@a Stereo Mix Bus 1 N [ ] Bus Selector #1
L] Bus Selector =1 v Bus Selector #2

]

- Bus Selector #2 v Pan
L L Pan - V@@ Gain Bus 1
—-[V|@a Gain Bus 1 - Vi@ Gain
LV Gain =V Mute Bus 1
+-[T|@l Mute Bus 1
=-{«][EF8 Mana (Strip 2 - Mona) Phase
2-[V|@a Stereo Mix Bus 1 Dither
L] Bus Selector #1 Repro
- Bus Selector £2 SoloSafe
LT Pan

—J B3 Gain Bus 1
i J@ Gain
- B3 Mute Bus 1
e-{¥|[E8 Mono (Strip 3 - Mona)
£-[¥][E@ Mono (Strip 4 - Mono)
7-[¥][ @ Mono (Strip 5 - Mono)
: Mano (Strip & - Mona)
7-[¥][E@ Mone (Strip 7 - Mono)
7-1¥][E@ Mono (Strip 8 - Mono)
7-[V][E@ Stereo Mix (Strip 9 - Stereo Mix)

F] - [F][F[F - [F - F - [F
e

m Mothing

Filter Mixer Controls to Snapshot dialog

This dialog is similar to the Pyramix dialog. The By Strips and By Types buttons switch between the two views.
Note: Switching between views restores selections to the default. l.e. All selected.

By Strips

In this view every automatable control in the current mixer is displayed in a tree structure. Ticked boxes include
the control or group of controls in the snapshot.

The All button ticks every box.
The Nothing button unticks every box.

. Select the mixer controls to be included in the snapshot.

. Click on OK to record the snapshot and close the dialog.
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Erase a Snapshot

. Select the Cue from which you wish to remove a Snapshot.

. Open the Cue Properties pane (if not already visible)

. In the Snapshot field click in the Type ComboBox and select None
Glide

When a Cue containing a Snapshot is Fired any changes are applied instantaneously by default. This behaviour
can be modified. Options are: over a user-defined time period linearly or over the entire length of the Cue linearly.

To modify the default behaviour:

. Open the Cue Properties pane.

. In the Mixer Automation Section

. Click in the Glide field.

. For a user defined glide time type a suitable value in the _:_:_:_time entry area or:

. For a glide over the entire length of the Cue choose Cue Length from the drop-down list.

Note: If a value longer than the Cue length is entered the Glide will occur over the Cue
length.

Apply Snapshot
To apply a Mixer Automation Snapshot simply Fire the Cue

Note:  Two snapshots controlling the same Mixing Console controls at the same time
will “conflict”. Please avoid this situation.
Snapshots can be Auditioned, however FF/REW and Scrubbing is not possible.

Copy and Paste Snapshot
To Copy a snapshot simply Copy the Cue containing the snapshot.
To Paste a snapshot select the target Cue and choose Paste Automation from the Cue right-click context menu.

Alternatively, select Cue > Paste Automation. The automation snapshot is added to the target Cue without
affecting the Media file or any other parameters.

Ovation Concepts : Snapshot Automation
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Show Logging

Show Logging creates Log Files listing every Audio file played. This is useful for broadcasters.
Logging is enabled and set up in the Show Properties pane. Please see: Show Logging Section on page 92

New Log Files are created Every Show, Every Week or Every Month and may be saved in any Folder accessible to
Ovation. Log Files are never deleted, new files are created with the date and time in the filename.

The filename can include:

. Station Name

. Station Name + Date

. Station Name + Show Name

. Station Name + Show Name + Date

Log Files are created in any of the following formats:

. ASCII Text (.log)

. XML (.xml)

. Enco DAD log file (.exp)
Examples

ASCII Text (.log)
2013-04-03 16:07:40 00:00:02 | Love Rock N Roll.wav

XML (.xml)
<Cue>

<Name>I Love Rock N Roll</Name>
<Date>2013-04-03</Date>
<PlayedAt>16:32:21</PlayedAt>
<Duration>00:00:07</Duration>

<FileName>| Love Rock N Roll.wav</FileName>

<PathName>E:\Media\Music\l Love Rock N Roll.wav</PathName>
</Cue>

Enco DAD log file (.exp)
16:09:0100:00:0104/03/1300000I Love Rock N Roll Love Rock N Roll.wav

Other Modules

Itis possible to call other applications such as audio editors from within Ovation and exchange data with them.
For example, the Merging Technologies Pyramix audio editor. Third-party applications will also be supported.
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Editing with Pyramix

In a MassCore™ system an audio Cue, Mono, Stereo, multi-channel or a multi track composition may be opened for
comprehensive editing by invoking Edit from either the right-click context menu while hovering over a Cue or for
the selected Cue from Cue > Edit. However, before Pyramix editing can be used, Pyramix must be open and both
applications set up in a specific way.

For example, to set up for editing stereo Cues :

1. Close Ovation if open.

2. Open the VS3 Control Panel.

Merging Technologies Virtual Studio Sem I,&J

/‘E Application | Ovation =)

Platform | MassCaore - |

Cores Allocation [zhared by all applications- requires admin rightsz)

Windows B D 2  MazzCore [Dedicated)

Latency

@ Low latency [5.33ms (8 43, 96, 192, 384K Hz]
AESET [4ms (2 48, 96, 132, 384k Hz)
Estra low latency [2.66ms (23 48, 96, 192, 384K Hz]

Ilkra howe latency [1.33me (@ 43, 96, 192, 384KHz]

Hardware
On Bus Wideo/ TC M anitor Jack

J—% [ @

Ravenns

Audio Bndge
Dizable MNumber of Channels [I.-"I:I]:| 2

@ ASIO Device Mode [ho create a virtual 2510 Device in the syestem)

Secondary Audio Device Host Mode
[to connect to an existing Audio Device in the spstem az a secondary [/0]

Fewire Miker Mode [to create a Fewire Miker in the spstem)

(0]4 | [ Apply ] | Cancel

.- -

Check that the Application drop-down list is displaying Ovation and, if it isn't, choose it from the list.
Check that the Platform drop-down list is displaying MassCore™ and, if it isn't, choose it from the list.
In the Audio Bridge section choose ASIO device Mode. VS3 Control Panel
Set the Number of channels (1/0) drop-down list to 8

Now select Pyramix Virtual Studio from the Application drop-down list

Also select Native - ASIO from the Platform list.

¥ ® N o v »Ww

Select MT ASIO Bridge from the 1/0 Selection Driver name: drop-down list if not already selected.

10. Start Ovation go to Settings > Show Settings > Mixing Console > Slots Allocation.
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11.
12.

13.
14.
15.

16.

In the Slots Allocation drop-down list set the value to 6

Now open the Ovation Mixing Console (View > View Mixer) and for Strips 7 and 8, set the Live INPUTS to
MT ASIO Bridge 1 and 2 respectively.

Start Pyramix
Create a new Pyramix Project and name it “Ovation Edit” or similar. A simple 8:2 mixer will do nicely.

Open the Mixer Monitoring Section, select the Configure Tab and create a new Speaker Set. Name this as

something you will remember such as “Ovation Edit” and patch the L and R Speaker OUTPUTS to MT ASIO
Bridge 1 and 2. Now activate the Speaker Set. (Alternatively you can simply patch the Pyramix Mixer Stereo
output strip outputs to MT ASIO Bridge 1 & 2)

Now save the Pyramix Project with a memorable name such as “Ovation Editor”.

Now you can right-click on a stereo Cue in Ovation and choose Edit.

17.
18.
19.

The selected Cue will open in Pyramix.
Edit in Pyramix until you are happy with the results.

In Pyramix select Project > Ovation > Publish to Ovation and the edited Cue will appear in the same place in
Ovation.

(Alternatively, choose Project > Ovation > Publish to Ovation as a New Cue. The edited Cue will then
appear in the Ovation Cue List directly below the original with the same name and the suffix (New) E.g. if the
original Cue is named steampass2 then the new one will be named steampass2 (New).)

Note: Pyramix must be opened AFTER Ovation and with an empty project loaded
before invoking Edit

Note: If you wish to edit Multi-channel Cues then simply follow the above set-up proce-
dure increasing the number of slots and changing speaker/output mappings as appro-
priate.

Note: When Edit is invoked from an Ovation Cue the existing Pyramix Project will be
overwritten with the new Cue. l.e. all existing tracks will be deleted and new tracks cre-
ated to accommodate the new Cue for editing.

Note: Clip Gain and Envelope ARE supported and published to Ovation.

When a Cue edited in Pyramix contains Envelope information this is published to Ovation.

Clip Gain set in a Cue edited in Pyramix is published to Ovation. (Gain value applied is not visible in Ova-
tion)

Ovation Concepts : Editing with Pyramix

‘AMERGING



MEDIA SERVER & SEQUENCER

Record

Recording

Overview

Ovation is able to record up to 8 channels of audio at a time using a mixer which is independent of the Ovation
output mixer.

Operationally, recordings are made into Cues in Cue Lists. The new recording can replace the Audio media file or
files referenced by the Cue currently or recordings can be made into a new, empty Cue. Recordings may be made
in Compose Mode or Show Mode whether the Show is running or not. (Provided that Forbid Editing is set to No
in Show Properties > Show Time Properties.) When recording in Show Mode all features of the Ovation user
interface operate just as they do when no recording is taking place.

Recordings are made in 24 bit Broadcast Wav format (.bwf) at the sampling rate of the current Show.

Initiating Recording
There are two methods of initiating a recording.
. To replace the Audio Media in an existing Cue with a new recording:
. Select a Cue in a Cue List.
. Choose Record Audio from the right-click context menu or Cue > Record Audio
. To record Audio to a new, empty Cue:

. Choose Add Cue > Record Audio as New Cue from the right-click context menu or Cue > Add Cue
> Record Audio as New Cue.
(Alternatively you could create a new empty Cue then proceed as for replacing the Audio Media in
an existing Cue.)

Either method of initiating a recording will open the Record Audio dialog:

Record Audio Dialog

=TT

Mame : steampasses
Input Slot : |1 v| MNocChamnels: [z v | ResetMixer toFactory | | ShowjHide Mixer |

Progress : 00:00:00:000 Record ] | Cancel

Record Audio dialog

Name When the dialog is opened to replace the Audio Media in an existing Cue the field
will contain the existing Cue’s name.
When the dialog is opened to record a new Cue the field defaults to Recording
Audio Cue.... In either case a new name for the recording can be typed in the field.

Input Slot The combo box enables the choice of the first Mixer Input which will be used as
the record source.

Nb Channels The combo box sets the number of channels to be recorded. (Maximum 8)

Reset Mixer to Factory Restores the mixer to the default 8 mono inputs, one stereo output.

Recording : Record
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Show/Hide Mixer Toggles the Record Mixer visible/hidden. (Default is hidden.)
Progress The counter shows elapsed time from the beginning of recording.
Record Click the button to start recording.

Cancel Click the button to cancel recording and close the dialog.

Note: The Record and Cancel buttons are modal. When recording they offer the follow-

ing options:
wonnse S ==
Mame : Recording Audio Cue...
Input Slot : | 1 Mb Channels : | 2 Reset Mixer to Factor | Shaow/Hide Mixer |

Progress : 00:00: 10:440 Stop & Accept Abort & Try Again |

Record Audio dialog - recording

Stop & Accept Click the button to stop the recording, close the dialog and link the recording to
the selected Cue.

Abort & Try Again Click the button to cancel the recording, delete the file and leave the dialog open
for another recording.
Note: If the Cue being recorded is deleted or the list containing the Cue is closed the
recording will be terminated correctly and the file will be created properly but no Cue
will be created or changed to point to the recording.
If a Record Audio operation is Undone then the Cue returns to its previous state or is
removed but the Audio Media file is retained.

Recording File location
Files created by recording will be located in the Audio Files sub-folder of the folder containing the Show file.
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Record Mixer

‘AMERGING

A dedicated Record Mixer is created when the Record Audio Audio dialog is opened:

Default Record Mixer
The Mixer can be displayed using the Show/Hide button in the Record Audio dialog.
By default, the Record Mixer is created with 8 mono inputs strips and one stereo output bus.
Inputs are connected to Channels 1 to 8.

The mixer is configurable as desired and will be recalled in the same state when the Record Audio dialog is
opened subsequently.

Note: VERY IMPORTANT

If you wish to use Record Mixer outputs for monitoring etc. then please ensure the phys-
ical outputs selected are NOT already assigned to the Ovation output Mixer. If outputs
already in use in the OV output Mixer are assigned to the Record Mixer they will be reas-
signed and the relevant outputs from the OV output Mixer will be disconnected.

Note: For detailed information about mixer configuration please see the Pyramix User
Manual.

Recording : Record




Ovation User Interface

Overview

The Ovation user interface has been designed from the ground up for composing and running shows. A show can
contain Media and Trigger Cues of many types and these can be fired manually or automatically to suit the appli-
cation.

Commands and functions can be accessed from buttons, pull-down menus, contextual pop-up menus and key-
board shortcuts.

There are generally several ways of accessing any given function in Ovation. Sub-sections of the interface are sep-
arate, dockable, nestable panes that can be shown or hidden and arranged automatically or by the user. This is
intended to enable users to work in the manner they find most comfortable for the type of task they are undertak-
ing. It also means ‘Power Users’ can develop highly efficient operating procedures.

Itis perfectly possible to use Ovation casually, or as an operator, without discovering all of the many available pos-
sibilities. However, for Show designers, a far more rewarding experience awaits.

User Interface Options
Apart from conventional menus Ovation offers many other Ul options:

Fire Command

The Fire Command acts like Double-Click when in Show Compose Mode and is mapped by default to the Space
key. So:

. In Edit Mode, Space Bar toggles Audition / Stop.
. In Show Mode, Space always Fires the Cue.

In Show Mode, Enter initiates Fire Sequenced Cue ! (Fire and Select Next Cue).

Context Menus

Right-clicking pop-ups menus with commands and options relevant to the current cursor location.

Keyboard Shortcuts

In particular we would encourage users to use keyboard shortcuts and preferably the standard Ovation mapping.
Keyboard shortcuts can be fully customized.

Hardware Control Surfaces

For many applications a hardware control surface and or touch-screen will be desirable if not essential. Merging
Technologies offer a versatile, dedicated controller for Ovation and our Sales Partners can help with bespoke solu-
tions.

Mouse Modifier Keys

The range of possible actions resulting from a mouse click are extended by the use of Keyboard Modifiers. These
aid productivity and are well worth learning. Please see: Appendix VI on page 227
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Main Window

If Ovation is launched without any Cue Lists present it opens as a blank canvas with no panes present. You will
see the main Ovation window with its Menus at the top and the Show Controls with Time Display at the bottom.:
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Main Ovation Window

Fixed Buttons
At top right the standard buttons are standard Windows items.
Minimize Minimizes the Main Ovation Window to the Taskbar.

Maximize / Restore Toggles between Maximizing the Main Ovation Window and Restoring it to the size
and position it occupied prior to being minimized / maximized

Close Opens the Exit Ovation dialog

-
Exit Ovation A ﬁ

i 1 Really want to exit Ovation ?

Ok H Cancel ]

Exit Ovation dialog

‘ Ovation User Interface : Main Window
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Click on OK to close Ovation or Cancel to exit the dialog without closing Ovation.

Main Window, Panes and Toolbars

The Ovation user Interface is based around a Main Window with sub-windows or Panes. These Panes (and Tool-
bars) can be positioned anywhere on the Windows Desktop, they do not have to remain inside the Main Ovation
Window. Panes and Toolbars are ‘magnetized’ to each other and to the edges of the Main window when in close
proximity. Panes and Toolbars will also resize automatically when close to the Main window edges. The new size is
shown as a semi-transparent grey box. Resizing only takes place when the mouse button is released. Blue “Land-
ing Lights” show where a Pane will dock.

Double-clicking in the Pane title bar toggles its size and position between current and last or docks the Pane in the
Main window.

Nested and Combined Panes
Nested Panes

Panes, e.g. Cue lists or Properties can be nested by simply dragging, say Cue List 2 over Cue List 1 Until the blue
“ghost” pane covers most of the existing pane.and the centre blue landing light is lit.

2 station i
00:00:46 A1

3 trainwhistle T Li)
2 - Cue List 2 (Hot Keys)

3 dungeondoor

000019

4 eerievoices

00:00:21

Cue List Pane with Cue List ready to dock - Compose Mode
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Here is the result:

2 - Cue List 2 (Hot Keys) *

1- Cuelistl 2 - Cue List 2

2 strangechoir 3 dungeondoor

0:00:18 00:00:15

00:00:21

Cue List Pane with Nested Cue Lists - Compose Mode

The large buttons at the top enable the focus to be switched between the nested Panes, in this case:
1-Cuelist 1, 2 - Cue List 2.

Panes can be Un-Nested by clicking and dragging on the large Cue List label buttons.

‘ Ovation User Interface : Main Window
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Combined Panes

If a Pane is dragged over another near the edges a Combined Window can be formed. This can be Closed or Auto-
hidden as a single entity. Depending on where the Pane is dragged Panes can be combined vertically or horizon-
tally. In the following image you can see a pair of Properties Panes Combined with two nested Cue List Panes.

1 - Cue List1 (Standard Cue List) X

1-Cuelistl 2 - Cue List 2

2 station

Wi

00:00:46 A1l

3 trainwhistle

Cue Properties

= Cue
Mumber

Mame

Comments

e
00:00:06 A1

Show Properties

Show Start Time 00:00:00:000
1 Chaze Offzet +00:00:00:000
steampasses B Show Time Options

Hide Menus

Hide Toolbars

Freeze Panes

Pinned to Active Cue Windo| Yes

Length

00:00:25:040

Show Validation
Forbid Editing

Combined and Nested Panes - Compose Mode

Here you can see that Cue List 1 has the focus. Properties are displayed for the selected Cue, highlighted in dark
gray, in the selected Cue List, highlighted in pale green.

Cue List Properties are pale green, Show Properties are blue and Cue Properties are gray.

Ovation User Interface : Main Window

‘AMERGING



MEDIA SERVER & SEQUENCER

Toolbars

Ovation is equipped with a number of standard Toolbars. These can be shown in the user interface or hidden as
required. It is also possible to show Toolbars in Compose Mode and hide them in Show mode by setting the Hide
Toolbars field in Show Properties to Yes.

All Main Window toolbars including the Menu toolbar can be made floating by clicking to the left of the first entry
until the cursor changes to Move 4—|:—> and dragging to a new location. If a floating Toolbar is dragged close to the
edge of the Main Window it will snap to a docked configuration.

Toolbar Context Menu

Right-clicking on a blank part of the Main window header or footer opens the Toolbars menu :

Show
Cue List

Create Cue List
Cue
Fire

Settings

Show Control

Audition

Customize...

Toolbars context menu

Checked entries in the list will be present in the Main Ovation window.

‘ Toolbars : Toolbar Context Menu
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Audition Toolbar

Selecting Show > View Audition Toolbar adds the Audition Toolbar to the bottom of the main Show Window.

Audition Toolbar

The buttons should be self-explanatory but, just in case, from left to right we have:

Start of Cue or Previous Cue if cursor is at Start of Cue - Rewind - Stop - Start / Pause - Fast Forward - Next Cue

These controls act on the currently selected Cue.

Audition Jump

There are six Audition Jump commands. These commands are available only when Auditioning a Cue and via
Keyboard Shortcuts or with a modifier key when clicking on the Rewind and Fast Forward buttons in any Audition
Toolbar or on the Ovation Keyboard:

. Audition Jump Forward 1: Jump 1 Second later in time (Ctrl + -> Key or Fast Forward Button)

. Audition Jump Forward 2: Jump 5 Seconds later in time (Ctrl + Shift + -> Key or Fast Forward Button)

. Audition Jump Forward 3: Jump 15 Seconds later in time (Ctrl + Shift + Alt + -> Key or Fast Forward But-
ton)

. Audition Jump Back 1: Jump 1 Second earlier in time (Ctrl + <- Key or Rewind Button)

. Audition Jump Back 2: Jump 5 Seconds earlier in time (Ctrl + Shift + <- Key or Rewind Button)

. Audition Jump Back 3: Jump 15 Seconds earlier in time (Ctrl + Shift + Alt + <- Key or Rewind Button)

‘ Toolbars : Audition Toolbar
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Audition Drop-down

In a Cue List pane, clicking on the down arrow immediately to the right of the Audition button drops down the
Audition transport controls. These are identical in function to the Audition Toolbar.

1 - Cue List 1 (Standard Cue List)

LB

00:00:45 A1

W
00:00:06 Al

4 bell Wi
00:00:42 A1

trainwhistle

F steampass2 i
00:00:31 A1

LB

00:05:08 A1

Kerberos Reel 1 6track44 Rob

|

Wil Chang:  mation
i

I Audition

M4 Start
4 Rewind
I+ Play/Pause

¥ Fast-Forward
el  End

Standard Cue List Pane with Audition Drop-down - Compose Mode
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Show Controls

<J>RORAJVYES RSN n | = Boosrss Rl

Ovation Main Window Show Control Bar

The Show Control bar at the bottom of the main screen can be made floating in the same manner as the Menus.
l.e. click and drag at the left-hand edge when the cursor changes to a cross.

If the Show Control bar is dragged near to an edge of the Main Screen it will re-dock, horizontally or vertically.
Otherwise it can be placed anywhere on the Desktop.

Select Previous Child-Cue in currently selected Cue List

Select Next Child-Cue in currently selected Cue List

Fire Selected Cue in currently selected Cue List and select next Cue and make Ready
to Fire

Select Previous Cue in currently selected Cue List

Select Next Cue in currently selected Cue List

Toggle through Cue Lists in ascending order (with Shift in descending order)

Fire Selected Cue in currently selected Cue List. Cue remains Ready to be Fired
Again

| B =] B [4]

Pause Selected Cue in currently selected Cue List

Stop Selected Cue in currently selected Cue List

o
e
=)

0:30 Show Time Counter Displays selected Time format when Show is running

Initialize Show Prepares Show for Running. Cue Lists displays change to Show
Mode

Toolbars : Show Controls
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Start Show Timed Cues fire at appropriate times. Hot Key Cues can be Fired at will.

Pause Show Opens the Pause Show dialog:

ZETE

Are you sure you really want to Pause the Show ?

-

[ OK ] | Cancel |

Pause Show Dialog

OK Pauses the Show, Cancel closes the dialog without affecting the Show.

Pause Show button with Show Paused.

Clicking on Pause Show when the Show is Paused, Re-starts the Show from the point at which it was Paused.

Stop Show Opens the Stop Show dialog

Eme s

Are you sure you really want to Stop the Show ?

[ Ok ] | Cancel |

Stop Show Dialog

OK Stops the Show. Cue List displays return to Compose Mode and the Time is reset if Time Mode is Duration.
Cancel closes the dialog without affecting the Show.

Note: The Pause Show and Stop Show dialogs can be suppressed in the Show Proper-
ties pane. Useful for rehearsals and when constructing a Show.

Other Toolbars

The other Toolbars are accessed by right-clicking on a blank area of the main Ovation Window header or footer
and selecting them from the context menu. All the extra Toolbars are user configurable. The down arrow next to
the far right icon gives access to the current Toolbar’s buttons plus Customize... Buttons visible currently in the
Toolbar are highlighted in blue. Clicking on an entry in the list toggles it shown/hidden. The last entry in the list is
Reset Toolbar this does what it says and resets the Toolbar to the default condition. l.e. all buttons present.

‘AMERGING
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New Show

Open Show

Save Show

Initialize Show

Start the Show

Pause the Show

Stop the Show

Consolidate the Show

Package the Show

Toggle Show Properties pane show/hide

Toggle Show Validator pane show/hide

Toggle Show Log pane show/hide

Toggle Show Control Toolbar show/hide

Toggle Audition Toolbar show/hide

Toggle Active Cue Window show/hide

Toggle Audio Gain Matrix show/hide

Toolbars : Other Toolbars
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-
f:) Toggle Audio Control Fader show/hide

Open User Manual

About Ovation
1N

Cue List

EHE0EA b=

NEW New - drops down the list of possible Cue List types. Selection opens new list.

Open Cue List

Save Cue List

=) |50 | @

Toggle Cue List Properties pane show/hide

Fire /Start Timed List

Start Timed List

Pause Timed List

Stop Timed List

Chase Timed List

Fire Toolbar - Toggles Fire Toolbar show/hide in selected Cue List in Show Mode for
selected window

Edit Toolbar - Toggles Edit Toolbar show/hide in selected Cue List in Compose Mode for
selected window

Toggle/Select Cue List - Cycles the selection through open Cue Lists

o |7 |2

Toggle/Select Hot Key List

‘ Toolbars : Other Toolbars
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Create Cue List
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)

New Standard Cue List

New Timed Cue List

New Hot Keys Cue List

7| 2| | &2

New Custom Keys Cue List

15

New Cue Browser

New Hot Browser

g6 | .’_‘"‘_IEI a4 li?]l@'lhdd B |C S| % |¢]| » Audition F

“—_) Undo
A

éﬁ Cut
0] e
m Paste

Toggle Cue Properties pane show/hide

Open Cue Rules window

Open Cue gain fader dialog

Add Add - drops down the list of Cue add options

Remove - selected Cue
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P Edit - Cue in Pyramix (if already open)

&-] Replace Audio Media - Opens a browser to select an alternative Audio Media file/Compo-
sition.

ﬁ Snapshot Automation

rﬂ Paste Automation

- = Audition - Click on the button to Audition the selected Cue or the
I» Audition down arrow to drop-down the Audition transport controls.
J;l Pin/Unpin Cue to the Active Cue Window

Places and Locks selected Cue in the Active Cue Window (Only available when Lock is
active in the Active Cue Window)

+ Move Down

f Move Up

Ly Nest

l"I Un-nest

QO Link Offsets / Start Times

Fire

Fire Selected Cue

l"' Select Previous Scene

Select Next Scene

Select Previous Cue

‘ Toolbars : Other Toolbars
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<+ Select Next Cue

’ Fire Selected Cue

i Pause selected Cue

o Stop Selected Cue

Stop All Cues
Settings
Q

Tx Open Settings Window
Q Open Keyboard Shortcuts Window

Show Menus and Toolbars in Emergency

The Hotkey combination Ctrl + Alt + Home brings back the menus and all selected Toolbars when in Show Mode
to give access to all commands in case of emergency.

‘ Toolbars : Show Menus and Toolbars in Emergency
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Features & Functions

Active Cue Window

The Active Cue Window displays information about, and enables various operations to be performed on, the Cue
selected currently in both Compose and Show modes.

Cursor Position, Position in Audio File and Zoom Level is remembered when switching between Cues.

Compose Mode

1-Cue List1

:

o8 8} RONONO

Cue List and Cue

Active Cue Window - Compose Mode

1-Cue List1

Active Cue Window - Cue List and Cue

Below the Upper Toolbar the first bar shows the Cue List where the Active Cue is located. The second bar shows
the Active Cue. The two buttons to the right activate Pinned mode or Locked mode.

Lock and Pin

Pinned Mode
Pinned Mode enables only Cues with “interesting” content to be displayed in the Active Cue Window.

4

When the Pinned button is inactive all types of Cue are shown in the Active Cue Window as

they are fired.

Active Cue Window : Features & Functions
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When the Pinned button is active only Cues with the Pinned to the Active Cue Window
Fl parameter set to Yes in Cue Properties will be shown as they are selected. Audio Cues are
Pinned by default. Other types of Control Cue are unpinned by default.

1 - Cue List 1 (Standard Cue List) *

W)

00:00:46 Ad

trainwhistle Wi
00:00:06 Al

e
00:00:42 AB

steampass2 Wi
00:00:31 A1

Cue List with Pinned Cues in Show Mode

Override

Alt + Click on an Unpinned Cue overrides the Pin function temporarily and substitutes this Cue for the current
Cue.

Note: The Pinned icon is only shown in Cues in Cue Lists when Pinned is active in the
Active Cue Window.

‘ Active Cue Window : Features & Functions
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Locked Mode
Locked Mode when active locks the Cue displayed currently to the Active Cue Window. No other Cues will be dis-
played until Lock is deactivated.

Override
Alt + Click on another Cue overrides the Lock temporarily and substitutes this Cue for the current Cue.

E| Unlocked. Cues are displayed as they are selected or fired.

. Locked. The Cue currently displayed is locked to the Active Cue Window.

1-Cue List 1 *

1 steampasses Wil
Ready 000017 A1

trainwhistle Wi
Ready 00:00:06 Ad

4 bell Wi
Asleep 000042 AB

K steampass2 Wil
Azleep 00:00:31 Al

Cue List with Locked Cue

In a Cue List the Cue locked to the active Cue Window is shown with a Lock symbol to the left of the name.

‘ Active Cue Window : Features & Functions
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Active Cue Window - Trimmer

Navigation

Marker Button

The Marker button gives access to the Marker management functions. Please see: Markers
on page 85.

Scroll Bar
The Scroll bar and Nudge buttons, Zoom In / Zoom Out / Zoom-To-Fit buttons control the view of the Cue in the

Trimmer.

The size of the Scroller handle changes according to how much of the Cue is visible in the Timeline.
The Nudge buttons scroll the view of the Cue left or right in one second increments.
Zoom In

Zoom Out

Zoom-to-fit

[o] Ce] (o] []

Timescale Ruler
The Cue selected currently is shown in the Active Cue Timeline starting at 00:00:00:000.

Double-clicking in the Ruler auditions the Cue from the mouse cursor position within the active area.
Clicking and dragging in the Ruler moves the Timeline.

Audition Cursor

. In Stop mode, with the Alt key pressed and held, placing the mouse cursor on the Audition Cursor in the
Timeline Ruler and clicking auditions the Cue while the left mouse button is held down. (Mouse Cursor
changes to I-beam) Audition Cursor flies back to Mouse Cursor position when button released.

. In Stop mode the I-beam mouse Cursor moves the Audition Cursor without playing.

. When Stopped or Paused and calling Audition or Fire from the Active Cue Window playback starts from
the current Audition Cursor position, i.e. from where previous playback stopped. This allows for, when for
example rehearsing a show, the rehearsal to be resumed from the middle of a Cue and not from its begin-
ning.

Active Cue Window : Features & Functions
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. After pressing the Audition Stop button twice the next Audition or Fire will start from the beginning of the
Cue.

When calling Fire or Audition from outside the Active Cue Window (Menu, Keyboard, Show Control Toolbar, etc...)
the Active Cue is Fired from its current IN point.

Trimmer Waveform Display

The visible portion of the selected Cue is displayed and the active portion of it is highlighted in lighter gray. The
four boxes at the corners of the shaded area are handles. These handles can be dragged to adjust the Start, End,
Fade In and Fade Out points graphically. The bottom handles set the In and Out points and the top handles adjust
the Fade In and Fade Out. Double-clicking a handle restores the default value. l.e. the Cue boundary for the In
and Out handles and No Fade for the Fade Handles.

Note: The Start and End points can be dragged out beyond the boundaries of the Media
to provide a Start Offset / Preroll and or an End Offset / Postroll.

Zoom and Move

a cross moves the entire Timeline.
Clicking and dragging vertically anywhere in the Timeline and Ruler while the cursor is a
cross zooms into or out of the Timeline

Trim with the Mouse

ﬁ Clicking and dragging horizontally anywhere in the Timeline and Ruler while the cursor is

The Cue can also be modified with the mouse.

. SHIFT+Click moves the Cue IN to the current mouse position.

. Ctrl+Click moves the Cue OUT to the current mouse position.

Review while trimming:

. To review the Cue while trimming the in point, simply audition it (either by using Audition Play/Pause or
Review Start): Each time the Cue IN is modified with one of the above methods, the Cue is restarted from
its new IN point.

. To review the Cue while trimming the OUT point, simply press Ctrl + Review End: When the audition gets
to the current Cue OUT point, it loops the last second of the Cue.

Note: The Preroll and Cue Out Loop durations are set in Settings > Application Set-
tings > General > Audition. While the Cue loops, you can trim the Cue out precisely
with quick and interactive feedback of the current result. Once the Loop Out mode is
enabled by Ctrl + Clicking the Review End icon button all the subsequent keyboard-
shortcut calls to Audition Review End (Ctrl + Alt + Space) will play in Loop out mode,
until the “Review end” icon button gets mouse-clicked without the Ctrl key. When
working with the mouse, you can choose to press Ctrl or not, each time you review the
end of the Cue.

Audition Toolbar

From left to right the buttons are:

Active Cue Window - Audition

Start of Cue or Previous Cue if Playhead Cursor is at Start of Cue - Rewind - Stop - Start / Pause - Fast Forward -
Next Cue

The Audition Toolbar is visible in Compose Mode and will be merged with the Fire Toolbar in Show Mode if the
Forbid Editing field in Show Properties is set to No.

‘ Active Cue Window : Features & Functions
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Show Mode

Note: The Active Cue Window displays the Cue selected currently in the Cue List selected
currently. l.e. NOT the Cue playing unless this is also selected.

1-Cue List1

Active Cue Window - Show Mode

In Show Mode the Active Cue Window is simplified by the removal of the top Toolbar and Audition toolbar (If
present). Fire, Pause and Stop appear at bottom left. If the Forbid Editing field in Show Properties is set to No
the Fire and Audition Toolbars are merged in Show Mode. See below:

‘ Active Cue Window : Features & Functions
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Show Mode With Merged Toolbars

Auditioning a Cue

1-Cue List1

Active Cue Window - Show Mode with Merged Toolbars
If the Forbid Editing field in Show Properties is set to No then the Fire and Audition/PFL Toolbars are merged
and if Hide Toolbars is set to No then the top toolbar is retained in Show Mode.

Cues can therefore be auditioned while the show is running by selecting them and using the Audition buttons.

Cue Fired

Active Cue b
EDRE00 I B

Active Cue Window - Show Running - Selected Cue Fired

When the selected Cue is Playing in Show Mode the Rewind, Stop, Play/Pause and Fast Forward buttons are
unavailable. (Grayed out.)

‘ Active Cue Window : Features & Functions Page 82
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Active Cue Window Edit Toolbar
Hidden by default, the Edit Toolbar can be shown by selecting View > View Active Cue Window Edit Toolbar.

Nudge

Cue Properties Opens the Cue Properties pane with details of the Active Cue

Cue Rules Opens the Cue Rules window

Cue Gain Opens the Cue Gain Window

Edit Opens the Active Cue ready for editing in Pyramix (Pyramix editing must be set up
and Pyramix launched before Ovation if this function is required.)

Replace Audio Media

Snapshot Automation

Snapshot Automation Paste

Audition clicking on Audition auditions the Cue. Clicking on the small arrow gives
access to the Audition transport controls. (Same as those at the bottom of the Window
plus the Jump options. Please see: Audition Toolbar on page 67)

Link Offsets/Start Times Links all Audio, TCGen, MMC and 9-pin (Sony P2) Offsets and
Start Times in a Cue with these properties. The button toggles on/off and it's state is not
saved when a different Cue is Active. When enabled all related field names in the Cue
Properties pane turn red for clarity.

The Nudge button functions affect the Cue in the increments set in the drop-down list. Increments range from 1
sample to 100 seconds.

£

t
4
>
£
s

Nudge Cue In Less (earlier)

Nudge Cue In More (later)

Nudge Cue Out Less (earlier)

Nudge Cue Out More (later)

Nudge Fade In Less (earlier)

Nudge Fade In More (later)

Active Cue Window : Features & Functions
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Nudge Fade Out Less (earlier)

Nudge Fade Out More (later)

Nudge Cursor Less (earlier)

Nudge Cursor More (later)

Snap Cue In to Cursor

e |12l | sl IER  EA 115

Snap Cue Out to Cursor

1 sample . Nudge Value
E Review Start

H Review End

‘ Active Cue Window : Features & Functions
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Markers

Markers, in combination with Interaction Rules are a very powerful Ovation tool.

(IR SEDEIES DN

16
_RoReRe

Add Marker st
Edit Selected Marker Interaction Rules : ' s

Remove Selected Marker

Goto Marker 1
Goto Marker 2
Goto Marlker 3

a1 0RO

Active Cue Window Markers Drop-down Menu

Clicking on the Markers button drops down the Markers Menu. When a Cue has no Markers only the Add Marker
entry is active.

Markers Menu

Add Marker Adds a new Marker at the current Audition Cursor position. Note: existing Markers subse-
quent to the new Marker are renumbered.

Edit Selected Marker Interaction Rules Opens the Interaction Rules dialog.

Remove Selected Marker Deletes the Marker selected currently. Note: existing markers subsequent to the deleted
Marker are renumbered.

Goto Marker 1 Locates the Audition Cursor to Marker 1.

Goto Marker 2 Every Marker added will show up here as a Goto Marker x entry.

Markers in the Timeline Ruler

. Clicking on a Marker in the Ruler selects it. Selected Markers are highlighted.
. Click and drag a Marker in the Ruker to move it.
. Double-clicking on a Marker in the Ruler opens the Interaction Rules dialog.

Note: Markers are always numbered in the chronological order they appear in the Time-
line. So, if Marker 4 is moved before Marker 1 it is renumbered as Marker 1 and all subse-
guent markers are renumbered accordingly. The same applies when Markers are added
or deleted. The left-most Marker will always be 1 and Markers are always numbered
sequentially. Note also that Markers with Interaction Rules have an exclamation point.!

‘ Active Cue Window : Markers
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Markers in Cue Properties

LI T Ol e IR,

Output Player

B Markers
Markers Selected Marker: 3
Marker Mame Chuff end
Marker Offset +00:00:15:132

Fire Itself at Marker 1 When Reaching Marker

Marker Interaction Rules

A Tirmad Fona

Cue Properties - Markers Section

Markers Section

Markers Clicking in the Selected Marker: x field or on the down arrow drops-down the
Marker Menu.

B Markers
Selected Marker: 2 j
Marker Mame Add Marker
Marker Offset Remove Selected Marker
Select Marker 1
Marker Interaction Rules Select Marker 2
Select Marker 3
Cue Properties - Markers Section - Markers field
Add Marker Adds a new Marker at the current Audition Cursor position. Note: Subse-
quent existing Markers will be renumbered.
Remove Selected Marker The selected Marker is deleted. Note: Subsequent Markers will be renum-
bered.
Marker Name Click in the field and type to add a Name to the Marker. This name will be
shown in the Active Cue window Timeline.
Select Marker 1 Selects Marker 1.
Select Marker 2 Every marker added will show up here and a Select Marker x entry.
etc.
Marker Offset Shows the Marker Offset from the beginning of the Cue. (Does not include any

Start (Preroll) Offset applied to the Cue.) Clicking in the field enables a new value
to be typed. Clicking the down arrow drops-down a list with the option of Reset.
This resets the Marker position to the current Audition Cursor position in the
Active Cue Window Timeline. (A negative offset is shown if the Cursor position is
before the start of the Cue.)

Marker Interaction Rules Shows a list of all Interaction Rules applied to the Selected Marker. Clicking in the
field shows a ... button. Clicking on this opens the Marker Interaction Rules dia-
log. Please see below.

Note: When a Cue has a Marker with a Marker Interaction Rule or rules applied this icon
is shown on the Cue in the Cue List:

O

‘ Active Cue Window : Markers
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Markers Interaction Rules

- —_— -

Fre Ttself at Marker 1 When Reaching Marker

| AddRue>> | | ModfyRuevy | |Remove Rue <<|

[Fire Ttoalf at Marker 1 When Reaching Marker '

Markers Interaction Rules
The Markers Interaction Rules dialog is very similar to the general Interaction Rules dialog with one exception:
Reaching Marker is a fixed property and therefore grayed out.

Simple or highly complex interactions can be set up. For example:

. Fire Cue XXX at Marker YYY to allow a Cue to be fired anywhere within a Cue automatically, at a Marker
position.

. Looping within a Cue (see full description below.)

. Conditional and Multiple Looping within a Cue l.e. Setting multiple rules for the same Marker enables

looping to different locations in the Cue from the same Loop Out point based on different conditions.
Looping
Just one of the Marker possibilities is Looping within a Cue.
To set up a simple loop:

1. Place two Markers, one at the Loop In point and one at the Loop Out point.

2. Either double-click the second, Out Marker or select it and choose Edit Selected Marker Interaction Rules
from the Markers button drop-down Menu.

3. Set up the following:

. Fire
. Itself
. When

. Reaching Marker (Fixed, not changeable)
4. Click on Add Rule to add the Rule to the list.
5. Click on OK to save the rule and close the dialog.

And that's it! When the Cue is fired it will play through the first Marker until it hits the second. It will then loop back
to the first Marker and continue playing around the loop ad infinitum until stopped manually. This is obviously

‘ Active Cue Window : Markers
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only a very simple example and careful use of multiple Interaction Rules enable many other possibilities. For
example stopping the Looped Cue when another Cue is fired.

For full details of the Interaction Rules Please see: Interaction Rules on page 111

Note: For a rule to be functional the system requires a period of 1 second before its trig-
gering time to prepare for triggering the rule. Therefore Markers set before 1 second
after the beginning of a Cue or 1 second before the Fade Out of a Cue will not trigger
their Rules. They will be colored Red in the Active Cue Window !

‘ Active Cue Window : Markers
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Properties Panes

Types

Ovation has three types of Properties Pane, Show, Cue List and Cue.

These Panes present information about the currently loaded Show, selected Cue List and selected Cue.

—_— The small Minus and Plus buttons on the left Collapse each main section of the Pane to a sin-
gle line and Expand it back to full respectively:

-+

Appearance
The text in Properties Panes is displayed in the font size set in View > Properties Font Size.

Properties Fields
Some fields are for ‘information only’ many others can accept text, numeric values or provide a choice of options.

Clicking in fields other than ‘free text’ or ‘information only’ pops up a down arrow. This gives access to the options

for the field.
B Length 00:00:06:000 |
Fade In 0 [ms]
Linear ﬂ
Fade Out Power
Fade Qut Curve
Stop Fade Out dB
Cosine

Root-Cosine
Interaction Rules

Properties Windows drop-down list

Numeric Fields

Many numeric fields offer a choice of likely values in a drop-down list. If you wish to enter your own value simply
click in the number field to produce a cursor and edit the value directly.

Precedence

In general settings made in Show Properties, Cue List Properties and Cue Properties have the following prece-
dence:

Cue Properties settings override Cue List Properties settings and Show Properties settings.
Cue List Properties override Show Properties settings.

Show Properties settings apply when not overridden by either Cue List Properties Settings or Cue Properties set-
tings.

Where exceptions exist to these rules they are noted.

‘ Properties Panes : Types
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Show Properties
Show Properties
E Show
Comments

Default Stop Fade Out
Maodified FadeIn
Madified Fade Qut

[Default Interaction Rules

Default Output Player
Application Delay Launch
Show Auto Start
Show Edit Password
E Show Time Mode
Show Time Mode
Show Start Time
Chaze Offset
B Show Time Options
Hide Menus
Hide Toolbars
Freeze Panes
Show Validation
Forbid Editing
Hide Properties
Cue Fire Buttons
Focused Cue Flashing Mode
Show Mode Confirmations
Saving Confirmations

Popups Confirmations

Show Logging
B TimeCode Generator
TC Gen Output Port

use Mode

Synchronization Mode
Resynchronize Drifts/Jumps

Resynchronize Difference Threshold

_llfll'J [ms]
ll.El [5]
1.0[s]

< Default Player=
0[]
Ma

Duration
00:00:00:000

'No
Yes
Mo

Mo

Yes
Mo

All Cue Lists except Hot Keys and Custom Keys

Properties Panes : Show Properties

Show Properties Pane
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Show Section
Comments Free text field where you can add comments to the Show
Default Stop Fade Out Clicking in the field accesses a drop-down list with a range of fade lengths from

0ms to 20s plus <Default> If the value is set to <Default> then the Cue Fade Out
value is used when a Cue is Stopped (interrupted).

Modified Fade In Clicking in the field accesses a drop-down list with a range of fade lengths from
Oms to 20s plus

Modified Fade Out Clicking in the field accesses a drop-down list with a range of fade lengths from
Oms to 20s

Default Interaction Rules Field contains a list of all Interaction Rules defined for the current Show. Note:
Rules shown in this field are all in force at the same time.

ividied rade Uut L 5]

Fire Mext Cue When Ending
Stop Previous Cue When Starting

Mhefar e Dby Plaver
Default Interaction Rules Field - Show Properties Pane

Clicking in the field reveals a button which leads to the Interaction Rules dialog.

Default Output Player Clicking in the field reveals a drop-down list with all OV Players installed on net-
worked PCs plus <Default Player> and <Local Player>.

Application Delay Launch  The drop-down list offers the choice of 0 [s] to 60[s].

Show Auto Start Clicking in the field reveals a drop-down list with the options Yes or No. When set
to Yes the Show loaded when Ovation was last exited starts automatically when
Ovation is next launched.

Show Edit Password Click in the field to drop-down the choice of New Password or Reset Password.
The former enables the show to be password protected for editing while the latter
resets the password to off.

Show Time Mode Section

Show Time Mode: Clicking in the field drops down the Time Mode sub-menu with the choice of:
Duration Choose this option to fire timed events in relation to elapsed Show Time
Time of Day Fires timed events in relation to system clock Time of Day
TimeCode chase Fires timed events in relation to an external (to Ovation) source of Time-
Code
Show Start Time Applicable only in Duration mode defines the starting time of the show. E.g. if the

field is set to 00:00:10:000 then, when the Show is started the counter will start at
00:00:10 i.e. 10 seconds into the duration.

Show Time Options Section

Hide Menus: When set to Yes Menus are hidden during Show Time.
Hide Toolbars: When set to Yes Toolbars are hidden during Show Time.
Freeze Panes: When set to Yes All Panes and Windows are frozen during Show Time. They cannot

be resized, moved, docked, undocked, etc...
Note: This includes the Mixer!

Show Validation: Clicking in the field reveals a drop-down list with Yes and No options. When set to
When set to Yes a Show Validation (see below) is performed when Initializing the
Show.

Forbid Editing: When set to Yes Editing and recording will be forbidden during Show Time. If this

option is set to No then Cues can be Copied, Pasted, Deleted, Dragged, etc... and

‘ Properties Panes : Show Properties
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Hide Properties:

Cue Fire Buttons

Focused Cue Flashing Mode

Show Mode Confirmations

Saving Confirmations

Popups Confirmations

Show Logging Section
Enable Logging

New Log File

Log File Name Structure

Log File Format

Log File Folder

Audio recordings made during Show Time, allowing for more interactive perfor-
mances to be achieved. Cues being modified during Show Time are immediately
updated. If they are currently playing at that time then the changes will be avail-
able for the next playback only. Cues being deleted while playing will continue
playing until they end or are manually stopped.

Clicking in the field reveals a drop-down list with Yes and No options. When set to
Yes Show Properties, Cue List Properties and Cue Properties will be hidden during
Show Time. This option is typically used with the previous one.

Clicking in the field reveals a drop-down list with Yes and No options. Default is No
When set to Yes, in Show Mode all Cues have Play/Pause and Stop buttons on the
left-hand side.

For clarity, especially in Shows with many Cue Lists, the Cue with the focus is given
a flashing red border in Show Mode. This setting determines which Cue List types
flashing mode is applied to. Clicking in the field accesses a drop-down list with the
following options:

None
All Cue Lists
All Cue Lists except Hot Keys and Custom Keys

Clicking in the field reveals a drop-down list with Yes and No options. When set to
No all “Show stopping” and “Show Pausing” dialogs will be disabled during Show
Time. Typically disabled for Remote Controlled Shows and during rehearsals. When
set to Yes cautionary dialogs will be displayed when performing actions which
would Stop, Pause, End or Change the Show.

Clicking in the field reveals a drop-down list with Yes and No options. When set to
No, no “Do you want to save..” confirmations will be shown when exiting Ovation.

Clicking in the field reveals a drop-down list with Yes and No options. When set to
No, no confirmation pop-ups for actions such as closing Cue Lists will be shown.

Clicking in the field reveals a drop-down list with Yes and No options. When Log-
ging is enabled by setting to Yes the following settings will apply:

Clicking in the field reveals a drop-down list with Every Show, Every Day, Every
Week and Every Month options. Choose the option appropriate to your needs.

Clicking in the field reveals a drop-down list with Station Name, Station Name /
Show Name, Station Name / Date and Station Name / Show Name / Date
options. This option determines how the generated Log File will be labelled.

Clicking in the field reveals a drop-down list with ASCII Text (.log), XML (.xml) and
Enco DAD log file (.exp) options.

Clicking in the field reveals a drop-down list with a Browse option. Clicking on
Browse opens a File Browser to navigate to the required Log output Folder.

TimeCode Generator Section

The Show TimeCode can be output to any available TimeCode Output Port. This can be LTC, if Ovation is running
with a Mykerinos card, or a MIDI MTC port enabled in Settings >Application Settings >Player Units > MIDI.

TC Gen Output Port

TC Gen Pause Mode
off
Freeze
Free Roll

TC Gen Stop Mode
off

Currently selected Output Port is shown. The drop-down list shows all available TC
outputs. This can be LTC, if Ovation is running with a Mykerinos card, or a MIDI MTC
port.

The drop-down list offers a choice of:
TC output ceases when the Show is paused
TC freezes at current value when Show is paused
TC continues to run when Show is paused

The drop-down list offers a choice of:

TC output ceases when the Show is paused

Properties Panes : Show Properties
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Freeze TC continues to generate current value when Show is paused

Free Roll TC continues to generate and increment value when Show is paused

TC Gen Goto on Ready Clicking in the field reveals a drop-down list with Yes and No options. If Yes
(enabled) the Start Time is generated continuously on the output port when the
Cue is made Ready, to allow a Slave device to commence locating to the Start Time
in advance of the Cue being fired.

Multi-Sequencer Synchronization Section
Synchronization Mode The drop-down list offers the choice of Master, Slave or Off.

Resynchronize Drifts/Jumps Determines whether or not re-synchronization will take place when a sync drift or
jump is detected. The drop-down list offer the choice of Yes or No.

Resynchronize Difference threshold Determines how far out of sync a sequencer must be before re-synchroni-
zation takes place. Type the desired threshold in the field. Default is 1.0[s].

Note: Synchronization is sample accurate provided Master and Slave TIME is in sync. l.e.
TimeCode Chase. A pre-roll of up to two seconds is required before output begins from a
slave Ovation.
If this is critical in your application add two seconds of silence to Cues which start at the
very beginning of the Show. Or use a TC/IP Command.
One method of achieving Time synchronization across several Ovations is to use a GPS
source.

Note: Before Multi-Sequencer Synchronization can be used an IP connection must be
established between the Master and Slave machines in Settings > Application Settings
> General > IP. Cues are configured for synchronization in Cue Properties. Please

see: TCP/IP Connections on page 157

Properties Panes : Show Properties
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Murmber 3
Mame Cue List 3

Comments

Autormatic Cue Mumbering Yes
Hidden Mo
Default Stop Fade Out < Default>

Default Interaction Rules

Default Output Player
B Timed Cue List
Tirned Mode Chasing Mo
Timed Mode TC Chase Source Show Time
Timed Mode Start Time 00:00:00:000
Tirned Mode Pauses Cues Yes
Tirned Mode 5tops Cues Yes
B TimeCode Generator
TC Gen Output Port MTC1
TC Gen Pause Mode Freeze
TC Gen Stop Mode
TC Gen Goto on Ready
Bl Hot Keys
Hot Keys Number of Coalumns
Hot Keys Column to Audio Slot Mapping
B Custom Keys
Custom Keys Grid Size
B Audio
Audio Output Slot «lse Cue Slot=

Cue List Properties Pane

Note: Some fields will be grayed out and sections collapsed depending on the Cue List
selected currently.

Cue List Section

Number Position in the list of Cue Lists of the currently selected Cue List. The Drop-down
list enables the position to be changed. The rest of the list is re-ordered to suit. l.e.
the other Cue Lists are automatically re-numbered as necessary. For example, if the
selected Cue List is currently no.2 of five then changing its Number to 1 places it at
the beginning of the list. The previous no.1 becomes 2 and everything else stays
put. If Cue List 2 is reNumbered 4, then 1 stays where it is, 3 moves up to the
empty 2 slot, 4 moves up to 3 and 5 stays where it is.

Name Name (can be changed here)

Comments Free text field where you can add comments to the Cue List

‘ Properties Panes : Cue List Properties
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Automatic Cue Numbering Default is On for Standard and Timed CuelLists. Default is Off for Hot Key and Cus-
tom Key Cuelists. Click in the field to toggle On/Off. When Off new Cues added
will still be numbered consecutively but these numbers can be removed in the
Cue Properties pane. Cue number is then determined by position in the Cue List.

Hidden When checked the Cue List will not be visible in Show Mode. This is useful for man-
agement Cuelists which contain logical instructions which are not relevant to the
operator running the show.

Default Stop Fade Out Clicking in the field accesses a drop-down list with fade times from Oms to 20s
plus <default>. If the value is set to <Default> then the Cue Fade Out value is
used when a Cue is Stopped (interrupted).

Default Interaction Rules Field contains a list of all Interaction Rules defined for the current Cue List. Note:
Rules shown in this field are all in force at the same time.

Clicking in the field reveals a button which leads to the Interaction Rules dialog

Default Output Player Clicking in the field reveals a drop-down list with all OV Players installed on net-
worked PCs plus the currently defined Show <Default Player> and <Local
Player>. When <Default Player> is selected nothing is shown in the box and the
player used will depend on the parent choices. l.e. in the Show.

Timed Cue List Section

Timed Mode Chasing Yes or No When Yes (enabled) the Cue List is fired in relation to the TimeCode
source values. When No (disabled) events are fired in relation to Show elapsed
time. Timed Mode Start Time introduces an offset.

Timed Mode TC Chase Source When Timed Mode Chase is enabled sets the TC source to be chased. Options in
the drop-down list are Show Time or any available TC input.

Timed Mode Start Time Offsets the Cue List start time values. Only available when Timed Mode Chasing is
not enabled.

Timed Mode Pauses Cues
Timed Mode Stops Cues

TimeCode Generator Section

The Cue List TimeCode can be output to any available TimeCode Output Port. This can be LTC, if Ovation is running
with a Mykerinos card, or a MIDI MTC port enabled in Settings > Application Settings > Player Units > MIDI.

TC Gen Output Port Currently selected Output Port is shown. The drop-down list shows all available TC
outputs. This can be LTC, if Ovation is running with a Mykerinos card, or a MIDI MTC
port.

TC Gen Pause Mode The drop-down list offers a choice of:

off TC output ceases when the Cue List is paused
Freeze TC freezes at current value when Cue List is paused
Free Roll TC continues to run when Cue List is paused
TC Gen Stop Mode The drop-down list offers a choice of:
Off TC output ceases when the Cue List is paused
Freeze TC continues to generate current value when Cue List is paused
Free Roll TC continues to generate and increment value when Cue List is paused
TC Gen Goto on Ready Yes or No. If Yes (enabled) the Start Time is generated continuously on the output

port when the Cue is made Ready, to allow a Slave device to commence locating to
the Start Time in advance of the Cue being fired.

Hot Keys Section
Hot Keys number of Columns Clicking in the field drops down a list with the choices of Auto (default) or 1 - 8.

Note: When the Number of Columns is set to Auto then the system automatically
adjusts the number of columns, but still follows the Automatic Cues Numbering setting
and leaves empty slots if necessary.

‘ Properties Panes : Cue List Properties
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Hot Keys Column to Audio Slot Mapping

. If set to No all Cues are played back in the Audio Output Slot defined in their Cue Properties.

. If set to a number (1, 2, etc...) then the Cues are played back in an Audio Slot corresponding to the Hot
Keys Column. In this way Hot Keys Cues can be assigned to Audio Output by the Column in which they are
placed.

Note: In this mode the actual Audio Output Slot(s) is computed as Cue Column Number
multiplied by the Hot Keys Column to Audio Slot Mapping. This allows handling Mono
(1), Stereo (2), Surround (6), etc... Cues.

The order of precedence is:

. The Cue List Audio Output Slot is used first if not set to <Use Cue Slot>
. The Hot Keys Column to Audio Slot Mapping is then used if not set to “No”
. The Cue individual Audio Output Slot is then used if none of the above applies.

Custom Keys Section

Audio Output Slot 5

‘AMERGING

40
50
Cue List Properties Pane - Custom Keys Section
Custom Keys Grid Size Click in the field to reveal the down arrow. You can either pick a value from

the drop-down menu or type directly in the left-hand side of the field.

Note: The Timed Cue List and TimeCode Generator sections are collapsed and fields
are greyed out for non Timed Cue Lists and the Custom Keys section is collapsed and
fields grayed out for non Custom Keys Cue Lists.

Properties Panes : Cue List Properties




Audio Section

Y <lse Cue Slot>

1
2
3
4
5
6
7
8

Please type higher values manually

Cue List Properties Pane - Audio Section
Audio Output Slot Click in the field to reveal the down arrow. You can either pick a value from
the drop-down menu or type directly in the left-hand side of the field.
Note: This setting applies to every Cue in the list. This value takes precedence over the
individual Cue Output Slot, if set, for the Cue list. The default value is <use Cue Slot>.

‘ Properties Panes : Cue List Properties
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Cue Properties
Cue Properties

E Cue

Mame steampasses
Comments

Pinned to Active Cue Window Yes

Length 00:00:17:144
FadeIn 3.7 [5]
Fade In Curve Linear
Fade Out 0 [ms]
Fade Out Curve Linear

Stop Fade Out < Default>

Interaction Rules

Ignore Parent Rules

Output Player

Markers

Timed Cue

Hot Key

Custom Key

Audio

Offset +00:00:07:895
Gain 0.00 dB
Audio Output Slot 1

D:\Merging from Dark Materials\Wav files imported from cld
Audic Media machine\5ocund Effects’,
stearnpasses-5536-4005-A847-D2F6F4 388 CCa ). pmf

Microphone f Input Switch

Timelode Generator

MMC

MIDI File

MIDI Command

Sony P2 / R5422

COM Command

IP Command

GPO

Shell Command / Script [ Batch

Mixer Automation

REMOTE CONTROL: General MIDI Command
REMOTE CONTROL: IP Command

REMOTE CONTROL: Multi-Sequencer Synchronization
REMOTE CONTROL: Dataton Synchronization

EHEHHEHEEEHGEHGGEMBHE

Cue Properties Pane

‘ Properties Panes : Cue Properties
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Cue Section
Number

Name

Comments

Number of the currently selected Cue. (Information only)
Name (can be changed here)

Free text field where you can add comments to the Cue List

Pinned to Active Cue Window When set to Yes (default) the Cue will be displayed in the Active Cue Window

Length

Fadeln

Fade in Curve
Power
Linear
dB
Cosine

Root-Cosine

Fade Out

Fade Out Curve
Power
Linear
dB
Cosine

Root-Cosine

Interaction Rules

Ignore Parent Rules

Output Player

Markers Section .

Cue Properties

when playing in Show Mode with the Pinned button active.
Length of Cue is shown and can be defined here
Clicking in the field accesses a drop-down list with fade times from Oms to 20s

Clicking in the field accesses a drop-down list with a choice of fade characteristics.

Clicking in the field accesses a drop-down list with fade times from Oms to 20s

Clicking in the field accesses a drop-down list with a choice of fade characteristics.

Field contains a list of all Interaction Rules defined for the current Cue List. Note:
Rules shown in this field are all in force at the same time.

Clicking in the field reveals a button which leads to the Interaction Rules dialog.

Determines whether child (nested) Cues follow the rules defined for the parent.
Clicking in the field reveals a Drop-down list with a choice of Yes or No.

Shows the currently defined OV Player for this Cue. Clicking in the field reveals a
drop-down list with all OV Players installed on networked PCs plus the currently
defined Show <Default Player> and <Local Player> When <Default Player> is
selected nothing is shown in the box and the player used will depend on the par-
ent choices. l.e. in the Cue List or Show.

Marker Offzet
Marker Interaction Rules

Markers

Selected Marker: 2 j

Add Marker
Rermove Selected Marker

Select Marker 1
Select Marker 2
Select Marker 3

Cue Properties - Markers Section - Markers field

Clicking in the Selected Marker: x field or on the down arrow drops-down the
Marker Menu

Properties Panes : Cue Properties
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Add Marker

Adds a new Marker at the current Audition Cursor position. Note: Subse-
quent existing Markers will be renumbered.

Remove Selected Marker The selected Marker is deleted. Note: Subsequent Markers will be renum-

Marker Name

Select Marker 1
Select Marker 2
Marker Offset

Marker Interaction Rules

Timed Cue Section

Cue Properties

bered.

Click in the field and type to add a Name to the Marker. This name will be
shown in the Active Cue window Timeline.

Selects Marker 1.
Every marker added will show up here and a Select Marker x entry.

Shows the Marker Offset from the beginning of the Cue. (Does not include any
Start (Preroll) Offset applied to the Cue.) Clicking in the field enables a new value
to be typed. Clicking the down arrow drops-down a list with the option of Reset.
This resets the Marker position to the current Audition Cursor position in the
Active Cue Window Timeline. (A negative offset is shown if the Cursor position is
before the start of the Cue.)

Shows a list of all Interaction Rules applied to the Selected Marker. Clicking in the
field shows a ... button. Clicking on this opens the Marker Interaction Rules dia-
log. Please see below.

Cue
Markers
E Timed Cue

S

 Hot Key

Go Time

| 00:00:10:000 |
Manual
Timed Cue section - Cue Properties Pane-

Cue Fire Time shown and can be defined here or set to Manual. Only applies to
Cues in Timed Cue Lists

Note: The Timed Cue section is collapsed and Go Time field is greyed out in non Timed

Lists

Hot Key Section

El Custom Key
Custom Color
Custom Font
Custom Font Color

Audio

mm e e e o e e e e

Hotkey Mode

| Press Play / Release Stop ﬂ
Play from Start
Toggle Play / Stop
Toggle Play / Pause

fofis i i
Press Play / Release Pause

Hot Key Mode Drop-down List - Cue Properties Pane

Only applicable to Hot Key and Custom Key Cue Lists. Shows current Hot key
Mode for the selected Cue. Clicking in the field reveals a Drop-down list with a
choice of Hot Key behaviors

Play from Start

Properties Panes : Cue Properties Page 100

‘AMERGING



MEDIA SERVER & SEQUENCER

Toggle Play / Stop
Toggle Play / Pause
Press Play / Pause

Press Play / Release Stop

Press Play / Release Pause

Custom Key Section

B |l Ry i Poyyic Clay ¢ oo
B Custom Key
Customn Color B 255 51; 204
Custom Font Segoe Print / 16pt / Bold
Custom Font Color B o: 102; 204
Bm Aedin

Custom Key section - Cue Properties Pane
Note: The Custom Color field in the Custom Key Section is also available for Hotkeys,
however the Custom Font and Custom Font Color fields are not.
In a Standard or Timed Cuelist Custom Color affects the label background only and
Custom Font is also available.

Custom Color Click in the field to reveal the ... and drop-down arrow buttons. Clicking on ...
opens a standard Color Picker. The drop-down accesses the default.

Custom Font Click in the field to reveal the ... button. Clicking on this opens a standard Font dia-
log with a list of all installed fonts. You can also choose the font style and size. The
drop-down accesses the default.

Custom Font Color Click in the field to reveal the ... button. Clicking on this opens a standard Color
Picker.The drop-down accesses the default.

‘ Properties Panes : Cue Properties Page 101
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Audio Section

Cue Properties

& Cue

s
B Audio
Offset

Gain

e

Audio Output Slot
Audic Media

Sampling Rate
Microphone / Input Switch
TimeCode Generator
MMC
MIDI File
MIDI Command

TP TNy

BHEHH

1

Offset

Gain

Audio Output Slot

Audio Media

Sampling Rate

+00:00:00:000

| 0.00 dB v

+6.0 dB -
+5.0 dB

+4.0 dB

+3.0 dB

+2.0 dB

+1.5dB

+1.0 dB

+0.5dB

0dE

-0.5 dB *

m

Audio section - Cue Properties Pane

Determines the starting point of the Cue within the Media File. Offsets must be
positive only.

Clicking in the field enables values to be typed directly. The value entered here
determines the gain offset the Cue will be played with. Negative values attenuate,
positive amplify. Clicking on the down arrow accesses a drop-down list of Gain val-
ues. Clicking on the ... button opens the Cue Gain fader dialog. Please see: Cue
Gain on page 121

Shows the Output Slot number. Clicking in the field enables a new number to be
typed. Please see: Audio Output Slots on page 124

Shows the full path to the Audio Media of the Cue whether single file or Multiple
Files. When the right-hand down arrow is clicked a drop-down list appears with
the choice of Replace and Remove the current Audio Media Files.

Information only - shows the Cue sampling rate.

Note: The Length and Audio Offset fields in the Cue Properties have a Reset option
accessed by clicking on the button on the right side of the field. The Go Time field in Cue
Properties has a Manual option accessed by clicking on the button on the right side of
the field to reset it to Manual Fire.

Note: Cue > Link Offsets/StartTimes and the Link Offsets/StartTimes icon in the
Active Cue pane Links all Audio, TCGen, MMC and 9-pin (Sony P2) Offsets and Start
Times in a Cue with these properties. The button toggles on/off and it’s state is not saved
when a different Cue is Active. When enabled all related fields in the Cue Properties pane

turn red for clarity.

Microphone Switch Section

This section allows a range of Mixing Console Inputs to be defined. All Inputs in the range will be switched to Input
when the Cue is Fired and returned to Repro when the Cue ends.

First Mic / Input Slot

Last Mic / Input Slot

‘AMERGING

Click in the field and type the number of the first Mic Input Slot to be switched
automatically.

Click in the field and type in the number of the last Mic Input to be switched auto-
matically.
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TimeCode Generator Section

The Cue TimeCode can be output to any available TimeCode Output Port. This can be LTC, if Ovation is running
with a Mykerinos card, or a MIDI MTC port enabled in Settings > Application Settings > Player Units > MIDI.

TC Gen Output Port

TC Gen Start Time
TC Gen Pause Mode
Ooff
Freeze
Free Roll
TC Gen Stop Mode
off
Freeze
Free Roll
TC Gen Goto on Ready

Currently selected Output Port is shown. The drop-down list shows all available TC
outputs. This can be LTC, if Ovation is running with a Mykerinos card, or a MIDI MTC
port.

The First TimeCode value that will be output when the Cue is Fired.
The drop-down list offers a choice of:
TC output ceases when the Cue is paused
TC freezes at current value when Cue is paused
TC continues to run when Cue is paused
The drop-down list offers a choice of:
TC output ceases when the Cue is paused
TC continues to generate current value when Cue is paused
TC continues to generate and increment value when Cue is paused

Yes or No. If Yes (enabled) the Start Time is generated continuously on the output
port when the Cue is made Ready, to allow a Slave device to commence locating to
the Start Time in advance of the Cue being fired.

Note: The TimeCode Generator section is collapsed and fields are greyed out for non

timed Cues.

MMC Section
MMC Output Port

MMC Start Time

Clicking in the field reveals a down arrow to access a drop-down list of all available
MIDI ports

When a valid output port is selected in the previous field a start time may be
entered here.

Note: When the Cue is fired, an MMC Play command is sent; when the Cue is paused, a
MMC Pause command is sent; when the Cue is stopped a MMC Stop command is sent.

MIDI File Section
MIDI Output Port

MIDI File Path Name

Clicking in the field reveals a down arrow to access a drop-down list of all available
MIDI ports

When a valid output port is selected in the previous field clicking in the field
reveals a down arrow with the choice of Replace or Remove. Clicking on Remove
removes the current path (if any) Clicking on Replace opens the Open MIDI Files
browser window. Navigate to the required file and click on Open.

Note: The drop down menu (MIDI 1, GPO, etc.) lists all the devices installed on the
machine but does indicate which devices are available/enabled in the system. (to be
improved in a next release).

MIDI Command Section
MID Command Output Port

MIDI Fire Command

MIDI Pause Command

MIDI Stop Command

Clicking in the field reveals a down arrow to access a drop-down list of all available
MIDI ports

Click in the field to reveal the ... box. Click on this to open the Edit MIDI Command
dialog.

Click in the field to reveal the ... box. Click on this to open the Edit MIDI Command
dialog.

Click in the field to reveal the ... box. Click on this to open the Edit MIDI Command
dialog.
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Examples of the Edit MIDI Command Dialog

g ™

Command : Channel : Data 1: Data 2 :

Note off HEE v| |1z M RE -
Mote off

Mote on

Polyphonic key pressure
Contral change

Reset contral change
Loc. contro_T(

All notes off

Omni on

Omni off

Monao on

Poly an

Program change
Cwverall keypressure aftertouc
Pitch bender change

System Exdusive (SYSEX)
Midi time code quarter frame
Song position point

Song select

Tune request

End of exdusive(SYSEX)

Midi dock

Start

Continue

Stop

Artive sensing

System reset

(0]4 ] I Cancel

Available predefined General Midi Commands drop-down list

i N = Ty

Command : Channel ; Data 1:

System Exclusive (SYSEX) ~ |

Custom Midi Message (hex) :
fOFf5202 140132333522 36003336 2236003539 f7

An example of a MSC Sysex (Go command of the Cue 235.6, Cue list 36.6, path 59)

.~ ™

Command : Channel : Data 1:

Al notes off v] IlE v] Ill3

Custom Midi Message (hex) :
be 7h 00

An example of a General Midi command
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Note: when you use the Custom Midi Message edit line, the drop-down menus above
are updated if the message is recognized

Sony P2 / RS422 Section
Sony P2 /RS422 COM Port  Shows the current Com Port or None. The drop down shows a list of all Com ports.

Sony P2/ RS422 Start Time

Note: When the Cue is fired, a P2 Play command is sent; when the Cue is paused, a P2
Jog [0] command is sent; when the Cue is stopped a P2 Stop command is sent.

Please see also: Sony P2 over IP 0 on page 162

COM Command Section
COM Command Output Port Shows the current Com Port or None. The drop down shows a list of all Com ports.

Command Format Click in the field to drop-down the choice of Hexadecimal or ASCII.
COM Fire Command Click in the field to type a command.
COM Pause Command Click in the field to type a command.
COM Stop Command Click in the field to type a command.

Note: COM Commands can be used to control suitably equipped external devices via
serial control. For example you could send a POWER ON command to fire up a projector,
or you could send a command line like Command=Cue_Fire &CueList=2 &Cue=1.

Each device manufacturer should provide a list of available commands.

IP Command Section

IP Command Output Port Shows the current IP Port or None. The drop down shows a list of all available IP

ports
Command Format Click in the field to drop-down the choice of Hexadecimal or ASCII.
IP Fire Command Click in the field to type a command.
IP Pause Command Click in the field to type a command.
IP Stop Command Click in the field to type a command.

Note: IP Commands can be used to control suitably equipped external devices via ether-
net. For example you could send a POWER ON command to fire up a projector.
Each device manufacturer should provide a list of available commands.

GPO Section
jLII'I}.-' Fe § roids] Do i [AINH I EHYNHETE
El GPO
PO Output Part GPO 1
GPO Cukput Pin 2]
GPO Ready State Doy
5P Fire Skake Up
P2 Pause State Crawan
QPO Stop State D
50 [ms] .
e I""‘|Ir|Fir|i|:E:
Audio section - Cue Properties Pane
GPO Output Port A physical GPO device assigned to that port.
GPO Output Pin The output pin of the GPO device to trigger.
GPO Ready State The state of the output pin when the Cue enters the Ready condition.
GPO Fire State The state of the output pin when the Cue is Fired.
GPO Pause State The state of the output pin when the Cue is Paused.
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GPO Stop State The state of the output pin when the Cue is Stopped.
GPO Duration The time in milliseconds during which the state is maintained. (Pulse length)

Note: Up and Down means:

Up the circuit between Common and the Pin# is closed

Down the circuit between Common and the Pin# is open

Shell Command / Script / Batch Section

E Cue

Fire Command

Fire Command Parameters

Fire Command Default Directory
Pauze Command

Pause Command Parameters
Pause Command Default Directory
Stop Command

Stop Command Parameters

= Shell Command / Script / Batch |

Stop Command Default Directory

Shell Command/Script/Batch section - Cue Properties Pane

Fire Command

Fire Command Parameters

Fire Command Default Directory
Pause Command

Pause Command Parameters
Pause Command Default Directory
Stop Command

Stop Command Parameters

Stop Command Default Directory

A Shell Command requires three parameters:

. The Application name or command (acrobat.exe, myscript.bat, etc...)

. The Parameters modifying this command (optional) (- filename, - load, - verbose, etc... or whatever
required by the command itself)

. The Default Directory (optional) (some commands or applications need to run from a given folder where
required files are present)

Note: There is a separate set of parameters for each Fire, Pause and Stop event.
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B Mixer Automation
Type Snapshot
Glide Cue Length

Mixer Automation section - Cue Properties Pane
Type Please see: Snapshot Automation on page 52 for details.

Glide

REMOTE CONTROL: General MIDI Command

E REMOTE CONTROL: General MIDI Command

Fire Command e * |

Pause Command

Stop Command

REMOTE CONTROL: General MIDI Command section - Cue Properties Pane
MIDI Command Input Port  Click in the field to drop-down a list of available ports.

Fire Command Click in the field to reveal the ... button and down arrow.
Pause Command Click in the field to reveal the ... button and down arrow.
Stop Command Click in the field to reveal the ... button and down arrow.

For each of the commands clicking on the ... button opens the MIDI Command Learn dialog. Clicking on the
down arrow offers the choice of <None> or <Learn>. None removes the existing mapping whilst Learn also
opens the MIDI Command Learn dialog.

Note: Before attempting remote control of Cues in this way check the Controller Set-
tings in Settings > Application Settings > Controller Units > MIDI.

In order for direct MIDI Command mapping to work for the given physical or logical MIDI port the option Enable
direct Cue mapping of MIDI messages from the selected Virtual MIDI Port in the General Midi (GM) section
must be checked. Commands coming from the given physical or logical MIDI Port will be seen in the MIDI Com-
mand Learn dialog as coming from the selected Virtual MIDI Port at the top of the MIDI settings page. This
enables the physical MIDI port to be changed easily without having to redo the entire mapping).

Note: A useful possibility is to be able to map Note On to the Fire Command and Note
Off to the Stop Command to emulate the Hot Keys Press Play/Release Stop mode.
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MIDI Command Learn

MIDI Command LearrA — 2%

Clear [ QK ] | Cancel

MIDI Command Learn dialog

The main field displays incoming MIDI Commands. After opening the dialog from one of the Fire, Pause or Stop
Command fields, send the MIDI command you wish to map to Ovation and, when you see it in the field, click on
OK to complete the mapping and close the dialog.

Clear clears the field if the command is incorrect and
Cancel closes the dialog without completeing the mapping.

REMOTE CONTROL : IP Command

E Cue

P RRE BN R AR B s B R BWEL AR S

E REMOTE CONTROL: IP Command
IP Command Input Port |11
Command Format Hexa

Pauze Command <Mone=

Stop Command <L earn>

REMOTE CONTROL: IP Command section - Cue Properties Pane

IP Command Input Port Click in the field to drop-down a list of available ports.

Command Format Click in the field to drop-down the choice of Hexadecimal or ASCII.
Fire Command Click in the field to reveal the ... button and down arrow.

Pause Command Click in the field to reveal the ... button and down arrow.

Stop Command Click in the field to reveal the ... button and down arrow.

For each of the commands clicking on the ... button opens the IP Control Fire/Pause/Stop Learn dialog. Clicking
on the down arrow offers the choice of <None> or <Learn>. None removes the existing mapping whilst Learn
also opens the IP Command Learn dialog.

Note: Before attempting remote control of Cues in this way check the Controller Set-
tings in Settings > Application Settings > Controller Units > IP.
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El REMOTE CONTROL: Multi-Sequencer Synchronization

Synchronization Mode Slave

Synchronization Token <Cue Mame / Cuelist Marne>
Resynchronize Drifts/Jumps Yes

Synchronize Pause Yes

Synchronize Stop Yes

T T Nl e e e et L

REMOTE CONTROL: Multi-Sequencer Synchronization section - Cue Properties Pane

Synchronization Mode Click in the field for the choice of Master, Slave or Off.

Synchronization Token Ovation generates the Synchronization Token automatically from the Cue Name
and CuelList Nam,e, Master and Slave Tokens MUST match. (case sensitive).
Note: If for some reason automatic Token generation is unsuitable. E.g. because the Cue
on the Master Ovation is named Bach and the Cue on the Slave is named Bach back
then a Token value may be typed in the field. (The same Token Value MUST be used on
Master and Slave Ovations.

Resynchronize Drifts/Jumps Determines whether or not re-synchronization will take place when a sync drift or
jump is detected. The drop-down list offer the choice of Yes or No.

Synchronize Pause Click in the field for the choice of Yes or No. When set to Yes if the Master Cue is
Paused the Slave Cue also Pauses.

Synchronize Stop Click in the field for the choice of Yes or No. When set to Yes if the Master Cue is
Stopped the Slave Cue also Stops.

Note: Before attempting to synchronize Cues in this way an IP connection must be
established between the Master and Slave machines in Settings > Application Settings
> General > TCP/IP Connections and Multi-Sequencer Synchronization must be
switched on and configured as Master or Slave in Show Properties.

Please see: TCP/IP Connections on page 157
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B Cue

B REMOTE CONTROL: Dataton Synchronization

Synchronization IP Port IP&
Synchronization Token <Cue Mame=
Resynchronize Drifts/Jumps Yes
Synchronize Pause Yes
Synchronize Stop Yes

‘AMERGING

REMOTE CONTROL: Dataton Synchronization section - Cue Properties Pane

Synchronization IP Port Click in the field to drop-down a list of available ports. The Port selected MUST be
the port associated with the target machine running the Dataton video player.

Synchronization Token The name typed here determines which Dataton Timeline. is linked to the Cue.
Note: If for some reason automatic Token generation is unsuitable. E.g. because the Cue
on the Master Ovation is named Score and the Timeline on the remote Dataton is

named Movie then a Token value may be typed in the field. (The Token Value MUST
match the name of the Dataton Timeline you wish to synchronize.)

Resynchronize Drifts/Jumps Determines whether or not re-synchronization will take place when a sync drift or
jump is detected. The drop-down list offer the choice of Yes or No.

Synchronize Pause Click in the field for the choice of Yes or No. When set to Yes if the Master Cue is
Paused the Slave Dataton Timeline also Pauses.

Synchronize Stop Click in the field for the choice of Yes or No. When set to Yes if the Master Cue is
Stopped the Slave Dataton also Stops.

Note: Before attempting to synchronize Cues in this way an IP connection must be
established between the Master Ovation and Slave Dataton machines in Settings >
Application Settings > General > TCP/IP Connections.

Please see: TCP/IP Connections on page 157
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Interaction Rules

Overview
Interaction Rules are one of the most powerful features of Ovation.

Interaction rules affect what happens to other Cues and Cue Lists when a Cue is Fired or Stopped. All selected
Rules apply together so it is possible to arrive at a situation where nothing will play at all!

Rules set in Show Properties are global. l.e. they apply to every Cue List and Every Cue unless overridden by Rules
set in Cue List Properties or Cue Properties.

Rules set in Cue List Properties apply to all Cues in the Cue List unless they are overridden by Rules set in Cue
Properties.

Rules include an optional offset

Rules can be conditional. A rule can be triggered based on the state of another Cue (Fired, Paused or
Stopped).

A Cue can fire itself through a Rule. This is how to make a Cue Loop.

When an Interaction Rule points to a Cue List as Target, then:

. If the Cue List is a Timed Cue List, then the Cue List Time is Started, Paused or Stopped (equivalent to the
Cue List Start, Pause or Stop buttons).
. If the Cue List is NOT a Timed Cue List then the FIRST Cue in the list is Fired, or ALL Cues are Paused,

Stopped or Dimmed.

Adding Rules

There are several ways of adding rules. You can use Cue > Add rule or the right-click context menu to add simple
rules to a Cue directly. For more complex compound interactive rules the Interaction Rules dialog is used.

Adding Simple Rules

Select a Cue and either go to Cue > Add Rule or right-click on a Cue and go to Add > Rule in the context menu.
The list of available Rules is the same whichever method you choose:

Fire Next Cue when Ending

Fire Next Cue when Stopping

Fire All Child Cues when Stopping

Stop Previous Cue when Starting

Stop All Cues in Cue List when Starting

Loop (Fires Itself when Ending)

Loop between Markers (Fire Itself between Markers)
Dim All Cues when Starting

Select Next Cue when Starting

Note: Choosing Loop between Markers creates two new Markers one at the beginning and end of the Cue. The
Markers can be moved subsequently.
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Opening the Interaction Rules Dialog

Clicking in an Interaction Rules field in a Properties pane and clicking on the ... button opens the Interaction
Rules dialog. When rules are already set double-clicking on the icon(s) in the Cue in the Cue List also opens the

dialog.
i - |
Interaction Rules for Cue 'steampasses’ of Cue List "Cue List 1 ﬁ

Frre v| [mextcue DI ms (When *| [Endng »| with 0 [ms] v Fadeln
&t Marker 0 [ms] + | Farde Cut

20008~ | DimGain

Ll Onlyif *| & @ Fred Paused Stopped
Fire Next Cue \When Ending

| AddRue >> | [ Remove Rue << Update Rude V¥ Move Rule Up | | Move Rule Down |

L ——)

Interaction Rules Dialog

The dialog enables Interaction Rules to be Added, Modified or Removed from the active list.

Interaction Rules applied at the Show level affect all Cue Lists and Cues. These are overridden by Rules applied to a
List and these in turn are overridden by Rules applied to individual Cues. However, some rules will affect Cues
regardless. E.g. If an individual Cue is set to Stop All Cues at Start then all Cues in all Cue Lists playing when it is
Fired will Stop. Subsequent Cues in Timed Lists will Fire as expected.

The options available under each of the drop-down lists will vary depending on the choices already made and
other rules in force.

Adding a Rule

Make choices using the drop-down lists and click on Add Rule >>

Removing a Rule
Click on the Rule you wish to remove in the list to highlight it and click on Remove Rule <<

Update a Rule

Click on the Rule you wish to update in the list to highlight it. Its parameters will be reflected in the controls.
Change parameters as required and click on Update Rule VV to accept the changes.

Change Order of Rules

Click on the Rule you wish to re-order and click on the Move Rule Up or Move Rule Down buttons to change the
Rule order.

Rules Form
Interaction Rules take the form:

Stop / Pause / Dim / Fire/ Select the:
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Next Cue
Next Sibling Cue

Previous Cue
Previous Sibling Cue
a Specific Cue or Group of Cues
Cue List or
Itself
When or After the selected Cue(s)

Starting
Ending or
Stopping

with a

Fadeln

Fade Out and/or

Dim Gain applied if required and as determined by the other choices.
If After is selected then the ms box becomes active. Enter a value here to delay the rule’s action after the trigger-
ing event has occurred.
For Stop the dialog presents Starting as the default choice.

For Fire the dialog presents Ending as the default choice.

For Pause and Dim the Start/ Stop choice is grayed out since the only logical use is to Pause or Dim another Cue
or Cues whilst the current one is playing.

Sibling means a Cue on the same level. Thus using e.g. Next Sibling bypasses any Child Cues.

Note: Rules which act when a Cue is started occur at the Start time. Rules which act
when a Cue Ends or Stops occur at he START of the Fade out. This produces a cross-fade.
If you require a fade out but do not want the next action to occur until the End of the
Cue then simply use the After rule with an delay equivalent to the fade out length.

at Marker

Only valid when first action is set to Fire. If the Cue has a Marker or Markers set then the Cue will be be Fired at the
Marker number in the at Marker field.

Loops
To produce a loop simply use the form, Fire : Itself : When : Ending. More complex loops within a Cue can be
achieved using Markers. Please see: Markers Interaction Rules on page 87

Cue List Target
When an Interaction Rules points to a Cue List as Target, then:

. If the Cue List is a Timed Cue List, then the Cue List Time is Started, Paused or Stopped (equivalent to the
Cue List Start, Pause or Stop buttons).

. If the Cue List is NOT a Timed Cue List then the FIRST Cue in the list is Fired, or ALL Cues are Paused,
Stopped or Dimmed.

Conditional Rules

If the Only if box is checked then a further layer of control comes into play. A rule set up using the controls
described above will only apply when the conditions are met. l.e when the item chosen in the drop down list from
a choice of Next Cue, Previous Cue a Specific Cue or Group of Cues or a Timed Cue List - is either Fired, Paused
or Stopped as selected via the radio buttons.

Interaction Rules is an extremely powerful tool and experimentation is strongly encouraged!
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Rules Icons
When Interaction Rules are applied an Icon or Icons is/are shown in the Cue in the Cue List.

When present there is a Rule or Rules applied in Cue Properties.

When present there is a Rule or Rules applied in Cue List Properties

When present there is a Rule or Rules applied to a Marker in the Cue

@ When present there is a Rule or Rules applied in Show Properties
[ A

Double clicking the Cue Properties, Cue List or Show Icons opens the Interaction Rules dialog.
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Show ValidationTool

Show Validator

Clear Results

Ma errors found... Show Valid !

Show Validator pane

The Show Validation Tool is available via Show > Show Validator.

It enables the following aspects of the Show to be validated:

. Interaction Rules validity. For instance, Rules pointing to a non existing Cue or Cue List.
. Offline Clips Players
. Invalid Audio Output Slots

More checks will be added in subsequent versions.

Note: Double-clicking on reported errors in the Validation Tool pane selects the incrimi-
nated Cue or Cue List.
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Show Consolidation and Packaging

Show Consolidation collects all Audio, MIDI and other files associated with and referenced by a Show and copies
them to the Audio Files folder in the same location as the Show file. The Show file is modified to point to the new
file locations of the copied files. The Show remains active in the Ovation Sequencer for further editing.

Show Packaging collects all Audio, MIDI and other files associated with and referenced by a Show and copies
them to a new Audio Files folder created automatically in the packing location selected along with copy of the
Show file. At the end of the process the option of Show Validation is offered to verify that all is well with the pack-
aged version. The resultant packaged Show file is modified to point to the new file locations of the copied files.

The original Show is not affected by the process and, when Consolidation is complete the original Show remains
active in the Ovation Sequencer.

The Consolidation Process

To initiate the Packaging Process choose Show > Consolidate Show to open the Consolidate Show dialog :

e =

The Consolidate process will collect certain Media files referenced by your
Show to the 'Audio Files' folder next to the Show file.

You have the following options:

Collect all files from any location

| Collect all files located on any Removable drives

| Collect all files located on the Netwaork

Consolidate Show Dialog

The options are self explanatory.

If you are happy to continue click on Yes to initiate the process.

i« Ny

Copying Audio Files...

Copying File: G:YOvation First\A First Simple ShowAudio Files\WyM702 Moods && Romance-E055-444A0-8678-20442E

-— ——

Cancel

Consolidating Cues Dialog
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The process begins and the Consolidating Cues... dialog appears. Click on Cancel to abort the process otherwise
an info box appears when the process is complete.

Consolidate Cues [&J

o Show Consolidated.

Consolidate Cues Info Box

The Packaging Process

To initiate the Packaging Process choose Show > Package Show to open the Package Show dialog :

oo . ==

o Packaging a Show is potentially a long operation. It consists of the following steps:
| |

1) All Media Files referenced by the Show will be collected and copied to the final Packaged Show Location.

2) A Copy of the Show will saved in that new Location and modified to point to the newly copied Media Files.
3) The Original Show will not be affected and will still be active after the Padkaging process,
4) Only Embedded OVPlayer and OVController will be packaged with the Show

5) An optional Validation pass will be performed at the end of the process

Continue with Packaging ?

Package Show Dialog

The options are self explanatory.
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If you are happy to continue click on Yes to continue the process by opening the Package Show Browse For
Folder dialog.

Please select a Destination Location for Packaging the Show

MFix -

Owvation Packages

Pyramix Libraries
B System Volume Information

Test files
YCube MXFix Source
YCube Projects
Video
Watch2PAL

‘[ Audic (G2

© o Stuff (T:)

e PR T T

Make Mew Folder |

Package Show Browser

Navigate to a suitable existing folder or to a suitable location to create a new one. When you have opened the des-
tination folder (or created it) click on OK to initiate the process.

A dialog will show details of progress:

Copying Audio Files. .,

I

Copying File: F:\Ovation Packages{Mew folder \LoopyAudio Files'madlaugh-FBDA-4159-A739-9957A 1BE4560}. pmf

—_— -

Cancel

Package Show Progress Dialog
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And a further dialog will show progress of copying individual files.

-

= Copying 1 item (557 MB) = 2

Copying 1 item (557 MB)

from Audio Files (G..\Audio Files) to Audio Files (F:..\Audio Files)

¥ 'More details Cancel

A

Copying Files Dialog

When the process completes you will be invited to validate the new Show :

oo

o The Show has been successfully Packaged

= Would you like to Validate the newly Packaged Show ?

[ Yes ] | Mo |
=_———————

Package Show Validation Dialog

We suggest you accept the option. The result will be displayed at the end of the process.

Recursive Packaging

The Packaging process can be incremental. l.e. the process can be called many times one after another and only
newly referenced files will be copied to the Packaged location.

Backup/Archive

The Package Show function offers a simple method of backing-up/archiving a Show to a different location.
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Audio Control

Audio Control Pane

The Audio Control pane is accessed from the Show Toolbar, the Show menu or the View menu. It controls atten-
uation of the right-most Bus fader from the 0dB position on the Ovation Mixer. It is only active when it is open and
a Show is running or a Cue is being Auditioned.

Controls are chunky to facilitate Touch Screen operation.

The top Slider button increases level in 2dB per click increments from -146dB to -40dB and
1dB increments from -40dB to a maximum of 0dB.

The slider can be clicked and dragged. The degree of attenuation is shown numerically on the
Slider knob. Double-clicking the knob restores the default, 0dB value.

The bottom Slider button decreases level in 1dB per click increments down to -40dB and 2dB
per click increments down to -146dB

The bottom button MUTEs the Ovation mixer Main Output.

The Audio Control pane retains its current settings when closed and opened (and from load

/ unload of the application) however, the output is only updated with its values when the
Audio Control pane is open.
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Cue Gain

Cue Gain Control

Cue Gain sets the overall Cue Level in real time.

The Cue Gain dialog is accessed from the Cue List Edit Toolbar, Change Cue Gain in the Cue menu and in the
right-click Cue context menu.

The box shows the amount of boost or cut applied in dB. You can click in the box and type a

k3,00 -
numeric value.

The Slider can be clicked and dragged to set the Cue Gain

Click OK to accept changes and exit the dialog

Click Cancel to reject changes and exit the dialog

Changes made in the Cue Gain dialog are reflected in the Cue Properties pane.

Note: When a Clip is published to Ovation from Pyramix any Gain adjustments made
with the Cue Gain Control are applied in addition to gain adjustments applied to the Clip
in Pyramix.
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TimeCode

TimeCode Reader Panes

TimeCode Reader panes enable the current values of any of the available TimeCode Sources and Generator Ports
to be displayed.View > View TimeCode Reader opens a new TimeCode Reader pane.

None

00:00:00:00

TimeCode Reader Pane

When first opened a TimeCode Reader pane has no source selected and is colored white. Up to 20 panes may be
open and active simultaneously. The pane(s) can be resized at will.

Right-clicking anywhere in the black area of the pane opens a context menu:

TimeCode Sources: ] Mone

TimeCode Generator Ports: 2 Show Time

Colors: L LTC1

' ' LTC2
MTC1
MTC 16

|

TimeCode Reader Sources sub-menu

Hovering the cursor over TimeCode Sources: drops down a list of all available sources. None and Show Time are
always present, other entries will depend on your specific hardware and driver configuration.

‘ TimeCode : TimeCode Reader Panes Page 122
AVIERGING



I Ovation

MEDIA SERVER & SEQUENCER

Hovering the cursor over TimeCode Generator Ports: drops down a list of all available outputs:

ime

00:00:00:00

TimeCode Sources: r
TimeCode Generator Ports: k Mone
Colors: L LTC1
LTC2
MTC1
MTC 16

TimeCode Reader Generator Ports sub-menu

None is always present other entries will depend on your specific hardware and driver configuration.

Hoevering over the third entry Colors: drops down a color picker:

TimeCode Sour w Time

00:00:00:00

TimeCode Sources: »
TimeCode Generator Ports: ¥
Colors: 3

TimeCode Reader Colors sub-menu
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Audio Output Slots

What is an Audio Output Slot?

Audio Output Slots are set in Cue Properties for individual Cues. An Audio Output Slot is nothing more than
the audio channel count across the mixer from left to right. So, Strip one, Channel one is also Slot one. But Strip
four Channel one could be one of several things depending on what type of Strips the mixer uses. In a mixer using
all Mono Strips, Strip four Channel One is Slot four but in a mixer with all Stereo Strips it will be Slot eight.In a
mixer using 5.1 GPS Strips Strip four Channel one will be Slot 19 and so on.

Multi-channel Cues

Multi-channel Cues are handled transparently with the channels present in the Cue mapped in ascending order
from the Audio Slot Output specified in Cue Properties.

Audio Output Slots and Cue Lists

The Audio Output Slot can be set for an entire Cue list in the Audio Output Slot field in the Audio section of the
Cue List Properties pane. The default is <Use Cue Slot> and in this case Cues will be played via the Audio Output
Slots set in the Cue Properties pane.

Note: If a setting other than <Use Cue Slot> is used then this takes precedence over the
Audio Output Settings in the Cue Properties pane.
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Audio Gain Matrix

By default the Audio Gain Matrix for each Cue is Off. Under these conditions an Audio Cue will be played via the
Mixer strip(s) determined by the Audio Output Slot settings. However, the Audio Gain Matrix is a very powerful
tool when dealing with Cues. For example, it can correct incorrect channel order, imbalances or level discrepencies
or, for example, downmix a 5.1 Cue for stereo playout.

The Audio Gain Matrix pane can be accessed by clicking in the Audio Gain Matrix field in the Audio section of the
Cue Properties pane or by selecting Show > View Audio Gain Matrix.

1-Cue List1

Output Slot

-

Matric Size

‘AMEFIGING

-

Audio Gain Matrix pane - Matrix Off

The Audio Gain Matrix pane shows the selected Cue List and selected Cue it will affect.

Output Slot

The Output Slot drop-down list functions in exactly the same way as the field in the Cue Properties pane and any
changes made here will be reflected in Cue Properties.

Cue Gain

The Cue Gain pot determines the overall gain of the Cue across all channels whether the Matrix is active or not.
Any change to the value made with this control is reflected in the Audio Gain field in the Cue Properties pane.

As with the other rotary controls here and in the mixer a value can also be entered by clicking in the numeric box
and typing.

Matrix Size

This value determines the number of Outputs from the Matrix and the number of vertical Output columns in the
dialog. Matrix Size can be set to Off (as in the above screenshot) or to any sensible value. When the Matrix is Off
the number of outputs is determined by the number of channels in the Cue. Off and 1-16 are available in the
drop-down list. Type larger values manually, followed by Enter. These outputs are patched to the Ovation mixer
slots in ascending order from the Slot Number set as the Output Slot.
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Inputs
The number of Matrix Inputs and therefore the number of horizontal Input rows in the dialog is determined by the
number of channels in the Cue.

Using both the Output Slot and the Matrix Size number enables you to focus first on an area of the mixer (Output
Slot) and then determine how many strips in that area you wish to distribute the audio channels present in the

Cue to.

For example, if you wish to mix a Cue into Strips 30,31,32,33,34 and 35 you would select Output Slot 30 and set
the Matrix Size to 6:

1-Cue List1

Output Slot Cue Outputs 30

a0 L Gain

Matrix Size ' : :
atrix Size | : P
- oy

F.
L

r

Audio Gain Matrix pane - 2 In 6 out

By default only the same number of Output channels will be active as the number of input channels. The rotary
controls set the overall Cue Gain and the individual gains for each of the channels present in the Cue.

The Output rotary controls set the overall level for each Output channel and the contribution per Output from
each Input channel. Double-clicking a rotary control Mutes / deMutes.
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Downmixing

Equally, the Audio Gain Matrix can be used to mix down a multi-channel Cue to Stereo or Mono:

Audio Gain Matro W

1-Cue List1

Cutput Slot Qutputs

Matric Size

Audio Gain Matrix pane - 6 In 2 out

Linking Parameters in the Audio Gain Matrix:
To make relative moves of several gains simultaneously, groups can be created.

Create a Gain Control Group
Press and hold SHIFT
. Click on individual gain controls to add them to a group.
. Click on members of a group to remove them from it.
Click on an Output Gain knob to add the whole Matrix column to the group.

Click on RESET to reset all the links (remove all from the group)
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Independent Control of a Group Member
. Press and hold CTRL

. Manipulate a gain knob which is assigned to a group, without moving the rest of the group.

Note: Links are preserved when you click away from the Cue. Links are saved with the
show, thus links are retained when you close and open the show.

Set Audio Gain Matrix For Multiple Cues
Audio Gain Matrix parameters can be set for multiple Cues or an entire Cue List in one operation. It only makes
sense to do this if the Cues are in the same format.

. Select all the Cues in the Cue List
. Open the Audio Gain Matrix pane with Show > View Audio Gain Matrix.
. Make the settings required.

The new settings will be applied to all the selected Cues.
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Ovation Files

File Types

‘AMERGING

Ovation files store Shows including Cue Lists and have an .ovs file extension.

Cue Lists can also be saved and loaded independently and have an .ovl file extension.
Settings are stored with a .pms file extension.

OVPlayer Sessions are stored with an .ovp file extension.

OVController Sessions are stored with an .ovc file extension
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Ovation Menus

Show
[ Show |

Mew Show

Open Show
Save Show

Save Show As

SR TyE

Save Show As Template
Save Special 3
Close Show

Recent Shows 3

Init Show

Consolidate Show
Package Show

View Show Properties
View Show Validator

View Show Log

View Show Control Toolbar
View Audition Toclbar
View Active Cue Window
View Audio Gain Matrix
View Audioc Control

g8 alEl=ErnHpn &o

Exit
Ovation Show Menu

New Show Opens a new, Untitled Ovation Show
Open Show Opens the Open Windows File Browser to enable an existing Show to be loaded
Save Show Saves the current Show. If this is Untitled, opens the Save As file browser
Save Show As... Opens the Save As file browser
Save Show As Template Saves the current Show as a Template fro future shows
Save Special Enables Show to be saved in Ovation 3.x format for mixer compatibility
Close Show Closes all open Cue Lists and the Show
Recent Shows > Drops down a list of recently opened Shows
Init Show Initialize Show
Start Show Start Show
Pause Show Pause Show
Stop Show Stop Show
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Consolidate Show Opens the Consolidate Show dialog. Please see: Show Consolidation and
Packaging on page 116

Package Show

View Show Properties... Opens the Show Properties Tab Pane
View Show Validator... Opens the Show Validator Tab Pane
View Show Log Opens the Log Tab Pane

View Show Control Toolbar Toggles the Main Window Show Control Toolbar
View Audition Toolbar Toggles the Main Window Audition Toolbar
View Active Cue Window Toggles the Active Cue Window

View Audio Gain Matrix Toggles the Audio Gain Matrix Window

View Audio Control Window Toggles the Audio Control Window

Exit Quits the Ovation application
Cue List
| Mew Cue List k Standard Cue List
B Open Cuelist &y Timed Cue List
E Save Cuelist As Hot Keys
Close Cue List [ Custom Keys
Cue Browser
[# Hot Browser
Toggle/Select Cue List
Toggle/Select Hot Key List
@] View Cue List Properties
E, view Edit Toclbar
Hot/Custom Keys 3
Ovation Cue List Menu
New Cue List Drops Down the List of Cue Lists
Standard Cue List Opens a new, Untitled, Standard Cue List
Timed Cue List Opens a new, Untitled, Timed Cue List
Hot Keys Opens a new, Untitled, Hot Keys Cue List
Custom Keys List Opens a new, Untitled, Custom Keys Cue List
Cue Browser Opens a new, Untitled, Cue Browser Cue List
Hot Browser Opens a new, Untitled, Hot Browser Cue List
Open Cue List Opens the Open Windows File Browser to enable an existing Cue List to be loaded
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Save Cue List As Saves the currently selected Cue List. If this is Untitled, opens the Save As file
browser

Close... Opens the Close Cue List dialog
Note: If a Cue List is Closed without saving it separately it will be lost.

Fire & Start Acts on Timed Lists when selected. Fires the Selected Cue and starts the Cue List
Counter running from the Go Time of the Cue. Selects and Readies next Cue for Fir-
ing.

Start Acts on Timed Lists when selected. Starts the Timed List from zero.

Pause Pauses the Timed List. List will restart from the point at which it was Paused.

Stop/Reset Stops the Timed List. List is reset to the beginning and made ready for Firing.

Chase When a Timed List is Selected engages/disengages Chase Mode

Toggle/Select

Cue List (Tab) Steps the selection through all open Cue Lists in ascending numerical
order.

Toggle Select

Hot Key list (Ctrl+Tab)Toggles the selected Cue List between the available Hot Key lists.
(Note: Hot Key Display is only visible when the Show is Initialized)

View Cue List Properties...  Opens or selects the Cue List Properties pane for the currently selected Cue List

View Fire Toolbar Toggles the Fire Toolbar Shown / Hidden

View Edit Toolbar Toggles the Edit Toolbar Shown / Hidden

Hot/Custom Keys Only available when a Custom Keys list is selected
Hot/Custom Keys * ||:| Hot/Custom Keys Design Mode

Snap all Keys on Grid
Reset all Keys Position
Reset all Keys Size and Position

Cue List Menu > Custom Keys sub-menu

Hot/Custom Keys Design Mode When ticked the selected Hot/Custom Keys pane is shown in Design Mode
Snap all Keys on Grid Snaps all the Keys into alignment with the current Grid

Reset all Keys Position Resets all Keys to their original positions

Reset all Keys Size and Position As it says.
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—

3 Unde Record Audio as Mew Cue

3% Cut

[ Copy

] Paste
[ Addcue b | B3 Add Short Empty Cue

B Remove Add Long Empty Cue

B Editin Pyramix Load MTInterChange XML
$  Record Audio Load Audic File

&-} Replace Audio Media Import CD Tracks

¥ Snapshot Automation Record Audio as Mew Cue
(¥ Paste Automation Load MIDI Eile

Mi Change Audio Gain

(] Edit Rules

Add Rule 3

I+ Audition/PFL

Audition *
' PinfUnpin to Active Cue Window
+ Move Down
+  Movellp
b Mest
f1 Unnest
£ Link Offsets/StartTimes
E] View Cue Properties

Ovation Cue Menu

Undo (last undoable action)

Cut Ctrl+X
Copy Ctrl+C
Paste Ctrl+Vv
Add Cue Opens the Add sub-menu

Add Short Empty Cue Adds a 1 second duration new empty Cue below the Cue currently high-
lighted. If none, then adds a new empty Cue at the bottom of the list.

Add Short Empty Cue  Adds a 24 hour new empty Cue below the Cue currently highlighted. If
none, then adds a new empty Cue at the bottom of the list.

Note: Empty Cues are typically used to trigger something immediately or in conditional
rules. If intermediate lengths are required this is easily accomplished by modifying the
Cue Length in Cue Properties.

Load MTInterchange XML

Load Audio File Opens a Browser to search for and Add Cues
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Remove

Import CD Tracks

Opens the Import CD dialog. Please see: CD Tracks Import on page 47

Record Audio as New Cue Opens the Record Audio dialog. Please see: Recording on page 58

Load MIDI File

Edit in Pyramix

Record Audio

Replace Audio Media

Snapshot Automation

Paste Automation

Change Audio Gain

Edit Rules
Add Rule >

Opens a Browser to search for and Add a MIDI File Cue
Removes the selected Cue from the Cue List

Opens the Pyramix editor for editing the selected Cue

Opens the Record Audio dialog to record audio into a new Cue. Please
see: Recording on page 58

Opens a Browser to search for and replace a Cue’s existing Audio Media File.
Opens the Filter Mixer Controls to Snapshot dialog.

Pastes the Automation Snapshot from the Cue copied last to the Cue selected cur-
rently. Please see: Snapshot Automation on page 52

Opens the Cue Gain fader window
Opens the Cue Interaction Rules dialog

Drops down a list of Rules which can be applied to the Cue directly

Fire Next Cue when Ending

Fire Next Cue when Stopping
Fire All Child Cues when Starting

Stop Previous Cue when Starting

Loop (Fire Itself when Ending

Loop between Markers (Fire Itself between Markers

Dim All Cues when Starting

Select Next Cue when Starting

Audition/PFL

Audition >

Start

Rewind

Stop
Play/Pause
Fast-Forward
End

Jump Forward 1
Jump Forward 2
Jump Forward 3
Jump Back 1
Jump Back 2
Jump Back 3

Plays the selected Cue through the selected Output Slot

Drops down a list of available Audition commands:

Pin/Unpin to Active Cue Window Toggles the Cue selected currently Pinned or Unpinned to the Active Cue Win-

dow

Lock in Active Cue Window Puts the selected Cue into the Active Cue Window when Lock mode is active.

Grayed out when Lock mode is not active in Active Cue Window
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Fire

Move Down
Move Up
Nest

Unnest

Edit Cue Rules
Edit Audio Gain
Link Offsets/StartTimes

View Cue Properties

Fire Sequenced Cue!

Previous Scene

Next Scene

Previous Cue
Next Cue

Fire Cue
Pause Cue
Stop Cue
Stop All Cues

Down Moves the selected Cue Down one position in the Cue List
Up  Moves the selected Cue Up one position in the Cue List
Right Makes the Selected Cue a Child-Cue of the one above.

Left Brings a Child-Cue Up one level (becomes a Cue if only one level deep)

Opens the Cue Interaction Rules dialog
Opens the Cue Gain fader window

Links all Audio, TCGen, MMC and 9-pin (Sony P2) Offsets and Start Times in a Cue
with these properties. The button toggles on/off and it’s state is not saved when a
different Cue is Active. When enabled all related fields in the Cue Properties pane
turn red for clarity.

Toggles the Cue Properties Pane Open/Closed

Previous Scene

*

L Med Scene
4+ Previous Cue
+

Mext Cue
k  Fire Cue
n Pause Cue
B Stop Cue

Ovation Fire Menu

Enter With the Show running Fires the currently selected Cue in the currently
selected Cue List and moves the Selection to the next Cue

LEFT Moves the selection to the Previous Scene (Child-Cue or Cue) in the cur-
rently selected Cue List

RIGHT Moves the selection to the Next Scene (Child-Cue or Cue) in the currently
selected Cue List

UP  Moves the selection to the Previous Cue in the currently selected Cue List

DOWNMoves the selection to the Next Cue in the currently selected Cue List

Plays selected Cue

Pauses selected Cue

Stops selected Cue

Stops all Playing Cues. (Typically used as Emergency Stop)
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View Show Properties
View Show Validator
View Show Log

View Show Control Toolbar

View Cue List Properties
WView Cue List Fire Toolbar

View Cue List Edit Toolbar

View Cue Properties

Properties Font Size k

Marmal

NEER

View TimeCode Reader

M | View Audition Toolbar

E=)  View Active Cue Window

View Active Cue Window Edit Toolbar
View Audioc Gain Matrix

View Audic Control

View Mixer

View 1/O Status

View Input Check

Medium
Large

View Show Properties
View Show Validator
View Show Log

View Show Control Toolbar

View Cue List Properties
View Fire Toolbar
View Edit Toolbar

View Cue Properties

Properties Font Size

View TimeCode Reader

View Audition Toolbar
View Active Cue Window
View Audio Gain Matrix

View Audio Control

Ovation View Menu

Toggle Show Properties show/hide
Toggle Show Validator show/hide
Toggle Show Log show/hide

Toggle Show Control Toolbar show/hide

Toggle Cue List Properties show/hide
Toggle Cue List Fire Toolbar show/hide (Show Mode)
Toggle Cue List Edit Toolbar show/hide (Compose Mode)

Toggle Cue Properties show/hide
The sub-menu offers the choice of:
Small
Medium
Large

Font sizes for the Properties panes.

Opens a TimeCode Reader window. Up to 20 may be opened
Toggle Audition Toolbar show/hide (in main Ovation Window)
Toggle Active Cue window show/hide

Toggle Audio Gain Matrix window show/hide

Toggle Audio Control window show/hide
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View Mixer
View 1/O Status
View Input Check

View Touch Controller

Settings

Settings

Keyboard Shortcuts

Help

User Manual
About Ovation

Toggle Mixer show/hide

Toggle 1/0 Status window show/hide

Toggle Touch Controller show/hide

T4 Settings
Keyboard Shortcuts

Ovation Settings Menu

Opens the Main Ovation application Settings window.

Opens the Keyboard Shortcuts dialog.

[ Help |

@) User Manual...

1% About Ovation...

Ovation Help Menu

Opens this User Guide.

Opens the About Ovation window.

Ovation Menus : Settings
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Settings

Note: When the Show is running or a Cue is Auditioning if the Settings Window is
opened many Settings pages will not be shown.

Overview

Many settings are made in the Cue Properties, Cue List Properties and Show Properties panes from within the
active Show. However, there are many other settings which are kept separate and are accessed from the Settings
menu.

The Keyboard Shortcut Editor, is accessed directly from the Settings menu.

The main Settings dialog window is also accessed directly from the Settings menu. Folders and sub-folders are
used to group settings logically. The left-hand side of the window shows all available settings. Folders can be col-
lapsed or expanded by clicking on the folder icons. By default, all folders are open, displaying the Settings Pages
they contain by name. Clicking on a Settings Page in the left-hand pane opens it in the right-hand side of the win-
dow for viewing and editing. Information about pages not described here can be found in the Pyramix
User Manual.

There are two main groups of settings.

T .
=] Settngs

(23 Show Settings

------ |23 Application Settings

Apply changes to All Settings

Load | | Save

Ok ] | Cancel

Ovation Settings dialog

Shown here with all sub-folders collapsed.

. Show Settings are specific to and saved with each Show.
. Application Settings are global and apply to all Shows.
Note: There is one exception to this rule.
In the Application Settings > General > Audition page all the settings are global

EXCEPT the Audition Cues Output Slot. This is saved with the Show so that Templates
can have a PFL bus.
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Settings Buttons

Apply changes to ...

Below the Settings folders tree view the first large button’s function and label changes to reflect the currently
open settings page (if any). Apply changes to ... does as it says without saving the changes to a Settings file. Set-
tings can be saved selectively or in their entirety for future use.

Load

Load opens a Browser window to enable settings Profile (*.pms) files to be located. When the required file has
been located clicking on the Open button loads the file.

Save

To save all settings, Click on the: Save button to open a Save As browser window. If necessary, navigate to a suit-
able location for the file. Type a suitable name in the File name: box and click the Save button to save the file and
close the browser window.

OK

Saves any changes made to settings and exits the Settings window.

Cancel
Cancels any changes made to settings and exits the Settings window.
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Show Settings

General

Formats & Sync

i B
sev . —
3 All settings Preset
----- =5 Show Settings
----- =5 General

----- -3 Reload Save Delete

----- MassCore [dedicated mode]

..... 23 1jO Interfaces Information
""" Master Board(#11290) Effective Sample Rate: 44,100 kHz
----- ADAT(#11290)

..... =3 Routing Effective TC Frame Rate: 25.00 frm/s
""" PCM 44.1, 48kHz Effective Video Frame Rate:  25.00 frm/s

..... PCM 88.2,96kHz
----- PCM 176.4, 192kHz

Warnings:
----- PCM 352.8,334kHz
----- DXD project
----- DSD project
""" TimeCode Frequencies
----- 5] Mixing Console
----- Slots Allocation Sampling Rate |4-4. 1 kHz - |
----- Level Meter
_____ D5 Power Saving TC Frame Rate |25 Frm/s = | Drop
""" Mlxer. SE“’”E_'S audio synchronization
----- Plug-ns Settings
""" Remote Contral Master Sync  |Board #11290 - ADAT -
----- £ Application Settings
Source | Internal A |

Mykerinos WordClod: is Output at 44, 1k 23

Video/TimeCode Synchronization

Video Format |SD -PAL w7 |
TC Reference |Interna| b |
Varispeed
@ Mominal Pull-Dawn Pull-Up
Varispeed 1000 / 1000 = 0.00%

| Apply changes to Formats Sync |

| Load | | Save |

[ Ok ] | Cancel |

Show Settings > General > Formats & Sync
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Preset

This section allows the user to Save and ReLoad or Delete Presets of all the parameters in this page. A variety of
common scenarios are covered in the supplied Presets:

Preset

FILM 24 Pul-Down {modified) -

FILM 24

FILM 30 Pull-Down
IFILM 30

FILM PAL

HDFILM 23.93/1080
HDFILM 23.98/720
HOFILM 241080
HDFILM 24,720
HDFILM 29,97/1030
HDFILM 29.97/720++
IHDFILM 29.97/720
HOFILM 30,1030
HDFILM 30/720++
HDFILM 30,720
JHOTY NTSC 1080
HOTV MTSC 720++
HDOTY MTSC 720
HOTV PAL 1080
HOTV PAL 720++
HOTY PAL 720

TV MTSC

TV PAL

Show Settings Hardware Formats & Sync Preset List

Information

Effective Sampling Rate Displays the sampling rate including the effect of any pull-up or down or Varisp-
eed settings.

Effective TC Frame Rate Displays the TC Frame Rate including the effect of any pull-up or down or Varisp-

eed settings.

Effective Video Frame Rate Displays the Video Frame including the effect of any pull-up or down or Varispeed
settings.

Sampling Rate Displays the rate set when the project was created or the default Mixer preset
loaded. This can be changed from the Sampling Rate drop-down list.

Note: Sampling rate can only be set when a Show is NOT running. If you have been
auditioning Cues the same applies. Please Init and Stop the Show to access.

Warnings

Displays any caveats about the selected rates.

Frequencies

Sampling Rate The drop-down list presents a choice of all available nominal sampling rates.

TC Frame Rate The drop-down list presents a choice of all available TC Frame Rates

Drop Only available for NTSC Frame Rates l.e. 29.97fps and 30fps. When checked drop

frame counting is applied.
Audio Synchronization

Master Sync In a Multi-board system choose the board which will be the sync master from the
drop-down list.

Source This determines the sample clock source for the whole Pyramix system. If an exter-
nal source is selected and no valid signal is detected, the system reverts to Internal
until the external signal is restored. The following choices are available:

Internal Selects the board’s internal oscillator as Clock Master.
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Video Selects an external video input as the reference. The card derives word
clock from the video sync rate. A valid video signal must be connected to
the Mykerinos board chosen as the Video / TC master in the VS3 control
panel.

Word Clock Selects an external word clock source as the reference. The word clock must
be connected to the Mykerinos board chosen as video / TC master in the
V'S3 control panel. This option is grayed out if there is no valid source con-
nected.

Audio Input Select this option if you want Pyramix to derive it's clock from an external
audio source connected to any of the daughtercard(s) present. The correct
audio input must also be selected. LTC

Note: In special situations this option enables word clock to be derived from Linear
TimeCode

WordClock is Output at XXk*2 For sample rates above 48kHz WordClock is normally output at the
standard fundamental rate. E.g. if 128KHz is selected then WordClock is out-
put at 32kHz unless the box is ticked, in which case the WordClock output
rate is doubled to 64kHz.

Video/TimeCode Synchronization

Video Format The drop-down list presents all available Video Formats.
TC Reference The drop-down list presents all valid TimeCode reference sources.
Varispeed

Allows either choice of either a pull-up / pull-down sampling rate or of running Pyramix in Varispeed mode by
adapting the sampling rate.

Important! Typical digital to analog or analog to digital converters (such as Merging Technologies
Sphynx or DUAII do not operate beyond +/- 0.15 %o (150 ppm) and therefore will mute in any Varispeed
mode. It is suggested that the Mykerinos digital I/O’s are routed through external real-time sampling rate
conversion circuitry or to that adequate external converters with built-in pull-up or pull-down support
are used.

Note: Note: Locking to external NTSC video reference is limited to nominal and pull-
down sampling rates.

Nominal ‘Normal’ mode. Uses the nominal sampling rate as set in the Sampling Rate pull-
down menu.
Pull-Down Decreases the sampling rate by 0.1%. Most often used in audio post production for

compatibility reasons between NTSC frame rates of 30 fps and 29.97 fps.

Pull-Up Increases the sampling rate by 0.1%. Most often used in audio post production for
compatibility reasons between NTSC frame rates of 30 fps and 29.97 fps.

Varispeed The speed of audio playback can be varied within the range of -12.5% to +12.5%.
Select this option, then enter the required speed change in tenths of percents into
the adjacent entry field. Values entered outside of the allowed range will be lim-
ited to the extent of the allowed range. E.g. if 1500 is entered, the value will be set
to 1125.

MassCore™ [dedicated mode]
Please see the Pyramix User Manual for details.

1/0 Interfaces

The page(s) shown here depend on the options included with your individual system. Please see the Pyramix User
Manual for details.
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Routing

The page(s) shown here depend on the options included with your individual system. Please see the Pyramix User
Manual for details.

TimeCode

Please see the Pyramix User Manual for details.

Mixing Console

Slots Allocation
-~ —— e Ny
T
{23 All Settings _ Slots Allocation
""" {23 Show Settings Please define the number of Audio Slots/Channels in the Mixing
""" {23 General Cansole used for playing badk Cues. Remaining Slots/Channels will
----- Formats & Sync

be automatically switched to Input Mode and can be used for Live
..... MassCore [dedicated mode] Mixing and for Mixing Inputs from MT ASIO Eridge.

----- 23 1f0 Interfaces

----- Master Board{#11290) Mumber of Audio Slots for Cue Playback: Al Strips] -
----- ADAT(#11290) s
..... a Routing 2 I
----- PCM 44.1, 48kHz 4
----- PCM 83.2,96kHz g
----- PCM 176.4,192kHz 10
""" PCM 352.8,384%kHz Please type higher
----- O¥D project values manually. ..

----- DD project
----- TimeCode

----- =3 Mixing Console

----- g Slots Allocation
----- Level Meter

Apply changes to Slots Allocation

Load | | Save

Ok ] | Cancel

Show Settings > Mixing Console > Slots Allocation

Slots Allocation

“Please define the number of Audio Slots/Channels in the Mixing Console used for playing back Cues. Remaining

Slots/Channels will be automatically switched to input Mode and can be used for Live Mixing and/or Mixing
Inputs from MT ASIO Bridge.

Number of Audio Slots for Cue Playback The drop-down offers the choice of:
All Strips
2,4,6,80r10
Please type higher values manually...

Slots are mapped incrementally to the lowest numbered Slots of the audio mixer.

This option enables vacant strips to be left in the Ovation Mixing Console to define MT ASIO Bridge or ReWire
connections to patch Pyramix (or any other DAW) outputs to the mixing Console for advanced Cue editing.
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Level Meter
This page determines the appearance and behavior of the level meters in the Mixer.

- oy
CEET T
=3 All Settings Head room
----- 25 Show Settings o b
----- =5 General f EEL

----- Formats & Sync P

----- MassCore [dedicated mode] - =

----- 23 10 Interfaces 1 b8 [4E] E
----- Master Board(11290) |
_____ ADAT(11290) Peak and Overload hold time =

----- 23 Routing 1| k|3 [5] =
----- PCM 44,1, 48kHz &
_____ PCM 85.7. 96kHz FPermanent Overload E
_____ PCM 176.4, 197kHz Fermanent Peak, E
----- PCM 352.8,384kHz 5
..... XD praject Decay integration time =
----- D50 project 1 b5 [mz/dB]

----- TimeCode

----- £ Mixing Console Peak level indicatar
----- Slots Allocation -
o | Show after:
----- Level Meter
gl L=ve Met=r I 7 7l (5 5

----- DSP Power Saving

----- Mixer Settings

----- Flug-ins Settings D50 Peak. Filter

----- . Flemu:utell:-:unh'nl | Ik - |

----- [£3 Application Settings

Apply changes to Level Meter

Load | | Save

Ok ] | Cancel

‘AMERGING

Show Settings > Mixing Console > Level Meter

These settings only apply to the current Mixer. This allows each Mixer to have its own custom General and Level
Meter settings.

To change any of the settings, click the left or right buttons or drag the horizontal scroll bar to increment or decre-
ment the selected parameter. Alternatively, type directly into the number field for each parameter (these fields will
only accept numbers within the permissible range for each parameter). The color graphic display of the level
meter will respond immediately to show the effect of Headroom and Alignment parameter changes.

Headroom

Sets the amount of headroom displayed as red meter segments before clipping.

Alignment

Sets the alignment level. Displayed by the point on the scale at which the dark orange segments begin.

Peak and Overload Hold Time

Sets the amount of time in seconds that the peak segment or overload segment (topmost red segment) of the
level meter remains illuminated.

Permanent Overload When the box is checked, the red Overload LED above a track will remain lit, even
after playback is stopped. To clear the LED, double-click it. When not checked, the
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Overload LED will automatically clear itself after a few seconds and remain off until
the next overload occurrence.

Note: The overload LED will go on after one sample with the maximum level.

Permanent Peak This parameter works in conjunction with the Peak Level Display. When this is on
(checked), the Peak Level pop-up display will show the value and location of the
highest level reached on a track up to the time when the mouse was clicked on the
meter. The level display will not be updated until the next time playback is
stopped and re-started. If it is not on (unchecked), the Peak Level Popup Display
will show the highest level reached in that track from the last time the Popup Dis-
play is activated (while playback continues). For example, clicking a channel’s
meter while playing back will display the Peak Level Popup, which will show the
peak level (and its location) reached so far. Click away from the Popup, and it will
disappear. Click on that meter again, and the Popup will appear again, this time
showing the peak level/location reached since the last time the Popup was dis-
played.

Decay integration time

This parameter sets the rate at which the level meter display decays after the level falls below the most recent
peak. The slope of the decay is given in terms of milliseconds per decibel (ms/dB).

Peak level indicator

Show After When the box is checked, the Fader/Input Level displays located above the faders
on each mixer strip display the peak level of the signal running through the corre-
sponding mixer strip. The values are updated at the interval set by the slider below
the check box. If the check box Show After is off, the Fader/Input Level displays
always show the setting of their corresponding fader.

DSD Peak Filter

For DSD projects this drop-down list offers the choice between two filtering options which will be applied to the
DSD signal before it is measured by the level meter.

This will help enable you to ensure that the DSD signal is compatible with the AES recommendations concerning
the high frequency dither noise content.

20k

Applies a 20 kHz low pass filter to the signal, thus only the audible audio content is measured.

40k-100k

Applies a band pass filter with a frequency range of 40 kHz to 100kHz to the signal. According to the AES recom-
mendation the signal level in this frequency range should not exceed -20 dB.
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DSP Power Saving

Gwre LA, | =
5] All Settings Special modes
----- | g:w Sethnlgs Player / Recorder Mode
..... G
_____ EnEra g Thiz mode allows big configurations [az 48 » 48 channelz]
orma ync to run on a single board, Must be used with Multiple Mono
----- MassCore [dedicated mode] Mix buzses
----- 3 10 Interfaces
----- Master Board(#11290) D5P Time Saving
----- ADAT(#11290)
..... 3 Routing Chizable Punch In # Punch Out
----- PCM 44. 1, 46kHz Dizable Mix Down

----- PCM 88, 2,96kHz
----- PCM 176.4,192kHz
----- PCM 352.8,3849kHz
----- DXD project

----- D30 project

----- TimeCode

----- 3] Mixing Console

----- Slots Allocation

----- Level Meter

----- Mixer Settings
----- Plug-ns Settings
----- Remote Control
----- £ Application Settings

Apply changes to DSP Power Saving

Load | | Save

QK. ] | Cancel

Show Settings > Mixing Console > DSP Power Saving

Special Modes

Player/Recorder Mode This mode allows big configurations (such as 48 x 48 channels) to run on a single
board. Player/Recorder Mode is intended for use with an external hardware con-
sole. When this mode is activated, the mixer is relegated to the role of signal router,
there is no level control, no panning, no plug-ins and no inserts. This option is only
available in configurations with multiple mono mix busses.

The Direct Out functionality provides an alternative, more user configurable method of achieving similar DSP sav-
ings.

DSP Time Saving

Disable Punch In / Punch out When the box is checked, Punch-in and out recording capabilities are disabled.

Important! The software still will allow you to arm tracks and to start the recording process, but the
resulting media file will contain digital nulls.

Disable Mix Down When the box is checked, the digital mixdown function activated with the menu
command: Project->Mix Down is disabled.

Important! The software still will allow you to start the mixdown process, but the resulting media file will
contain digital nulls.
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Mixer Settings

P© ™y
Eer ==

=3 all settings

----- 3 show Settings

----- =3 General

----- Formats & Sync

----- MassCore [dedicated mode]

----- £ 1f0 Interfaces

Steren Pan Law

| Sin/Cos law, Conztant Power, -3dB center - |

Intermal Buses

----- Master Board(#11290) b 2 Murnber of Internal Buzes available : | B4 -
----- ADAT(#11290)

----- £3 Routing _ _
_____ PCM 44.1, 48kHz Delay Compenzation policy
----- PCM 88.2,96kHz Mode:
----- PCM 176.4, 192kHz -
_____ PCM 352.8,384kHz Full Delay Compensation -
""" DXD praoject Mate: Delay Compensation mechanism does not support more
""" D50 project than & nested /0 loops.

----- TimeCode

_____ {23 Mixing Console | Awtomatic Delay Compensation
ﬁl:ilﬂlztc:rtun b ax Miser Delay Compensation

----- DSP Power Saving

Delay: { 20 e
----- » [ Rieset to Factor
----- Plug-ins Settings

----- Remote Contral
----- [Z3 Application Settings

Apply changes to Mixer Settings

Load Save

Show Settings > Mixing Console > Mixer Settings
Stereo Pan Law

The drop-down menu offers a choice between the default Sin/Cos law, Constant Power, -3dB center and Square
Root law, Constant Power, -3dB center.

Note: Existing projects will use the previous default Square Root law unless this setting
is changed.

Internal Buses

Max Number of Internal Buses available : Select the number of Buses required from the drop-down. (32 - 384)
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Delay Compensation Policy
Mode

The drop-down menu offers a choice between:
Delay Compenzation policy

hode:

Full Delay Compenzation -

O L

LM T IE SIS O T oo pess

Full Delay Compensation
Ooff

Note: Automatic Delay Compensation does not support more than 5 nested 1/0 loops.

Automatic Delay Compensation When ticked, turns Automatic Delay Compensation On

Note: Any changes to the delay required that occur during playback or recording will
only be computed and applied when the Transport is next in Stop.

Max Mixer Delay Compensation

When required by the Mixer error: Delay compensation dialog the slider should be set to a value just above the
delay latency value requested.

Reset to Factory Click the button to restore the factory computed maximum delay value.
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Plug-ins Settings

-~ N
T e
3 Al settings VBT Flugie
----- 25 Show Settings
""" £3 General Plug-inz Ligt Menu display type:

----- Formats & Sync . .
C H d |40 Canf t

----- MassCore [dedicated mode] @ ~ompanyHame an prigurEen

..... 23 1/0 Interfaces [/0 Configuration

----- Master Board(#11290)
----- ADAT(#11290)

----- PCM 44, 1, 48kHz
----- PCM 88.2,96kHz
----- PCM 175.4,192kHz
----- PCM 352.8,3849kHz
----- DXD project

----- D50 project

----- TimeCode

----- 25 Mixing Console

----- Slots Allocation

----- Level Meter

----- DSP Power Saving

----- Mixer Settings

----- Remote Control
----- (23 Application Settings

Apply changes to Plug-ns Settings

Load | | Save

Ok ] | Cancel

Show Settings > Mixing Console > Plug-ins Settings

VST Plug-ins
The buttons offer a choice of how the VST Plug-ins are ordered and grouped in the Plug-ins List Menu.
Company Name and 1/0 Configuration Sorts the list will be ordered by Company Name and the plug-in’s

grouped according to their /0 configuration.l.e. 1in-1out, 1in-2out,2in-2
out and so on.

1/0 Configuration Groups the Plug-ins by 1/0 Configuration and within each group lists them alpha-
betically by name.
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Remote Control

( — g
cww .~
3 All Settings Mixing Console Remote Control
3 Show Setlings - |
=4 General | Enable Protocol:  |QASIS bt Froperties
Formats & Sync CASIS ! i
MassCore [dedicated mode] EMC
3 1O Interfaces e
Master Board(211240)
ADAT(#11290)
5 Routing
PCM 44. 1, 49kHz
PCM 8B.2,96kHz

PCM 176.4, 192kHz
POM 352.8, 384Hz
DXD project
DED project
TimeCoda
= Mixing Console
Slots Allocation
Level Meter
CISP Poweer Saving
Miver Settings
Plug-ns Settings
& Remote Control
] Apphcation Settings

Apply changes to Remote Control

—r

Show Settings > Mixing Console > Remote Control

Mixing Console Remote Control

Enable When ticked enables the mixer remote protocol(s) selected from the drop-down
list and set up in their respective configuration dialogs.
Properties Opens the configuration dialog for the mixer remote protocol selected in the
drop-down list.
OASIS
EMC
RAP
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OASIS

r Ny
OASIS Transport S
Console IP address Port
192 .168. 1 ., 16 2000
Timeout Options
| Show reconnection message

Timeout [ms] @000

[ (0]4 ] | Cancel |

OASIS Transport Configuration dialog

Console IP address
Set the Console IP address and Port.

Timeout Options

Show reconnection message When ticked a message box will be displayed if connection to the console is
lost and re-established.

Timeout [ms] Set the maximum time for connection to be re-established.

Click on OK to save the configuration and close the dialog or Cancel to close the dialog without saving.

EMC
Midi ln Part Midi Out Part Cortroller
1 | 1. Ethemet MIDI [Emulat v | | 1. Ethemet MIDI [Emulat «| | TASCAM US-2400 (HUI |
2 | Mot Connected v | [Mot Connected | | TASCAM Us-2400 (HUI)
3 | Not Cannected +| | Mot Connected | | TASCAM US-2400 (HUI)
4 | Mot Connected +| Mot Connected | | TasCAM Us-2400 (HUI)

Channel Shift Steplz] 1 Banlk Shift Step(z] 8

Cancel

EMC MIDI I/O Configuration dialog

Click on OK to save the configuration and close the dialog or Cancel to close the dialog without saving.
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RAP (Ross Audio Protocol)

ra Ny
Ross Audio Protocol Controller I&I
Server IP address Server port
192 ., 168 . 100 . 50 EEIEI|

RAP - Ross Audio Protocol configuration dialog

Ovation can be controlled by the Ross Overdrive and Vision products.
Set the Server IP address and Server port in this dialog.

Click on OK to save the configuration and close the dialog or Cancel to close the dialog without saving.

Note: RAP support requires the optional OASIS first class security key. (Included with
Ovation Platinum)
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Application Settings

General

Media Manager

G . =

i3 All Settings Preferred Media Folders
(=] Shaw Sattings
‘=3 Application Settings Click here to add a Path
2 General F:\Owvation Projects
4
Audition
TCR{IF Connections
— Player Units
£5 MIDT
Microsoft MIDI Mapper [Emulatec
Microsoft GS Wavetable Synth [
Microsoft Synthesizer
25 coM
COoM1
=] Ethernet Real-time Sampling Rate Comaersion
Sony over [P 1
Sony over IP 2 Disabled Medium Quality @) High Quality Very High Quality
Sony over [P 3
Sony over IP 4
=3 Controller
Remote Controlled Ovations
=y Contraller Units |l

=3 Proprietary

Other settings

nrrl

Application Settings > General > Media Manager
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Preferred Media Folders
Click here to add a path

Click on the ... field to open the Browse For Folder dialog:

Please select a preferred media folder

&, Local Disk (C) -

- 243 DVD RW Drive (D:)

- =3 DVD RW Drive (E:)

g Video (F:)

a Budic (G

o Stuff (L)

4 — Scratch (%)
SRECYCLE.BIN
Audio

Derno Project

m

Images

QK ] | Cancel

Preferred Media Folders Browser

This enables new Media Paths to be added to search for Media required to Run by an Ovation Show. For example,
it may be desirable to use locally stored Cues rather than run them across a network connection.

Real-time Sampling Rate Conversion
Toggles between three options:

Disabled No Real-time SRC will take place. Clips will be played back at the original sampling
rate. l.e. if sampling rate does not match Project sampling rate then the Clips will
be played back at incorrect speed.

Medium Quality Clips will be played back at the correct speed. Conversion, if necessary, will be car-
ried out at a compromise quality between speed and quality.

High Quality Clips will be played back at the correct speed. Conversion, if necessary, will be car-
ried out at a the highest quality. This obviously requires more resources.

Very High Quality Clips will be played back at the correct speed. Conversion, if necessary, will be car-
ried out by the Merging Technologies HeptaCon Sample Rate Converter at a the
very highest quality.
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Other Settings
Compressed Media Settings

Here you specify where the media should be decompressed to :

* Locally (by the original).
(" Subdocally (by the original, in a WMTDXCache sub folder). Cancel

i

(" Custom (files are generated to the specified location).

Decompress files... dialog

Locally (by the original). When active, File(s) will be created in the same location as the original file.

Sub-locally (by the original, in a \MTDXCache sub folder). When active, File(s) will be created in a sub-folder
created by Pyramix in the same location as the original file.

Custom (files are generated to the specified location). File(s) will be created in a user specified location. When
this option is selected the Browse... button is available to open a file browser win-
dow to set the user defined path.
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Audition

=) General
Media Manager
g Audition
TCRYIP Connections
{Z3 Fayer Units
£5) MIDI

s 2 2020 2 2 2
. =3 All Sethings

(L3 Show Settings
{3 Application Settings

Cue Audition

@ Audition Cues through their default Player
Audition Cues through :

Player

Microsoft MIDI Mapper [Emulate:|

Microsoft GS Wavetable Synth [E

Microsoft Synthesizer
=] COM
COoM1
i3 Ethernet
Sany over IP 1
Sony over IP 2
Saony over IP 3
Sany over IP 4
=5 Controller
Remote Controlled Ovations
= Controler Units
f_-.] Proprietary
OVKeyboard
Web Server
3 coMm

g

i}

Audition Cues on their default Audio Qutput Slot
@ Audition Cues on :

Audio Output Slot | 24

Mote: This setting is saved in the Show, as opposed to all

other settings in this page that are saved globally.

Active Cue Window Trim InfOut Audiion Timings

Cue Out preroll (in s.) 5

Cue Qut looping (in 5.) 1

Apply changes to Audition

Load _! L Save

oK I Cancel

Cue Audition

Application Settings > General > Audition

The radio buttons offer a choice of which Player and Audio Output Slot will be used to audition Audio Cues.
Default is the machine Ovation is running on. Alternative Player choices are only valid in very advanced configura-
tions with Players on networked machines.

Note: For multi-channel Cues, the number set in the Audition Cues on : Audio Output
Slot box defines the FIRST slot to be used for audition monitoring. So, if the Cue is six
channel surround and the number in the box is 9 then the signals will be routed to Out-

put Slots 9 though 14

Audition Cues through their default Player

Audition Cues through:

Audition Cues on their default Audio Output Slot

Audition Cues on:

Audio Output Slot

Any available Audio Output Slot can be typed in the field.

Any Player, on the network can be selected from the Player drop-down list.

Note: This setting is saved in the Show, as opposed to all other settings in this page that

are saved globally.
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Active Cue Window Trim In/Out Audition Timings

Cue Out preroll (in s.) Click in the field to enter an alternative to the default value (5 secs)
Cue Out Looping (in s.) Click in the field to enter an alternative to the default value (1 sec)
TCP/IP Connections
- S --————— e - B
e e =
5 Al Settings
] Show Settings ID Type IP/MName Port  Transport  Status
{2 Apphcation Settings Pl Chent  locahast 1111 TP connected
{2l General P2 Clent locabhast prrr B (e connected
:‘L::m'"m” P3 Server 0.0.0.0 1111 TP 1 chent(s) conmected
i ol IP4 Server 0.0.0.0 prrr il (s 1 dient{s) connected
- :sa CEnneciiion IPS Mene  0.0.0.0 a (e
-_uYr:r:D: P& None 0.0.0.0 o T
Microsaft MIDT Mapper [Ermulater FP? Nene  0.0.0.0 0 IEP
Microsoft GS Wavetsble Synth i | 8 MNeme 0.0.00 o e
Mecrosaft ETﬂmEQW P9 Mone 0.0.0.0 0 Toe
29 coM IPI0 None  0.0.0.0 0 TP
COM1 P11 Nene  0.0.0.0 ] TP
= Ethernet IP12 Mons 0.0.0.0 0 TP
Sony over IP 1 P13 hone  0.0.0.0 0 TP
Sony over IP 2 P14 Nene  0.0.0.0 0 TP
Sony over IP 3 P15 Mons 0.0.0.0 0 TR
Sony over IP 4 P16 None  0.0.0.0 0 TP
3 Controler
Remate Controlad Crvations
23 Controller Units
4 nr ]
Apply changes to TCPIP Connactions
_ Load ][ Save
Lo« I Cancel

Application Settings > General > TC/IP Connections

The TC/IP Connections page enables Ovation TCP/IP connections to be set with the following options:

Type Server or Client

IP address / Server name Enter the target Server IP address or name here. (Not relevant if Type is set to
Server)

Port number / name Enter the target Port number or name here.

Transport Default is TCP.

Status This field shows the current status of the connection.

Note:

+  Oncean IP Client or Server is created, the IP object appears in both the Player Units and Controller
Units sections.

. Player Units deal with Control Protocol Outputs
. Controller Units deal with Control Protocol Inputs

. Both Servers and Clients can send AND receive data. The only practical distinction between them is
that a Server can be connected to multiple clients whereas a Client can only be connected to one
Server.

. Servers accept multiple Clients’ connections.
. When data is sent through a Server, it is sent to all connected Clients.

«  When a Server is no longer available, Clients attempt to reconnect to the Server automatically.
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. When a new connection is created/destroyed, the Apply changes to IP connection button adds/
removes the corresponding Player/Controller units.
IP Address / Server Name Considerations

In general, it is usually preferable to use fixed IP addresses to avoid surprises. A DHCP server should assign the
same address to a given device every time until the device is offline for the amount of time set in the DHCP servers
“lease time”". If you use machine names instead of IP addresses then there is no real disadvantage with a DHCP
server on the network. However, some devices cannot be resolved as a name and an IP address is the only way to
connect them. So, unless there is a very good reason not to use them, fixed IP addresses are the preferred option.

Note: It is best to avoid using the most common port numbers (under 1024 ). For maxi-
mum safety we would recommend the use of ports in the range 49152-65535.

Player Units

Player Units are the virtual devices which enable Ovation to control other targets .

Lists available MIDI interface IP ports and COM ports for playing MIDI, IP Commands and Sony P2 / RS422 Cues

Note: If you attempt to assign an output to a Virtual Com Port that is already in use this
dialog appears:

Virtual Midi port selection cnnﬂi- l-*-]

@>% The selected port is already assigned to a physical device. Would yeu
\ . ' like to assign this virtual port to the current physical port,
~ and therefore unassign the virtual port of the Microsoft MIDI Mapper
[Emulated] device?

Virtual COM Port selection conflict

‘ Settings : Application Settings Page 158
ANVIERGING



I Ovation

MEDIA SERVER & SEQUENCER

MIDI
' - !
e
{3 Application Settings - MIDI
'j zeneral
b Media Manager /| Enable Virtual MIDI Port
ﬁ.wihﬂﬂ NDHE
TCPIP Connections MIDI 1
£5 Player Units MIDI 2
_____ - MIDL MIDI 3
= MIDI 4
Microsoft MIDI Mapper [Emul MIDI 5
Microsoft GS Wavetable Synt MIDCI &
g 01, Ethernet MIDI [Emulated MIDI
[MIDIS |
Microsoft Synthesizer MIDI &
= g MIDI 10
; Pl MIDI 11
P2 MIDI 12
MIDI 13
IP3
4 MIDI 14
MIDI 15
3 COM MIDI 16
COM1
------ 3 Ethernet
[ Tan——— X | =
P4 %
q T 3

Apply changes to 01. Ethernet MIDI [Emulated] ]

Load ] [ Save ]
( oK ] [ Cancel ]

Application Settings > Player Units > MIDI

Clicking on an entry in the MIDI list under Player Units brings up the associated options in the right-hand pane.

Midi
Enable Click to enable
Virtual MIDI Port When enabled the drop-down list becomes active to enable a Virtual Midi Port to

be selected from the list.
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IP
i e N
Qe S, 0 =
4 All Sattings » 1P
() Show Settings
3 Application Settings /| Enable
5 General
Media Manager Escape character [ 'I
Audition - -
Connec 0xQONUL(nul)
=y plﬂ.;ftﬁ:; rons 0x01 SOH (start of heading)
Ox02 5TX (start of text)
i MIDI 0x03 ETY (end of text)
o Microsoft MIDT Mapper [Emul 0x04 EQT (end of transmission)
----- Microsoft GS Wavetable Synt 0x05 ENQ (enquiry)
0L Ethernet MIDI [Emulated g;gg g&‘: Eg’;‘”""“ge)
Micrasoft Synthesizer 0x08BS (backspace)
= IP 0x09 TAE (horizontal tab)
P1 O0x04& LF (ML bne feed, new line)
P2 0x0B VT (vertical tab) 1
0x0C FF (NP form feed, new pag =
""" w IP3 00D CR (carriage return)
------ P4 3 0x0E SO (=hift out)
=3 COM 0x0F SI (shift in)
coM1 0310 DLE (data nk EscarI.EJ
&3 Ethemet OX120C2 (device contil )
Sony over [P 1 0%13 DC3 (device control 3)
Sony over IP 2 0x 14 DC4 (device control 4)
- Sony over IP 3 0x15 MAK {negad_:i-ﬁ adﬂj;'ngedge
_ -~ SeyoverIP4 NIIETh Eiﬁ of trans, block)
J Controller Ox18 CAN {CE“‘EEIJ
Remote Controlled Ovations 0%19EM (end of medium)
=y Controller Units Ex i;. g;lg &{mm]
X
= pmpc;l:z;:oard 0x1C FS (file separator) i
o Web Server
3 MIDI
B 01. Ethernet MIDI
=5 CoMm
CoM1
=p
IP1
frene P2 o
4 ] b
| Apply changes to IP3

-+

Application Settings > Player Units > IP

IP
Enable When checked the Player will output IP commands as defined in Cue Properties.
Escape character When checked an Escape character is used to define the end of a command string.

Choose a suitable Escape character from the drop-down list.
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Com
[ 1 I’ 1 Py
@i L, $ —
. TmeCode - COM
-3 Mixing Console
. slots Allocation /| Enable virtual COMPort  |coM12
Level Meter .
DSP Power Saving Protocol [ Genaric = l |I
Mixer Settings
Plug-ins Settings
COM Settings
Remote Control g
.23 Application Settings Baud rate
= General
Media Manager Data bits (g -
Audition
TCR/IP Connections Parity |Mone =
= Player Units
Micrasoft MIDI Mapper [Emul.
Micrasaft GS Wavetable Synt Flow control [H ke "l
01. Ethernet MIDI [Emulated! |
Microsoft Synthesizer
P Protocol
IF1
P2 : Start of message [ v]
IP3
IP4 End of message [ - |
= COM
g CC
1771 Ethernet
= I
] 7] !

Apply changes to COM1
Load ] ( Save

Cancel

Application Settings > Player Units > COM

com

Enable Click to enable the COM Player

Virtual COM Port When enabled the drop-down list becomes active to enable a Virtual COM Port to
be selected from the list.

Protocol The drop-down offers the choice of Generic or Sony P2

COM Settings

Note: COM Settings and Protocol below are only available when Generic is selected in
Protocol above.

When Generic is active the following serial port options are available. Use the drop-down lists to select the appro-
priate settings for your application:

Baud rate
Data bits
Parity
Stop bits

Flow Control
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Protocol

Start of message The drop-down list offers a choice of hex character strings which will be added to
the start of each outgoing message.

End of message The drop-down list offers a choice of hex character strings which will be added to
the end of each outgoing message.

Ethernet

Sony P2 over IP 0

Pre-requisites

1. Check that File and Printer Sharing is activated:

Win XP Windows Control Panel > Network Connections ~select your LAN card/adap-
tor~ Right-click and choose Properties

Win 7 Windows Control Panel > Network and Sharing Center > Change advanced
sharing settings

:r__‘!__l_m:al Area Connection Properties T@\ [
Gereral | Advenced.
Correct utng Change sharing options for different network profiles
B Restek RTLEIERMN11 PCLE Gigsbi VWindews crestes b separste netwerk profile for each network you use, Tou can choese specic options fer

each profile.

This canrmction uzet e Pollowag bevs:
s Chesrl ow Microoodl Hedwodks
¥ 1 Fil ared Pricker S haing fon Micropof Networcs | | Netwaork discovery
el Qa5 Packet S chadules
B % Inderned Protocol [TCPAPY

Haome or Work (current profile)

When network discovery is on, this comiputer can tee cther network computers and devices snd iz
wisible to other netwaork computers. YWhat s

[ @ Tign eon netoeork disgovery

itall.. atal

[ o | | brin: Twm off netwark discovery
Diescngton
Flgrerd otived COrmpuint: B HOGESE PO Gk 0N ol GoMmgeter File and printer shanng

g & Micnooodt nestwork:

‘When file and printer shanng i on, files and printers that you have shared from this computer can
be accessed by people on the network.

[#] Shaos icon im rotificstion aea when conrected
(] Moty prs kel thaz crpee bt P v do i ety @ T on file and peinter sharing
Twm off file and printer sharing

Publhc folder shanng

Local Area Connection Properties Network and Sharing Center > Advanced Sharing Settings

2. a) Computers onadomain
If your Computers are connected under the same domain jump directly to section 3, since the security access
is managed by your domain server. Please talk to your IT Manager for further details.
b) Computers in a WorkGroup
Working under workgroups requires some extra steps:

. Make sure each machine is a member of the same workgroup.

. You can change your workgroup in Windows Control Panel > System >
. [XPlComputer Name tab > Change [Win7]Change Settings

. You must restart the computer for changes to take effect !

. On each machine, make sure that you can access the other machine(s):

« My computer > Network > Workgroup

. Remember that you have to enter a user name and its password for a user account on the machine
that you require access to.

+  Check the box Remember my credentials [Win7] Remember my password [XP] Otherwise you
will have to enter the user name and password each time you restart the computers.
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. You do not need to share any folders.

Sony over IP

e v

= General - COM
Media Manager
Audition | Enable Virtual COM Port COMiD
TCP/IP Connections -
25 Player Units _
24 Mot Remote Identification
Microsoft MIDI Mapper [Emul: Remote Computer Mame
Microsoft G5 Wavetable Synt
01. Ethernet MIDI [Emulated Part MName *
i Microsoft Synthesizer
23 1P = Port Mame : Type any name you wish, but it must match the
1 Cuntrl_aller Port Name on the other computer. (May be left
blank if only one portis used.)
P2
P3
P4
£3 coMm
: comM1
5 Ethernet

Sony over IP

Sony over 1D 3

111

Apply changes to Sony over IF 1

Load Save

(84 Cancel

‘AMERGING

Application Settings > Player Units > SONY P2 > Device\Serial

Sony P2 over IP enables Ovation to control a remote VCube or Pyramix workstation by using the Sony P2 protocol
over an Ethernet connection. Enable COM port.

Choose a Virtual COM Port (COM1 to COM 16). This behaves in the same way as a real COM port. Virtual COM
ports are used in the Cue Properties pane under Sony P2 / RS422 and COM Command sections.

Remote Computer Name Insert an IP address or a computer name or leave blank when the target local is local.
(E.g. VCube running on the same machine as the Ovation Sequencer.

Port Name Use if the target machine has multiples ports set. This could be the case for a Pyramix but not for a
VCube.

In the rare case that the remote machine is a Pyramix, you must add a controller in Pyramix with the Sony over IP
settings.

If the remote machine is a VCube, there is nothing to configure on the VCube side. But only one connection is per-
mitted.

Com
Enable When the box is ticked Sony P2 over IP is active.
Virtual COM Port Shows the virtual COM port selected currently. The down arrow drops-down the

list of ports available.
Remote Identification

Remote Computer name The entry here must match the remote computer
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Port Name* The entry here must match the Controller Port Name on the other Computer.
GPO
] O%Player Settings -
= All Settings zeneral Purpose Cukpuk (GPO)
— iGeneral
Farmats & Sync Enable Wirkual GPO Part GPO & |
— I/ Interfaces Mone
ASI0{ASIC4ALL v2) GPo 1 i
TimeCode ggg %
Media Manager CPO 4
—i Audio GPO S
Audio Player Settings
— Mixer ggg ;
Level Meter . PO 9 .
D3P Power Saving GPO 10 -
Mizer Setkings
Plug-ins Settings
— Wideo
Wideo Player Settings

— Player Units
A MIDT

=9 GPO
‘ % Seal/O-410 (COMS [0])

apply changes to SealfC-410 (COM [0])

Load } | Save

(0] 4 ] | Cancel

Application Settings > Player Units > GPO > Seal/0-410

Note: For the present the only supported GPI/O interfaces are the following models
manufactured by Sealevel:

. SeaPORT PLC-16** 8 in 8 out

. Seal/O-410U 16 in 16 out

. Seal/O-420U* 16 in 8 out

. Seal/O-430U* 32 in 0 out

. Seal/0-440U* 0 in 32 out

. Seal/O-450U* 0 in 16 out

. SeaDACP/N 8221* 16 in 16 out
. SeaDACP/N 8222 16 in 8 out
. SeaDAC P/N 8223* 32 in 0 out
. SeaDAC P/N 8224* 0in 32 out
. SeaDACP/N 8225* 0in 16 out

* Obtainable on special order.

** No longer available.
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Note: Note: USB drivers are included in the Pyramix Installer. There is no need to download the
driver from the supplier’s website. For more information about the specification of the GPIO
hardware device please see:

http://www.sealevel.com

A maximum of 32 units may be connected. Physically installed GPO devices will appear here. capabilities will
depend on the model.

General Purpose Output
Enable
When ticked General Purpose Outputs are enabled

Virtual GPO Port

The drop down list offers a choice of all available Virtual GPO Ports or None.

Note: When the Show is running or a Cue is Auditioning if the Settings Window is
opened the Player pages will not be present.

Note: Whether the Player is the default local machine or stand alone on a Networked
machine, when the Show is running or a Cue is Auditioning all Player related pages are
absent from the Settings window.
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Controller

Remote Controlled Ovations
This page enables you to define which Stations l.e. PCs running Ovation, will be controlled by an OV Controller

Session.
5 Al Settings Controlled Stations
(1 Show Settings
{3 Application Settings [¥] Local Cvation Sequencer
I ) Ganeral
‘3 Player Units Remote Ovation Sequencers |
3 miDt |
Cawr Click here to add a Remote Ovation Sequencer
£3 CoM Parade
COM1 Lake
23 Ethernet
Sony over [P 1
Sony over [P 2
Sony over IP 3
Sony over IP 4
=3 Controller
Pl Remote Controlled Ovations pecRE e
=] Controller Units o
~ ) | Mirror All Commands to Remate Ovation Sequencers listed above
i3 Proprietary -
CVKeyboard
thfah Rarar
| |
[ Apply changes to Remote Controled Ovations ]
[ Load | Save ]
[ OK ] ( Cancel ]

=]

Application Settings > Controller > Remote Controlled Ovation Stations

Controlled Stations

Local Ovation Sequencer

When checked the Ovation Sequencer running in the same machine (Embedded or Local) receives the commands
from this Controller.

Remote Ovation Sequencers

This table enables a list of remote machines to be added on which a running Ovation Sequencer will receive com-
mands from the selected Controller. This allows for remote control via the network and/or controlling multiple
Ovation Sequencers at the same time for redundancy.

New Remote Ovation Sequencers are added by clicking on Click here to add a Remote Ovation Sequencer and
typing the PC’s network name.

In the above screenshot two Remote Ovation Sequencers, Parade and Lake have been added.
Backup Sequencer

Mirror All Commands to Remote Ovation Sequencers listed above

When checked all commands on the local Ovation are mirrored to the selected remote sequencer(s) for redun-
dancy.

Controller Units

Controller Units enable the Ovation Sequencer/Show controller to be remote controlled.
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In this folder all supported Remote Control Units available in the system are listed in sub-folders. They can be:

The Proprietary Ovation Keyboard
The Proprietary Ovation Webserver
IP Controller

MIDI ports - Midi Show Control (MCS), Midi TimeCode (MTC), Midi Machine Control (MMC) and General
Midi (GM).

DMX ports (Art Net protocol available in later beta)
GPI ports

Sony 9-pin (P2 Protocol) remote control

Note: Appendix | and following details how the various Controller Units protocols are
implemented and how they map the available Ovation Media Sequencer and Media
Server Commands.

When a Controller Unit is clicked to select it in the list, a related page displays appropriate options.Please see sub-
sequent pages in this document.

Proprietary

OVKeyboard

[ @ Settings

= Controller

e
' All Settings Owvation Keyboard
(] Show Settings
=] Application Settings 7] Enable
(2] General
=3 Player Units

(= MIDI Keyboard Mapging

gy

E3 CoM ]
coM1 @) Multi-purpose (Standard Mapping)

=5 Ethernet
Sony over IP 1
Sony over IP 2
Sony over IP 3
Sony over IP 4

Remate Controbad Ovations

{3 Controller Units Hot Keys Only

{3 Proprietary
¥
Web Server
i
01, Ethernet MIDI
=3 CoM
CoM1

Application Settings > OV Controller Units > Proprietary > OVKeyboard

Ovation Keyboard

‘AMERGING

Enable
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When checked the Ovation Keyboard is active

Keyboard Mapping
Multi-purpose (Standard Mapping)

Hot Keys Only

The radio buttons are mutually exclusive. Select the Mapping corresponding to your physical keyboard layout.

Note: For those people using Pyramix and Ovation at the same time and who have the
ADR authorization key and an Ovation Keyboard then Pyramix may conflict with the
Keyboard. In this case you should add a DWORD Registry Key in:
HKEY_CURRENT_USER\Software\Merging Technologies\Pyramix\ADR,

name it "Disable ADR Keyboard" and setitto 1.

If you are not confident with Registry editing then please ask your Merging Sales Partner
to make this change for you.
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Web Server
' B e —— 2
Swrs . =
= .:!dl Settngs - \Web Server
() Show Settings
=y Application Settings 7| Enable
=y General
Media Manager
Audition TP Port: Bag
TCPTF Connections T
=y Player Units Pages Root Folder: C:\Program Files\Merging Technologies\Ovation\Ovatic | ... |
25 MIDI
Microsoft MIDI Mapper [Emul Password (Optional) :
Microsoft G5 Wavetable Synt
01, Ethernat MIDI [Emudated| Tutorial
Microsoft Synthesizer
QP In any browser simply type the IP address of the machine running Ovation followed by
Py the port number as defined above, lie :
P2 http:/127.0.0, 1:888
IP3
P4 =
3 COM The displayed Cue Lists can be limited by adding the following fiter (the Cue List Index in
COM1 the filter iz defined as the Cue List Mumber minus 1) :
3 Etherneat
Sony over [P 1 http:/f127.0.0. 1:888 Filter 2Cuelist=0

Sony over IP 2
Sony aver IP 3

sl The Show Control Bar on the bottom of the page can be hidden to avoid unexpected
= Controller miteraction by adding the Fllowing filter ;
Remate Controlled Ovations
=y Controller Units hitp:/127.0.0. 1:888 Filter ?ShowControliiar =Hidden
=3 Proprietary

If & Passwond is setin the settngs, then it must be provided to access the page :

http:127.0.0. 1:838 Filter Password = <xyz>
01, Ethernet MIDI

23 coM
COoM1 Multiple filters can be provided together, separated by a &:
aF i hittp:f127.0.0. 1:888 Filter Cuelist=08ShowControlBar =Hidden
IP2 =
4 i k
Apply changes to Web Server
Load | Save
[ Ok I | Cancel
Application Settings > OV Controller Units > Proprietary > Web Server
Web Server
Enable When ticked, Web Server control is active.
HTTP Port: The default value is 888. Type in the field to change this if necessary.
Pages Root Folder The default path to the Pages Root Folder is shown in the field. Clicking on the ...
button opens a browser where an alternative path can be set.
Password (optional) : Type a Password in the field to password protect the pages.
Tutorial

In any browser simply type the IP address of the machine running Ovation followed by the port number as
defined above, like :

http://128.0.0.1:888

The displayed Cue Lists can be limited by adding the following filter (the Cue List Index in the filter is defined as
the Cue List number minus 1) :
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http://128.0.0.1:888/Filter?Cuelist=0

The Show Control Bar on the bottom of the page can be hidden to avoid unexpected interaction by adding the
following filter :

http://128.0.0.1:888/Filter?ShowControlBar=Hidden
Or both together, separated by an &:

http://128.0.0.1:888/Filter?Cuelist=0&ShowControlBar=Hidden
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MIDI

E.g. Ethernet MIDI

g I —-
= All Setbings al Midi Bort
(] Show Settings -
) Application Settings +f | Enable Virtual MIDI Port  |MIDL7 = |
= General 3
Media Manager
Ausdbon Midi Show Control (MCS)
TCP/IP Connections 7] Enabl r 1 — 4
e - ( - |
&5 Player Uiits Device Id |27 | Command Format LR.ME J
3 MIDI
Microsoft MIDI Mapper [Emul Mick TimeCode (MTC)
Micrasoft GS Wavetabls Synt :
O1. Ethernet MIDT [Emulated | Enable
Micrasoft Symthesizer
|J' ]p
P11 Mich Machine Control (MMC)
P2
+ | Emabl
IP3 >
P4 B
—coM General Mid
i (cM)
{4 Ethemet 7| Enable direct Cue mapping of MIDI messages from the selected Virtual MIDT Port
Sony over IP 1
Sony over [P 2 Note:  Direct MIDI messages Cue mapping is avaiable in the Cue Properties
REMOTE COMTROL: General MIDI Command' seckion
Sony over [P 3
Sony over IP 4 7] Enable Mapping based on command: | Program change v
=3 Controller 5
Remote Controlled Cvations Midi Channel  Data 1 Media Sequencer
= Controfler Units adg
{=d Proprietary
CWVKeyboard 1 CueFire
Web Server 0 2 CueStop
£ MIDE o 3 CueSelectiext
F 01, Ethemet MIDI
= coM
CoM1
=P
IP1
P2 = Enable Legacy GM (Note OnjOff and Program Change old auto mapping)
i mn ¥
| Apply changes to 01. EthernetMIDI |
[ wead  J[ sawe ]
[ OK | Cancel
Application Settings > Controller Units > MIDI > Ethernet MIDI
MIDI INPUTSs

Note: Red flashing ‘LEDs’ to the right of each MIDI section indicate that MIDI data is
being received.

Midi Port
Enable

Check the button to enable MIDI remote control

Note: The rest of the options on this page will be grayed out (unavailable) until this
option is selected.
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Virtual MIDI Port

The drop down list offers the choice of any of the first 16 MIDI ports available on the machine.
Midi Show Control (MSC)

Enable
Check the button to enable MIDI Show Control (MSC)

Device Id

The drop-down list offers the choice of Any or Device Ids from 0 to 7E

Command Format

The drop-down list offers many MSC choices for filtering Command Format types.
Midi TimeCode (MTC)
Enable
Check the button to enable MIDI TimeCode
The Midi Port used is the one set in the first section above: Midi Port.
Midi Machine Control (MMC)
Enable
Check the button to enable MIDI Machine Control.
General Midi (GM)

Enable direct Cue mapping of MIDI messages from the selected Virtual MIDI Port

Check the button to enable General MIDI (GM) control of individual Cues.

Note: Direct MIDI messages Cue mapping is available in the Cue Properties
‘REMOTE CONTROL: General MIDI Command section

Please see REMOTE CONTROL: General MIDI Command on page 107

Enable Mapping based on command:

Enables MIDI commands to be mapped to events not related to Cue events, such as Show Start, Select Next Cue
List, etc... or contextually related Cue commands such as Select Next Cue, etc...

The drop-down list offers a choice of which type of Midi command is to be mapped from:

Note off

Note on

Polyphonic key pressure
Control change

Program change

Overall keypressure aftertouch
Pitch bender change

Control Change commands are General Midi commands such as Note On.

Clicking on Add in the Midi Channel column adds an entry to the list.

Clicking on the 0 entry in the Midi Channel column drops down the list of available Midi Channels (1-16)
Clicking on the entry in the Data 1 column drops down a list with the choice of 0 to 127.

Clicking in the Media Sequencer column drops down the list of mappable Ovation commands.
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Delete on the PC keyboard removes a mapping entry.

Enable Legacy GM (Note On/Off and Program Change old auto mapping)
Reactivates the old ‘fixed’ style GM mapping.

Please see also: General Midi (GM) on page 172 for a complete list of mappable commands.

com
Ovation Cues can be Started - Stopped or Paused from any Sony P2 Protocol controller. An Ovation station can
also control another Ovation linked via a serial connection using the native Ovation protocol.
Sony P2
i - e ———— I
o I —-
:'J All Settings COM Port
(21 Show Settings
I Appication Settings [V]Enable Protocol  [Sony P2 -
_I General Ovation
{23 Player Units SonyP2 |
(L3 mIDI COM Settings
arwr
i COM Baudrate | cs00
COoM1
£3 Ethernet Data bits |3
Sony over [P 1
Sony over IP 2 Parity |MNore
Sony over IP 3
Sony over IP 4 Stop bits
=3 Controller
Remote Controlled Cvations Flow control landshake

=] Confroller Units
£ Proprietary

CVKeyboard Protocol
Web Server
£5 MIDI Sony device Id Targeted Cue list
i 01. Ethernet MIDI | —— -| [1 — |
£3 CoM
g COM1 Tradk arming Cues selection
£1P
IP1 [Targeted Cue list is used, 1-32 selects Cues ']
P2
P3 Goto Cues selection
IP4 [Targ&ted Cue list is used, hours select Cues - ]

Apply changes to COM1

Application Settings > Controller Units > COM > COM1: P2 mode)

Com Port

Enable When ticked the Com Port and associated remote controller are able to control
Ovation.
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Protocol The drop-down offers the choice of Sony P2 and Ovation. The settings page is
modal and this setting determines what other appropriate settings are shown.
Choose Sony P2 for control by a machine using this protocol.

Com Settings

Protocol
Sony Device Id

The drop-down list offers the choice of Ovation and all P2 device emulations supported by Ovation

Targeted Cue List

The drop-down list enables any Cue List in the current Ovation Show to be selected as the target.

Track Arming Cues Selection
Note: Only Digital presets (Track Arming) from 1-32 are allowed.

The drop down list offers the following choices:
No selection track arming has no effect.
1-8 Selects Cue lists, 9-32 selects Cues

Targeted Cue List is used, 1-32 selects Cuestargeted Cue list is determined by the choice made in the
Targeted Cue List drop-down list.

Targeted Cue List is used, hours selects Cues targeted Cue list is determined by the choice made in the
Targeted Cue List drop-down list.

Goto Cues selection
The drop-down list offers the following choices:
No Selection goto TimeCode has no effect
Hours selects Cue Lists, minutes select Cues

Targeted Cue list is used, hours select Cues targeted Cue list is determined by the choice made in the
Targeted Cue List drop-down list.

Notes:
Valid Cue and Cue List Numbers

Since 00 is not allowed as either a Cue number or Cue List number the maximum number of Cues and Cue Lists
that can be adressed is limited to 23 i.e. 1-23 or 59 i.e. 1-59 in Hours and Minutes respectively.

Limitations
. Goto a specific timecode inside a Cue (not implemented)
. Analog A1, A2,V and TC edit preset bit (track arming) are not used. Only Digital edit preset from 1 up to 32

are used. Above Preset 32 (not implemented)
. Rew, F.Fwd, Jog, Shuttle not possible.

Track arming Cues selection options:

. A) "No selection" track arming has no effect.
. B) "1-8 selects Cue lists, 9-32 selects Cues"
. C) "Targeted Cue list is used, 1-32 selects Cues" : targeted Cue list is chosen by the drop down menu.

Goto Cues selection options :

. 1) "No selection" goto timecode has no effect
. 2) "Hours select Cue lists, minutes select Cues"
. 3) "Targeted Cue list is used, hours select Cues" targeted Cue list is chosen by the drop down menu.

Ovation to Controller Reporting

Ovation reports the following information back to the Controller:
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. The current timecode of the selected Cue.

. Full timecode for option 1 above;

. Seconds and Frames for option 2 above, Hours and Minutes indicating respectively the Cue list # and Cue
#.

. Minutes, Seconds and Frames for option 3 above, Hours indicating the Cue #.

. Play, Stop, Pause (Still) tally, Cue Up (when Cue is ready).

. Track arming status (Edit preset sense) indicating the selected Cue. Inactive for option A.

. Default Device Id is Ovation which reports: Sony device ID : 0xFOB1 (NTSC), 0xF1B1 (PAL), 0xF2B1 (Film).

Any other available device Id can be selected from the Sony Device Id drop-down list.

Ovation mode

..... 3

Show Settings

23 General
i3 Player Units
D MIDI

a COM
COM1
i..{Z3) Ethernet
Sony over IP 1
Sany over [P 2
Saory over IP 3
Saony over I[P 4
5] Contraller

: Remote Controlled Ovations
235 Controller Units
----- =3 Proprietary
' OVEeyboard
Web Server

CEEE 222 v

{_ﬂ All Settings

Apply changes to COM1

Load ||

Save

K Cancel

| |

‘AMERGING

Com Port
Enable

Protocol

COM Port
| Enable Protocol | Ovation -
|
Sony P2 |
COM Settings
Baud rate | a500 - |
Data bits | a - |
Parity | Mone - |
Stop bits | 1 - |
Flow contral | Handshake - |
Protocol
Flease see appendix ITX of the Qvation user manual for the
commands detail

Application Settings > Controller Units > COM > COM1: Ovation mode)

When ticked the Com Port and associated remote controller are able to control

Ovation.

The drop-down offers the choice of Sony P2 and Ovation. The settings page is
modal and this setting determines what other appropriate settings are shown.
Choose Ovation for control by another Ovation station.
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COM Settings

The following parameters should be set to match the controlling Ovation.

Baud rate
Data bits
Parity

Stop bits
Flow Control
Protocol

Please see: Appendix VII on page 228 of this document for the commands detail.

IP
-
= "’f" Settings Internet Protocol Options
(20 show Settings
= fPDL'v:atﬂn Settings (7] Enable
[ General
1 Player Units COvation Native
i Controller
Remote Controled Ovations Text string format based on http command format. Detads are
£ Controller Units avaiable in the appendix IIX of the user manual.
=3 Proprietary
OVKeyboard @ Mapping (Cue direct mapping)
Web Server
5 MIDI Escape character 0300 MUL {nuwll)
01. Ethermet MIDI
£3 CoM @) Message length of 8 byte(s)
CoM1
£3 1P Dataton Synchronization
IF1
P2 || Send status feedbadk via Player section of this connection.
) (Player section will be unavailable for other purpase)
v &
P4

Apply changes to IP3
| ' Save

] [ Cancel

Application Settings > Controller Units > IP > IP3

Note: An IP entry and IP1 etc. controllers will only be visible if they have been defined in Settings > Application
> General > IP Connection. Please see: TCP/IP Connections on page 157

An IP Controller Unit is used to receive data.
Two data formats are accepted:

1. Ovation Native (http protocol format)
2. Mapping. Mapping data messages are defined either by
a. Message length

b. By a special end of message character (Escape character)

Internet Protocol Options

‘ Settings : Application Settings Page 176
ANVIERGING




Enable

Ovation Native

Mapping (Cue direct mapping) Mutually exclusive with Native and Dataton Synchronization.

Dataton Synchronization

When checked, the Controller is active and the rest of the settings on this page

become available.

Mutually exclusive with Mapping and Dataton Synchronization. When checked,

the native HTML format command strings as used by the Ovation Web Server are

accepted. Please see: Web Server Commands on page 228

Escape Character When checked an Escape character is used to define the end of a command
string. Choose a suitable Escape character from the drop-down list.

Message Length of When checked the Message length (in bytes) is used to define the break

points between command strings.

and Mapping.

Check this when using a remote Dataton player. Mutually exclusive with Native

Send status feedback via Player section of this connection (Player section will be unavailable for other pur-

GPI

pose)

All Available GPI Units Listed

Click on each entry in the list to configure the GPI Device

Note: For the present the only supported GPI/O interfaces are the following models

manufactured by Sealevel:

SeaPORT PLC-16** 8 in 8 out

+ Seal/0-410U 16 in 16 out

+ Seal/0-420U* 16 in 8 out

+ Seal/0-430U* 32 in 0 out

+ Seal/0-440U%* 0 in 32 out

+ Seal/0-450U* 0 in 16 out
+SeaDACP/N 8221* 16 in 16 out
+SeaDACP/N 8222 16 in 8 out
+SeaDAC P/N 8223* 32in 0 out
+SeaDAC P/N 8224* 0 in 32 out
+SeaDAC P/N 8225* 0in 16 out

*Qbtainable on special order.

**No longer available.

Note: A maximum of 32 units may be connected.
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OV Controller Settings > Controller Units > GPI > Seal/0-410 (COM9 [0])

General Purpose Input (GPI)
Enable
Check the button to enable General Purpose Input (GPI) control.

Cue # corresponds to the Cue ID

When the button is checked the The Cue is identified with up to 3 nested levels using Cue#, Child#1, Child#2 and
Child#3. This is the greyed number present in the Cue property page or the Number next to the Cue namein a Cue
button. The number represents the separation between the Cue# of Child#1 etc.

This mode is useful when a Cue needs to be added anywhere in the Cue List using the nesting mechanism without
changing the # of the Cue below the inserted Cue.

Cue # corresponds to the Cue Index
The Cue # is the Cue index in its Cue List. This is the greyed number present in the Cue Properties page or the

Number next to the Cue name in a Cue button IF any of the Cues are nested. Useful when the nested mechanism
is not useful for the mapping.
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Example:

Cue Number |Cue Id  |Subl Cue Id [Sub2 Cue Id |Cue Index
1 1 0 0
2

3
3.1
3.2
4
41
411
4.2
421
422
5

ORARARARDRDEW®W®WN
ONNNRRONROO
ONPFPORFRPOOOOOO
SREBoo~vouarwnpr

Trigger Options

The 8 radio buttons set the trigger parameters:

1 Trigger when High level signal is detected

2 Trigger when Low level signal is detected

3 Trigger when Rising level is detected

4 Trigger when Falling level is detected

Trigger when the first High level pulse is detected

6 Trigger when the second High level pulse is detected

7 Trigger when the first Low level pulse is detected

o=

8 Trigger when the second Low level pulse is detected

Note: 3-4, 5-6 and 7-8 will often be used in pairs:

Example 1: You wish to Fire a Cue when a button is pressed and released and to Stop the Cue when the button is
pressed and released for the second time. In this case use 5-6 or 7-8.

Example 2: You wish to Fire a Cue when a button is pressed and Stop the Cue when the button is released. In this
case use 3-4.

Note: High/Low and Rising/Falling inputs trigger the mapped command in the same
circumstances. The only difference is that Rising is executed before High and Falling is
executed before Low. This can be useful if two commands need to be executed consec-
utively.

Media Server Commands Mapping

In the commands Table the P columns correspond to Parameters. For the majority of Media Server commands. P.1
=Cue List #, P.2 = Cue #, P.3 Cue Child1 #, P4 = Cue Child2 #. Please see also AppendixV on page 225 and espe-
cially the notes.
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Ovation Webserver

Overview

Ovation delivers an amazing amount of control over any system. However, until now, accessing that control has
been, like most other sequencer and control software, limited to proprietary interfaces on local machines.

Now, with the WebServer option for Ovation, the entire picture has changed. Through standard HTTP interfaces
on any web enabled platform (desktops, laptops, Smart Phones, iPad etc) it is now possible to have complete con-
trol over your Ovation show from multiple locations.

Use Merging's own interface design, or, if you know basic web page design, you can do it yourself and create
bespoke custom interfaces. Whatever your choice, and whatever the project, using WebServer for your next Ova-
tion show or installation will unlock unprecedented control possibilities.

Applications

. Multiple zone access for non-technical users (Museum exhibits with multiple rooms etc.)

. Stage side access for firing manual Cues and sequences

. Multiple control stations, for example, for game shows. The gallery, the sound supervisor and presenter
can all have appropriate controls for theor needs.

. Show information and timing views for Conductors in "the Pit"

. Bespoke, branded interfaces for hotel lobbies and bar installs

. And many, many more......

Using Ovation Webserver

Activating

To enable the Ovation WebServer go to Settings >Application > Controller Units > Proprietary > Web Server
and check the Enable button.

If necessary, the HTTP Port number can be changed in this page. The default Port is 888.

The Pages Root Folder can be changed to provide custom pages different to those provided by Merging as stan-
dard. The default implements an interface similar to the Ovation User Interface.

Note: The files OvationShow.html and js/OvationProcess.js are the property of Merg-
ing Technologies, but can be used freely as a reference to aid in the creation of custom

pages.
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Quickstart
In any browser simply type the IP address of the machine running Ovation followed by the port number, for exam-
ple:
http://192.168.2.13:888
EJ Owvation Web Controller - Mozilla Firefox ZE
o= Qo Mew Hglory Qookmarks  Took  Help
@ = gf | L] heepilf192.169.2. 13880/ -1 143- y:

B Mt Vashed W Gatbing Stacted 0 Latest Haadines | | Customizs Links | | Fres Hotrad | Windaows Macketplses | | Windows Mada | | Windows

| Dvation Web Controller

Crvation - Chuickstart V2 1.0vs

Cue List1 Cue List 2 Cue List3 Cue List 11 Cue List12 Cue List13

1  steampasses D0:00:25

000048

trairmwhistle 00:00:06

00:00:42

sleampassd opoon

The Cue Lists displayed can be limited by adding the following filter (the Cue List Index in the filter is defined as
the Cue List number minus 1) :

http://192.168.2.13:888/Filter?Cuelist=0

The Show Control Bar on the bottom of the page can be hidden to avoid unexpected interaction by adding the
following filter :

http://192.168.2.13:888/Filter?ShowControlBar=Hidden
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Or both together, separated by an &:

http://192.168.2.13:888/Filter?Cuelist=0&ShowControlBar=Hidden

Which looks like this :

@' Ovation Web Controller - Mozilla Firefox =), |
Ble Edt Wew Hgoy Gockmarks ook Hel

@ - O (2 | L] Bepiiuez68.2. 3 6as Fite PCusktm0S S CortrolilarmHidden R B J
) Mot visked b Getting Stated 5 Latest Hasdines | | Customice Links | | Free Hotmal | | Windows Marketplace | | Windows Madia | | Windows

| Dvation Web Controller =

Onation - Quickstart V2 1.0vs

Cue List 1 Cue List 2 Cue List 11 Cue List12 Cue List13

1-CueList1

« 1 steampasses 00:00:35
2 station 000046
3 trainwhistie D0:00:06

beell Dooo42

steampass2 000031

Frkp T2, 166, 2, | 3688 Filer Ouekt =B ShowControlilar=Hidden#tabs-2

Settings
Clicking on the Ovation logo on the top right-hand corner of the page displays a menu with a choice of viewing
style, Tabbed or All-In-One-View and the page Refresh Interval :

v TYoE:

All-in-One View

Refresh Interval; Tabbed Yiew

00:00:46

In All-in-One View Cue Lists are shown one after another down the page. In Tabbed View a single Cue List is
shown with the rest available on tabs at the top of the page.
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200 ms
333 ms [detaulf)

1000 ms

If the network is slow or artefacts are noticed the refresh rate can be reduced to advantage.

HTTP Control

HTTP Commands can be sent directly to the Ovation WebServer by any client application (or simply by typing
commands in a web browser URL field).

These commands are described in the Ovation Controller Commands documents which can be found here:
Appendix VIl on page 228 Web Server Commands.

Typically, commands such as these will be sent:

. 192.168.1.33:888/Action?Command=Show_Init

. 192.168.1.33:888/Action?Command=Show_Start

. 192.168.1.33:888/Action?Command=Cue_Fire&CueList=0&Cue=4.-2
. 192.168.1.33:888/Action?Command=CuelList_Select&CueList=0

. 192.168.1.33:888/Action?Command=Cue_Select&CueList=-1&Cue=1.-2
. 192.168.1.33:888/Action?Command=Cue_Fire&CueList=-1&Cue=-1

. 192.168.1.33:888/Action?Command=Cue_Pause&CueList=-1&Cue=-1
. 192.168.1.33:888/Action?Command=Cue_Fire

. 192.168.1.33:888/Action?Command=Cue_Stop

. 192.168.1.33:888/Request?Show

. 192.168.1.33:888/Request?Cues_Status

Connection Feedback

If the client network connection is lost (wifi) or if for whatever reason the Ovation server goes offline, the Time-
Code counter background turns red. The Web Ul reconnects automatically when the connection is restored.
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Rules

Tips and Tricks

Itis important to appreciate the differences between specifying Ending and Stopping.
Ending is when a Cue finishes playing normally.
Stopping is when a Cue is terminated prematurely either manually or by a rule.

Itis equally important to appreciate the difference between When and After. This setting affects the point at
which the rule is applied. If When is selected then the rule is applied at the point the fade out or the fade in begins.
If After is selected then the rule’s action is applied after the Cue Starts or after the Cue Ends or Stops with a delay
setin the ms box.

Note: A rule’s action always occurs at either the start of a Cue or at the beginning of the
Fade Out unless a delay is applied using After.

If When is chosen this is an easy method of producing cross-fades.

If a crossfade is NOT required then you can use the Offset parameter to compensate.

Fade Modifier

Pressing the Shift key invokes the User defined fade duration. (Fade Modifier key on the dedicated keyboard or
the Shift key of the standard keyboard.)

<Default>

Where <default> is an option in Ovation the hierarchy works like this:

Cue settings override Cue List settings override Show settings.

Player

If no specific network OVPlayer is assigned in Cue Properties l.e. the field is set to blank or <default> then Ova-
tion looks at the assignment in the Cue List Properties Default Output Player field. If this is also set to blank or
<Default> then Ovation looks at the Default Output Player field in Show Properties. If this too is set to blank or
<Default> then the local Ovation player is used.

Stop Fade Out

Similarly if Stop Fade Out is set to <Default> in Cue Properties then Ovation looks at the setting in the Cue List
Properties Default Stop Fade Out field. If this is also set to <Default> then Ovation looks at the Default Stop
Fade Out field in Show Properties. If this too is set to <Default> then the value in the Fade Out field in Cue
Properties is used.

Drag & Drop

Media Files can be “Dragged & Dropped” into Cue Lists from outside Ovation. E.g. Explorer browser or iTunes. A
new Cue is created automatically when Media Files are added in this way unless the Alt key is held down while
Drag & Dropping onto an existing Cue, in which case, for Audio only Cues, the underlying Media File is replaced.

Cues can be dragged and dropped between Cue Lists using the Shift modifier. If the Alt modifier is used the
underlying audio Media File is replaced with the source. Simple drag and drop is used to reorder Cue Lists.
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Changing Properties for Multiple Cues

When multiple Cues are selected, parameters changed in Cue Properties are updated for all selected Cues. The
only exception being Cue Number. This applies even when the Cues are selected in several different lists.

(Selecting Multiple Cues follows the Windows browser conventions. l.e. With one Cue selected, Shift + Click
selects a contiguous range of Cues to the second Cue clicked and Ctrl+Click toggles Cues selected/unselected.)

Starting a Show With Sysex

In Ovation 2.x, MIDI SysEx inputs are not mappable to a specific Ovation command. The only MIDI inputs mappa-
ble are : General Midi (GM) - Control Change commands (2-3 byte length message). l.e. hexa = B0 00 00 or B1 10 00
or..

However, if the controlling device is capable of sending any SysEx message, the two Midi Show Control specific
SysEx messages below can be used.

Show Init:

Hexa = FO 7F <Device id> 02 <Sound (General) = 10> 07 01 F7 Show Start:

Hexa = FO 7F <Device id> 02 <Sound (General) = 10> 07 02 F7

<Device id> : specified in Settings > Controller Units > MIDI > Midi port (Midi Show Control section).
<Sound (General)> : as well.

For details of Midi Show Control macro commands available in Ovation Please see MIDI and Midi Show Control on
page 216 onwards.
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System Requirements For Ovation

Computer
. Pentium 4, Pentium D or Core 2 Duo
. "1024 MB RAM (2048 MB or more recommended for large projects)
. "IDE, SATA System Hard Disk
. "AGP/PCle graphic card with resolution of 1280x1024 or better (ideally Dual-Head
for twin screen operations)
. "SATA/RAID HD for Audio Storage
. "SVGA 17" monitor (19" or better recommended)
. "3 button mouse
. "USB or Firewire/IEEE1394a (better) for ASIO Audio

Note: Please note that Ovation requires a 32 bit Windows 7 or Windows XP Pro worksta-
tion with a minimum display resolution of 1280x1024 256 colors (in small fonts mode).
(64 bit Windows 7 is also certified for Native Oavtion systems ONLY.

Hard Disk Space Requirements

A complete software installation will require around 100MB of disk space for the Ovation software itself and
approximately 10MB of disk space for Virtual Transport.

In addition, you will need hard disk storage for media files. For audio media as a rule of thumb, one Gigabyte of
disk storage equals:

. 185 track minutes at 44.1 kHz 16 bits
. 125 track minutes at 44.1 kHz 24 bits
. 170 track minutes at 48 kHz 16 bits

. 115 track minutes at 48 kHz 24 bits

. 55 track minutes at 96 kHz 24 bits

For multi-track applications, divide total available mono track time by the number of tracks you will be using.

Please note that these are very rough estimates, and should be used only as a general indication of storage
requirements.

Operating System

For systems including Mykerinos cards and or MassCore 32 bit Windows 7 or 32 bit Windows XP Pro, installed with
Administrator privileges (never attempt to install Ovation on NT Server). For Ovation Native systems ONLY 64 bit
Windows 7 is also certified.

Power Management

N.B. As with all real-time applications, we recommend setting the PC to an Always On Power management
scheme. (Start > Control Panel double-click Power Options. Choose Always On from the Power Schemes
combo box.) This allows the monitor to be turned off by the system but disables hard-disk turn off and Standby.

Note: The Mykerinos card is not designed to support Standby modes.

Other Applications

Like all real-time applications, Ovation works best when there are no other unnecessary applications or services
running.
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Installing Hardware

Mykerinos Board Installation

The Merging Technologies Mykerinos board can be installed in any free PCl slot in your PC. In general, it is best
NOT to install the board in the PCl slot adjacent to an AGP graphics adapter; and in a PCl slot which may be physi-
cally shared with an ISA slot.

Please consult the:

www.merging.com

website for current compatibility information.
Make absolutely certain the PC power is OFF before installing the board!

With most of the current generation motherboards this means either the mains switch on the power supply or the
power outlet switch. Where no switch is provided, either on the PC or the supply socket, then the PC should be
unplugged.

Always observe proper static precautions when handling any PC boards! Use a static strap, and/or be sure to firmly
ground yourself to the computer power supply, chassis or if the PC is unplugged, to a known good earth before
handling and installing the Mykerinos board.

Some PCs have batteries, cables, jumpers, etc. which could prevent proper board seating in one or more slots.
Make certain the board is firmly and fully seated before switching on.

Multi-board installation

Multiple boards must be installed in adjacent slots. To enable multi-board operation, all Mykerinos cards in the PC
have to be connected together using a special HDTDM ribbon cable. This cable has to be plugged into the multi-
pin connectors located on the top edge of the I/0 daughter cards. Please contact your Merging Technologies
dealer for information on how to order this HDTDM ribbon cable.

HDTDM/XDTDM
The HDTDM board linking cable has the following functions in a multiple Mykerinos board installation:

a) synchronization (to 1/512th of an audio sample accuracy) This enables Pyramix to "see" a single system com-
prised of a large pool of DSP power and I/0 resources spread over separate cards.

b) transfers all audio signals (Live Inputs, Internal Send/Return Busses, Mix busses, Aux busses, Live Outputs, etc.
between all the Mykerinos I/0 daughter-cards which comprise the multi-board system.

Mykerinos Board I/0

‘AMERGING

Audio /O Options

Mykerinos is a modular board which can have any one of several optional audio I/O daughter cards attached.
When ordering Ovation from Merging Technologies or one of its distributors, be sure to specify the daughter card
appropriate to your specific needs.

On-board Analog Audio I/0

Regardless of which 1/0 daughter card is chosen, you can simultaneously use the 3.5mm stereo mini-phone jack
on the Mykerinos board as an unbalanced, analog stereo audio monitor output for all projects up to 384 kHz, with
levels programmable from within the software. Sources at sample rates higher than 96 kHz are automatically Sam-
ple Rate Converted to 96 kHz, 24 bit. This stereo mini-jack connection may be connected to headphones or to a
line level audio monitor input.

External Audio D/A-A/D Converter Boxes

Most of the I/0O options for the Mykerinos board are digital. Pyramix will often be used with external audio D/A (for
playback) and A/D (for recording) converters. Many such converters are available from Merging Technologies as
options: for example, the Merging Technologies Dua Il and Sphynx 2. Contact your local Merging Technologies
Sales representative for more information.
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Capabilities of third party A/D - D/A converter boxes are widely variable. Please check with the manufacturer to
ascertain which sample rates, word lengths and number of I/0 channels are supported. You will need this informa-
tion later to appropriately configure the software.

Time Code and Video Sync Option

The Synchronization option provides SMPTE / EBU LTC and VITC time code in/out, video sync in/out and word
clock sync. A multi-pin circular mini-DIN connector, on the back plate of the Mykerinos board carries all the system
synchronization, time code and video sync signals. An optional break-out cable is provided for connections to
time code, sync and video I/O. The Synchronization option allows Ovation to be configured as a master or slave
lock to external time code, video or word clock. It also enables VITC and/or a visible time code burn-in window
(BITC) to be added to video output/throughput.

Cabling Ovation in your System Environment

Please read this in conjunction with the guide or guides for your specific interface daughter-cards and external
interfaces/converters.

Due to the number of possible I/O options and the variety of user environments it is impossible to cover all the
variations of cable connections to and from an Ovation workstation. However, here are some general rules and
examples:

Mykerinos Back-plate

e F
Py -

r

—
[(. y‘-—l 3.5mm Mini-Phone Jack for analog monitor output
i

—

8-pin Mini-DIN for sync breakout cable

I4—| Area where 1/0 Daughter Card output connectors appear

’

v

Mykerinos Backplate

Audio Connections

Many users will have A/D Converters for feeding analog audio sources into Pyramix, and D/A Converters for play-
ing analog audio out of Pyramix. In this case, connect your analog audio sources to the A/D Converter analog
audio inputs, and the A/D digital audio output(s) to the Mykerinos digital audio input(s). Similarly, connect the
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Mykerinos digital audio output(s) to your D/A Converter digital audio input(s), and the D/A Converter analog
audio outputs to your studio monitors or recorders. It may be also be useful to connect the stereo mini-phone out-
put on the Mykerinos card to either stereo headphones or a stereo monitor console input. The source for this jack
can be configured inside the Pyramix software.

Digital Audio Synchronization and TimeCode

THERE MUST BE ONLY ONE SOURCE OF SYNC FOR AUDIO AND TIMECODE

Digital audio relies on extremely accurate timing. In any digital audio system there can only be one source of sync
at one time. This is particularly important when planning multi-machine systems. If TimeCode is not locked to the
same sync source as the digital audio then either the audio will work properly, or the Time-Code. But NOT BOTH
AT THE SAME TIME.

Ideally, in any system with more than one device, there will also be an independent source of sync. E.g. a word-
clock generator with multiple outputs. Each device is fed by a single output and configured to use this source as
its sync reference.

Sync, Video and Time Code Connections

In any digital audio system, it is VERY IMPORTANT all interconnected units are locked to the same sync reference.
A digital audio signal itself can sometimes be used as the master sync source, but a high stability video or word-
clock signal is usually preferable.

The Mykerinos board can be configured inside the Ovation software to act as either a sync master, or to slave to a
variety of incoming signals.

Decide which device in your system will provide the master sync reference, then ensure that all other digital audio
devices in your system take their synchronization from it. This will require routing appropriate cables --whether
digital audio, video or wordclock cables-- to the various other devices and may also involve a separate sync refer-
ence generator and or distribution amplifiers.

If Pyramix is configured as the master (Internal sync), other digital audio devices will probably be able to lock to
the digital audio output from Ovation. However, Ovation can also be configured to output a wordclock signal at
the Video output BNC connector (Synchronization option required).

If Ovation is configured as a slave to an external device, Various synchronization signals can be accepted.

. To lock to incoming digital audio, connect an appropriate digital audio signal to an Ovation digital audio
input.

. To lock to incoming video, connect an appropriate video signal to the Video Reference input (Synchroni-
zation option required).

. To lock to incoming wordclock, connect an appropriate master wordclock signal to the Video 2 Input (Syn-
chronization option required).

. To set the termination jumpers provided on the Mykerinos board, please see the Mykerinos User Guide.

. Ovation can either output or lock to incoming SMPTE / EBU TimeCode.

. If a master LTC Time Code output from Ovation is required, cable the LTC time code out RCA jack or XLR to

any other devices slaving to this output (Synchronization option required). Ovation always generates time
code when playing.

. To lock Ovation to an incoming LTC time code signal, cable the LTC TimeCode output from the TimeCode
source to the LTC input RCA jack or XLR (Synchronization option required).

. Ovation can accept and generate VITC in standard PAL/NTSC formats. It can also provide BITC (Burnt In
TimeCode) on its video outputs.

MIDI Connections

To use Ovation MIDI functionality with external equipment, you will require a MIDI interface. Many current moth-
erboards include an on-board MIDI interface. If yours does not, it is a simple matter to add one. This can be either
an internal PCl card or an external unit connected via a USB port or an RS232 serial COM port.
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Installing Ovation Software

Installation Overview:

Note: If you have purchased hardware options such as the NET-MSC-GBEX1 PCle Ether-
net card, the Sync Board and or a Black Magic or AJA video card, please install these fol-
lowing the instructions in the accompanying documentation. The drivers for all of these
except BlackMagic cards are installed automatically with the Ovation software.

Note: Where applicable BlackMagic video card drivers have to be downloaded from the
BlackMagic website and installed separately.

Installer

The Ovation software uses an automated installer wizard which will install all necessary prerequisites. We use a
unified installer package containing the current versions of Pyramix, VCube and Ovation. The initial installer
screen offers the choice of Pyramix, VCube and Ovation. Choosing Ovation will also install Pyramix.

You may exclude the installation of any of the individual components in the wizard, if the device in question is not
present on your machine or if you do not intend to use an item, by un-ticking the tick boxes next to the items
listed in the wizard.

Note: The security dongle must be in place and the security keys entered before
attempting to launch the software

Driver Signing

There is no Driver Signing Options dialog in Windows 7.

Windows throws up a warning dialog when unsigned drivers are installed. To avoid the necessity of clicking on OK
several times you may wish to check the Always Trust Drivers from Merging Technologies box.

Flux VS3/V3 plug-ins

The Flux plug-ins are not bundled in the installer, they must be installed separately. Two versions are available, 32-
bit and 64-bit. Download the 64-bit installer for Pyramix 10 and ensure you have valid Merging Flux v3 Keys in
order to run these Flux VS3 plug-ins.

https://www.fluxhome.com/download

VB VS3 plug-ins

VB VS3 plug-ins are installed by default with a complete Pyramix install. If you do onot wish to have them installed,
e.g. in evaluation mode or if you do not have valid keys then select Custom during the Pyramix install and remove
them from the install by right-clicking on them.
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Running the Installer

Note: Note: You must have full Administrator Access to install Ovation. If you have a
SafeNet dongle please remove this before installing Pyramix and replace it after installa-
tion is complete.

Note: The HASP dongle is not supported on 64-bit systems. If you have a HASP dongle
please contact your Merging Technologies Sales Partner to purchase a SafeNet dongle
and transfer your keys.

Once the NET-MSC-GBEXT1 Ethernet card has been properly installed, you can now install the Ovation 6.x software.

To install the Ovation 6.x software insert the USB memory stick. The installation program will auto-start on a PC
where auto-start is configured on. Otherwise, double-click on the USB memory stick icon.

Please follow the automatic installation procedure accepting the option to install unsigned drivers and re-boot
your PC once setup is complete.

Note: If the installation appears to freeze for a long period please check that the Driver
Signing warning dialogue is not hidden behind another Window. Installation will not
continue until you click OK in this dialog.

WARNING: Certain computers do not properly shut down despite the reboot command issued by the installer but
only perform a log off. In this case, please activate a full shut down manually.

Enabling Ovation with your Software Key

The Ovation software and its various software options are protected by an authorization key mechanism which
uses a unique registration key number generated by Merging Technologies. Based on purchased software compo-
nents, this key is unique to your Sentinel or HASP USB dongle serial number or Mykerinos board serial number,
your Company Name and your User name. Once you have registered your software you will be provided with this
Key or Keys (depending on the options chosen).

When you receive your Ovation Package you should also receive either an email from your Merging technologies
Sales Partner or a printed copy of the email containing your security setting details. If you did not receive this key,
have lost it or would like to change the user and/or company name, please contact your Merging Sales Partner
with your Mykerinos serial #, your User Name, your Company Name and the list of purchased software compo-
nents. Usually, a key can be issued within one business day, after the verification of your personal data has been
completed.

Entering your Key(s)

After the installation process you will be prompted to enter your Authorization Key. If you click Yes the MT Secu-
rity Settings dialog will be launched automatically, allowing the Key or Keys to be entered immediately. If you
choose not to enter your Key at this point you can do so later by choosing one of the following procedures:

1. Double-click the file YourPersonalKeyXXXXX.mtk. This is attached to the email containing your Key(s).

2. Open the MT Security Settings Control Panel
(Windows Task Bar Start > Control Panel > MT Security Settings),
click the Import Key button and browse for your Key file called

YourPersonalKeyXXXXX.mtk

3. Open the MT Security Settings Control Panel (as above), in the Registration section select the board num-
ber corresponding to the serial number for your Keys or HASP Key for a dongle, click the Enter Key button
and type your User Name, Company Name and Key then click OK. Repeat this step for each Keys listed in the
email.

Changing or re-entering a Key
Should you need to subsequently change or re-enter a Key, follow the appropriate option above.
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First launch

Starting Ovation

By default the Installer will put Ovation into the Programs folder. It also places a shortcut icon on the Windows

D

desktop.

Oreakion

Double-click on the Ovation desktop icon to launch Ovation.
Alternately, choose Start > All Programs > Ovation > Ovation.

This Ovation Guide is available from within Ovation and may be accessed via the Help menu or by pressing F1, or
online at merging.com

Security Keys
The first time Ovation is launched, you will need to enter in your special Key to enable the program properly
(Please see: Enabling Ovation with your Software Key on page 191).

The Pyramix Settings dialog window brings together all Pyramix settings. You will find detailed information
about individual pages in the Pyramix User Manual.

The left-hand side of the window shows all available settings grouped in folders. Folders can be collapsed or
expanded by clicking on the folder icons. By default, all folders are open, displaying the Settings pages they con-
tain by name. Clicking on a settings page opens it in the right-hand side of the window for viewing and editing.
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Audio File Support

Quicktime Support

In order to enable the Quicktime handler you will need to purchase and install Quicktime Pro from Apple.

http://www.apple.com/quicktime/pro/

Compressed Audio File Formats

Codecs

Ovation supports many compressed file formats, including MP3 and AAC, directly. Other compressed formats are
supported via Windows DirectShow technology.

MP3 and AAC

Ovation supports MP3 and AAC directly. (Requires the optional Advanced Audio Codec Support key.) No sepa-
rate codec installation is required and no decompressed file is generated.

FLAC

FLAC encoding and decoding is supported directly. No separate codec installation or key is required and no
decompressed file is generated.

Ogg-Vorbis
Ogg-Vorbis encoding and decoding is supported natively. No separate codec installation or key is required and no
decompressed file is generated.

How Compressed Audio Support Works

‘AMERGING

Technology

The decompression is handled via Microsoft DirectShow technology. So the formats supported will depend on
which DirectShow codecs are installed. Default Windows installation should handle most of the common com-
pressed file formats (wma, mp3 and more), but a wide variety of codecs exist to support all the major compressed
formats (such as ogg-vorbis, flac, etc.).

If you experience problems with the default Widows Installation or if you are in need of specific Codec, Merging
has a list of recommended third-party codecs available.

For more details please refer to the Merging Forum Pyramix Troubleshooting & Tips section

http://forum.merging.com/viewforum.php?f=16

To enable sample accurate editing, the compressed files are first decompressed into a cache file. The file is format-
ted as follows:

originalFileName__DXC(tag)DCX_.wav

This file is a plain wav file.

Ovation Setup

First, set up the Default decompression cache optionsin :

Settings > Application > General > Media Manager > Other settings and click on Decompression Settings to
open the Decompress files... dialog.
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Here you specify where the media should be decompressed to when no Mounting Rules are specified :

‘AMERGING

]

{+ Locally (by the original).
" Subdocally {by the original, in a WMTDXCache sub folder).

{" Custom (files are generated to the spedfied location).

Decompress files... dialog
Locally (by the original) File(s) will be created in the same location as the original file.

Sub-locally (by the original, in a \MTDXCache sub folder). File(s) will be created in a sub folder created by Pyra-
mix in the same location as the original file.

Custom (files are generated to the specified location). File(s) will be created in a user specified location. When
this option is selected the Browse... button is available to open a file browser window to set the user defined path.

Mounting Rules

In addition to the general settings, Mounting Rules can be created to override the Default decompression cache
settings for a specific Mounting location:

Spedal rules for cache file decompression: [v Enable
{* decompress locally (by the original) [v Allow cache files mounting
" decompress subdocally (in a WMTDXCache subfolder)

(" decompressin a custom folder:

e

Mounting Rules dialog decompression rules section

Special rules for cache file decompression

Locally (by the original) File(s) will be created in the same location as the original file.

Sub-locally (by the original, in a \MTDXCache sub folder). File(s) will be created in a sub folder created by Pyra-
mix in the same location as the original file.

Custom (files are generated to the specified location). File(s) will be created in a user specified location. When
this option is selected the Browse... button is available to open a file browser window to set the user defined path.

Enable enables the rule.

Allow cache files mounting when ticked cache files can be mounted directly, otherwise they remain invisible.
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Default Keyboard Shortcuts

Keyboard Shortcuts

Note: The Fire Command now acts like Double-Click when in Show Edit Mode and is

mapped by default to the Space key. So:

Show

New Show
Open Show
Save Show

Save Show As

Init Show
Start Show
Pause Show

Stop Show

Consolidate Show

View Show Properties
View Show Validator

View Show Log

View Show Control Toolbar
View Audition Toolbar
View Active Cue Window

View Audio Control

Exit

Cue List
New Standard Cue List

New Timed Cue List
New Hot Keys

New Custom Keys
New Browser

New Hot Browser

Open Cue List

Save Cue List As

Keyboard Shortcuts : Default Keyboard Shortcuts

§ In Edit Mode, Space toggles Audition / Stop.

§  In Show Mode, Space always Fires the Cue.

CTRL+N
CTRL+O
CTRL+S
CTRL+A

F1
F2
F3
F4

SHIFT +P

CTRL+Q

CTRL + SHIFT + N

CTRL + SHIFT +B

CTRL + SHIFT+ O
CTRL + SHIFT + A

§ In Show Mode, Enter calls Fire Sequenced Cue ! (Fire and select Next).
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Close Cue List

Fire & Start
Start
Pause

Stop

Chase

Toggle/Select Cue List
Toggle/Select Hot Key list
Select Specific Cue List

CTRL + SHIFT +C
F5

Fé6

Shift + F7, F7
Shift + F8, F8

TAB

CTRL + Corresponding Hot Key (01 - 48) (Either on PC

keyboard or Hardware Remote)

View Cue List Properties

View Fire Toolbar
View Edit Toolbar

Custom Keys Design Mode
Snap all Keys on Grid
Reset all Keys Position

Reset all Keys Size and Position

Cue
Undo

Cut

Copy
Paste

Add Empty Cue

Load MTinterChange XML
Load Audio File

Load MIDI File

Remove

Edit

Replace Audio Media
Audition

Audition Start
Audition Rewind
Audition Stop
Audition Play/Pause
Audition Fast-Forward
Audition End

CTRL + SHIFT + P

Ctrl + Shift + E

Ctrl+Z

CTRL +X
CTRL+C
CTRL +V

Insert

Delete
Ctrl+E

Ctrl + Space, Ctrl + D

Ctrl + Shift + F11, Ctrl + F11
Ctrl + F9, Ctrl + Shift + F9
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Audition Review Start

Audition Review End

Audition Jump Forward 1

Audition Jump Forward 2

Audition Jump Forward 3

Audition Jump Back 1
Audition Jump Back 2
Audition Jump Back 3

Move Down
Move Up
Nest

Unnest

Edit Cue Rules
Edit Audio Gain

View Cue Properties

Fire
Fire Sequenced Cue!

Previous Scene
Next Scene
Previous Cue
Next Cue

Fire Cue
Pause Cue
Stop Cue
Stop All Cues

Hot Key 01
Hot Key 02
Hot Key 03
Hot Key 04
Hot Key 05
Hot Key 06
Hot Key 07
Hot Key 08
Hot Key 09
Hot Key 10
Hot Key 11
Continues to:-
Hot Key 48 (Down)

(Down)
(Down)
(Down)
(Down)
(Down)
(Down)
(Down)
(Down)
(Down)
(Down)

(Down)

Ctrl + Right

Ctrl + Shift + Right

Ctrl + Shift + Alt + Right
Ctrl + Left

Ctrl + Shift + Left

Ctrl + Shift + Alt + Left

Ctrl + Down

Ctrl + Up

Ctrl + Alt + Right
Ctrl + Alt + Left

Ctrl +R
Ctrl+ G

Ctrl+P

Enter

Left
Right
Up

Down

Space, Shift + F9, F9
Shift + F10, F10
Shift+F11,F11

© VW 00 N OO 1 A W N =

Keyboard Shortcuts : Default Keyboard Shortcuts
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Hot Key 01 (Up)
Hot Key 02 (Up)
Hot Key 03 (Up)
Hot Key 04 (Up)
Hot Key 05 (Up)
Hot Key 06 (Up)
Hot Key 07 (Up)
Hot Key 08 (Up)
Hot Key 09 (Up)
Hot Key 10 (Up)
Hot Key 11 (Up)

Continues to:

© VW 00 N OO 1 A W N =

Hot Key 48 (Up)

Trimmer
Nudge Cue In Less

Nudge Cue In More
Nudge Cue Out Less
Nudge Cue Out More

Nudge Fade In Less
Nudge Fade In More
Nudge Fade Out Less
Nudge Fade Out More

Nudge Cursor Less

Nudge Cursor More

Snap In To Cursor

Nudge Out To Cursor

Audition Review Start

Audition Review End

View

View Show Properties Shift + P
View Show Validator

View Show Log

View Show Control Toolbar

View Cue List Properties Ctrl + Shift + P
View Cue List Fire Toolbar
View Cue List Edit Toolbar
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View Cue Properties Ctrl +P

View Audition Toolbar

View Active Cue Window

View Mixer Alt+ M
View Touch Controller Alt+C

Settings

Settings Alt+G

Keyboard Shortcuts Ctrl + K
Help

User Manual Ctrl+H

Custom Keyboard Shortcuts

‘AMERGING

We strongly encourage you to learn the default Ovation keyboard shortcuts. However, if you wish to create your

own Keyboard Shortcuts for Ovation functions this is how to do it.

To define your own Keyboard Shortcuts:

Keyboard Shortcuts : Custom Keyboard Shortcuts
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1. Choose Settings > Keyboard Shortcuts. This opens the Keyboard Shortcuts window.

TS
Coeremands {Double -didk on a Command, Press a Key combination and Cldk 'Assign’) Assigned Keys
Cue Lest | Qo Fre Tromimesr | Vilw Settrgs | Help
Cormmands Assianed Keys
Mew Show CTRL +M
& Open Show CTRL +0
& 5ave Show CTRL +5
Save Show As CTRL + A
Close Show
+ Init Show Fi
b Start Show F2
1l Pause Show F3
B Stop Show Fi
Priess new shorbout key

(B Consobdate Show

[#] View Show Propertes SHIFT +P
(] view Show ¥aldator

[=] View Show Log

m View Show Control Tookbar

CTRL + SHIFT + ALT +

o | Mo Repeat

Accept Extra Modifiers

Assipned Modifiers
M View Audibon Tookar
CTRL
E=) View Actve Cue Window SHIFT
@ View Audo Control ALT
I -
Exit CTRL +Q | Resctd
|
Press new modifier
- = v| [ LosdTame | [ ExportTanie
Presets | v|| ssvepreset || peletepreset | | saversbe || ResetTabe | | ome

Ovation Keyboard Shortcuts dialog
2. All menu Commands are grouped together into Tabs within this window. Select the Tab with whichever
group of Command Functions you wish to add or change key assignments for.
3. Click on the appropriate Command so that it is highlighted.
4. Clickin the Press new shortcut key box. The cursor will become a blinking bar.

5. Now press the desired Key or combination of Key and modifier (e.g. the Ctrl, Shift, Alt, etc.). These will appear
in the Press new shortcut key box. Note that Pyramix will warn you if the chosen Key or combination is
already assigned to another function.

6. Click the Assign button.
7. Continue assigning Keys to Commands until you are satisfied.

8. Any set of user defined Keyboard Shortcuts can be saved as a Preset. To do so, click the Save Preset button,
then name the Preset. Similarly, to recall a previously saved Preset, click in the Presets box and select it from
the pop-up list. Note that several common Presets are shipped with Ovation.The Table will be saved in the
system for the user currently logged in and will not affect any other user.

9. Atable can be Saved or Loaded to a file so it can be taken to an other system. Just Click on the Save Table or
Load Table button.

10

A table can be exported as a Text File along with some comments about commands. This is very useful since it
enables you to print it as a command reference guide with your own keyboard shortcuts.
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Advanced Features

Multiple Ovation Sequencers for Redundancy

Mirror All Commands to Remote Ovation Sequencers

he Mirror All Commands to Remote Ovation Sequencers setting can be found in Settings > Application Set-
tings > Controller > Remote Controlled Ovations. When enabled (ticked) this option ensures that all commands
issued by the local Ovation Sequencer with the mouse, keyboard shortcuts or touch screen (l.e. NOT with a hard-
ware controller) are also sent to all the Remote Ovation Sequencers defined in the Controller Settings. This enables
total redundancy to be achieved with another Ovation Sequencer running the same show on another machine on
the network. If two machines on the network enable this option and both define the other one in their own Con-
troller Settings > Remote Ovation Sequencers list, then either or both user interfaces can be operated during
the Show and each Sequencer will be a mirror of the other. Multiple mirrors can be defined.

Remote Players and Controllers

Ovation Players
Apart from the main Ovation application a smaller application, the OVPlayer is also included in the package.

In most circumstances Ovation will either operate stand-alone or networked with other machines running further
full iterations of Ovation. However, it is possible to have one master Ovation sequencer with one or more Ovation
Players running on remote, networked machines. In this case one Ovation sequencer is the master and controls
the others.

Ovation Controllers
Similar to the OVPlayer, OV Controllers can be run on remote machines. OV Controllers enable Ovation to be con-
trolled by commands from external devices.

OV Player

The OV Player module is the mechanism for interpreting Ovation Sequencer instructions and playing back the
correct Media files and outputting control protocols at the right time from local or network storage.

In Show Mode an OV Player on a networked PC or indeed several PCs running OV Player can be controlled by a
single Ovation module. This powerful feature enables highly complex scenarios to be developed.

Each Cue List and indeed each individual Cue can have different Default Output Players defined which then
override the Show defaults.

Only one OV Player can be running on any one machine at one time. The OV Player on the machine running the
Ovation Show is part of the Ovation Sequencer. The separate OV Player application is provided for use on slave
Player Machines.

OV Player Files

OV Player files store player set-ups including audio mixer settings and have a .ovp file extension.
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OV Player User Interface
Main Screen

When an OV Player is launched its Main window opens together with the audio Mixer window used most recently.

"_'_'J.u Cine.ovp - OWPlayer

Session View  Help

D& B ET m

Ready

OV Player main Window
Note: The OV Player can be set to start minimized in the View menu.
OV Player Buttons and Toolbars

Fl%
_ OV Logo button. Clicking on this drops down the Main window control menu:

Py
o

o=

Move

Size |
= Minirize
O M™aximize

¥ Close Alt+F4

OV Player Window Control Menu

Controls are standard Windows items. At top right the three circular buttons are, from Left to Right:

Minimize Minimizes Main OV Player Window and the Mixer window (If open) to the Taskbar.

Maximize / Restore Toggles between Maximizing the Main OV Player Window and Restoring it to the
size and position it occupied prior to being minimized / maximized
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Close Opens the Exit OV Player dialog

Exit OVPlayer o

|9I Really want to exit OVPlayer

[ QK | | Cancel |

Exit OV Player dialog
Click on OK to close the OV Player or Cancel to exit the dialog without closing OV Player.

Toolbars

All toolbars including the Menu toolbar can be made floating by clicking to the left of the first entry until the cur-
sor changes to Move 4—|:—> and dragging to a new location. If a floating Toolbar is dragged close to the edge of the
Main Window it will snap to a docked configuration.

D Be

OV Player Toolbar

& Opens a new, Untitled OV Player Session

& Opens the Open Windows File Browser to enable an existing Session to be loaded
= Saves the current Session. If this is Untitled, opens the Save As file browser

i Toggles the Mixer window open / closed

Opens the OV Player Settings Window

7%

Opens the About OV Player window (Will later also open this Guide)

OV Player Menus

Session  Wiew  Help
OV Player Menus
Clicking on Session, View or Help drops down the respective menu

Session

Session
[ Hew
= Open...

[l Save

Save As...

Recent Sessions 3 1 Second

Exit 2 First One

OV Player Session Menu
New Ctrl+NOpens a new, Untitled OV Player Session
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Open Ctrl+OO0pens the Open Windows File Browser to enable an existing Session to be

loaded
Save Ctrl+S Saves the current Session. If this is Untitled, opens the Save As file browser
Save As... Opens the Save As file browser
Recent Sessions Drops down a list of recently opened Sessions
Exit Quits the OV Player application
View
Run Minimized
S Mocer
V0 Status
Settings
OV Player View Menu
Run Minimized When ticked OV Player will subsequently open minimized in the Task Bar
Mixer Toggles the Mixer window open / closed
View Player 1/O Status Toggle OV Player I/0 Status window show/hide
Settings Opens the OV Player Settings Window

Note: This is a restricted version of the Settings window accessible from the Ovation
Sequencer Settings menu.

Help
Help
1% About OVPlayer...
OV Player Help Menu
al Opens the About OV Player window
OV Controller

This application module handles Ovation MIDI and GPI remote control inputs. l.e. control OF the Ovation
sequencer(s) by external devices.

Exactly like the OVPlayer application it can be run on a remote computer.

Only one OV Controller can be running on an any one machine at one time.
Note: OVControllers control Ovation Sequencers which in turn can control remote
OVPlayers.

OV Controller Files

OV Controller files store controller set-ups and have a .ovc file extension.
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OV Controller User Interface
Main Screen

When an OV Controller is launched its Main window opens: .

(1 First.ove - OWController

Session  View  Help

0D BET m

Ready

OV Controller main Window

Note: The OV Controller can be set to start minimized in the Controller View menu.

OV Controller Buttons and Toolbars

Fl%
_ OV Logo button. Clicking on this drops down the Main window control menu:

Py
s’

o=

Mave

Size |
= Minimize
O Maximize

¥ Close Alt+F4

OV Controller Window Control Menu

Controls are standard Windows items. At top right the three circular buttons are, from Left to Right:

Minimize Minimizes Main OV Controller Window to the Taskbar.

Maximize / Restore Toggles between Maximizing the Main OV Controller Window and Restoring it to
the size and position it occupied prior to being minimized / maximized

‘ Advanced Features : Remote Players and Controllers Page 205
ANVIERGING



vation

MEDIA SERVER & SEQUENCER

Close Opens the Exit OV Controller dialog

Exit OV Controller

Iel Really want to exit OVController ?

[ QK | | Cancel |

Exit OV Controller dialog
Click on OK to close the OV Controller or Cancel to exit the dialog without closing OV Controller.

Toolbars

All toolbars including the Menu toolbar can be made floating by clicking to the left of the first entry until the cur-
sor changes to Move H:—b and dragging to a new location. If a floating Toolbar is dragged close to the edge of the
Main Window it will snap to a docked configuration.

O & & BE] m

OV Controller Toolbar

O Opens a new, Untitled OV Controller Session

= Opens the Open Windows File Browser to enable an existing Session to be loaded
(= Saves the current Session. If this is Untitled, opens the Save As file browser

I Opens the Touch Controller window

Opens the OV Controller Settings Window

Al Opens the About OV Controller window

OV Controller Menus

Session Wieww  Help
OV Controller Menus
Clicking on Session, View or Help drops down the respective menu

Session
Session
[ Hew
(= Open...
& Save
Save As...
Recent Sessions 3 1 Lake
Exit 2 Parade 1
OV Controller Session Menu
New Ctrl+NOpens a new, Untitled OV Controller Session
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Open Ctrl+OO0pens the Open Windows File Browser to enable an existing Session to be
loaded

Save Ctrl+S Saves the current Session. If this is Untitled, opens the Save As file browser

Save As... Opens the Save As file browser

Recent Sessions Drops down a list of recently opened Sessions

Exit Quits the OV Player application

View

View

Run Minimized

PB Touch Controller
Settings

OV Controller View Menu

Run Minimized When ticked OV Controller will subsequently open minimized in the Task Bar
Touch Controller Toggles the Touch Controller window open / closed
Settings Opens the OV Controller Settings Window

Note: This is a restricted version of the Settings window accessible from the Ovation
Sequencer Settings menu.

Help
£1% About OV Controller. ..
OV Controller Help Menu
™

Opens the About OV Controller window
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Appendix |

OVController Commands

‘AMERGING

Ovation can be remote controlled in two ways:

. As a Media Sequencer: All features available in the user interface are remote controllable the same
manner they are operated manually with the mouse from within the application. It’s equivalent as
remote controlling each buttons of the user interface.

. As a Media Server: All Cues and Cue Lists can be remote controlled independently given their Cue
List Number and/or Cue Number or Index. It's equivalent as remote controlling a pool of media inde-
pendently of the Ovation user interface.

- Both modes can be used at the same time. A remote controller can send some Media Sequencer com-
mands and some Media Server commands anytime and transparently.

- The charts in following pages show all available commands in both modes.

Appendix Il on page 213 gives details on the Ovation Keyboard Commands mapping
Appendix lll on page 216 gives details on MIDI / Midi Show Control Commands mapping
Appendix IV on page 224 gives details on DMX Commands mapping

Appendix V on page 225 gives details on GPI Commands mapping
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Media Sequencer Mode available Commands:
Note: If the tables are difficult to read please zoom in.

Ovation Media Sequencer
Commands Parameter 1 Parameter 2 Parameter 3 Parameter 4

CueFire
CueFireSequenced
CuePause
CueStop
CueStopAll

CueHotPress Down=1/Up=0

CueAudition
CueAuditionStart
CueAuditionRewind
CueAuditionStop
CueAuditionPlayPause
CueAuditionFastForward
CueAuditionEnd
CueAuditionReviewStart
CueAuditionReviewEnd
CueBrowse

CueSelect Cue # ** Cue Sub#1 ** Cue Sub#2 ** Cue Sub#3 **
CueSelectNext
CueSelectPrev
CueSelectNextScene
CueSelectPrevScene

CuelListSelect Cue List # *
CuelListSelectNext
CuelListSelectPrev
CuelistSelectToggle

HotCuelListSelect Cue List #*
HotCueListSelectNext
HotCueListSelectPrev
HotCueListSelectToggle

CuelListFireStart
CuelListStart
CuelListPause
CuelistStop
CuelListChase On=1/0ff=0
CuelListChaseToggle

Showlnit
ShowsStart
ShowPause
ShowsStop
ShowReset

OK
Cancel

SendModifierKey Modifier Key Code *** Down=1/Up=0
SendVirtualKey Virtual Key Code **** Down=1/Up=0

Undo
Cut
Copy
Paste
Save

SetMasterOutputGain Gain
MuteMasterOutput Mute =1/ Unmute =0
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* CuelList #

* Cue #

*** Modifier Key:

** Virtual Keys:

Parameters details:

Cue List Number as displayed in the Ovation Sequencer

If Cue Sub#1 equals OVCUEINDEX (-2) then Cue # is the Cue index in its Cue List
Otherwise the Cue is identified with up to 3 nested levels using :

Cuet#, Sub#1, Sub#2 and Sub#3.

Example: 1.1.2 or 3.4.2.5

Note: 1.2.0.0 = 1.2.-1.-1 = 1.2

OVCCMK_CONTROL 1
OVCCMK_SHIFT 2
OVCCMK_ALT 3

OVCCMK_FADE 2 (= OVCCMK_SHIFT)
OVCCMK_RESET_PL4
OVCCMK_PLAY_STC5
OVCCMK_PLAY_PAL 6
OVCCMK_PLAY_DEF7
OVCCMK_PLAY_DEF 8

Any valid Windows Virtual Key Code

Appendix | : OVController Commands
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Media Server Mode available Commands:

Ovation Media Server Cuelist / Cue Identification Parameters Command Timing Parameters Generic Parameters
Commands
Cuelist Cue CueSub CueSub CueSub Progress
# # #1 #2 #3 Time TimeOffset Fade  Offset Boolean Integer Floating Point String

CueAddAudio
CueAddVideo

Audio Output Slot Audio Gain PathName URL
PathName URL]

Cueload
CueUnload
CueMakeReady
CueFire
CueFireSequenced
CuePause
CueStop
CueStopAll
CueDim

CueUnDim

X X Fade In X

X X Fade Out
X X Fade Out

XXX X XXX XX
XXX X XXX XX
XXX X XXX XX
XXX X XXX XX

X X Fade Out
X X Fade In

CueHotPress Pressed=1/Released=0

CueAudition
CueAuditionStart
CueAuditionRewind
CueAuditionStop
CueAuditionPlayPause
CueAuditionFastForward
CueAuditionEnd
CueAuditionReviewStart
CueAuditionReviewEnd
CueBrowse

X X XXX XXXXXX X XX
X X XXX XXXXXX X XX
X X XXX XXXXXX X XX
X X XXX XXXXXX X XX

CueSelect
CueSelectNext
CueSelectPrev
CueSelectNextScene
CueSelectPrevScene

XXXXXX XXXXXXXXXX X XX XXXXXXX XX

CuelistSelect
CuelListSelectNext
CuelistSelectPrev
CuelListSelectToggle

HotCuelListSelect X
HotCuelListSelectNext
HotCuelListSelectPrev
HotCuelListSelectToggle

CuelistFireStart
CuelistStart
CuelListPause
CuelListStop
CuelListSetTime
CuelListChase
CuelListChaseToggle

Chase Enabled = 1

XX X X X X X

Showlnit
ShowsStart
ShowPause
ShowStop
ShowReset

OK
Cancel

SendModifierKey Pressed=1/Released=0 Modifier Key Code
SendVirtualKey Pressed=1/Released=0 Virtual Key Code

Undo
Cut
Copy
Paste
Save

SetMasterOutputGain Gain
MuteMasterOutput Mute = 1/ Unmute = 0
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Cuelist #

Cue #

Time

TimeOffset

Fade

ProgressOffset

Virtual Key Code:

Modifier Key Code:

Parameters Explanation:

If CuelList # equals OVSELECTED (-1) then the currently selected
Cuelist in the Sequencer is used for the command
Otherwise the Cue List Number as displayed in the Ovation Sequencer

If Cue # equals OVSELECTED (-1) then the currently selected Cue in the Sequencer is used for the command
If Cue Sub#1 equals OVCUEINDEX (-2) then Cue # is the Cue index in its Cue List

Otherwise the Cue is identified with up to 3 nested levels using Cue#, Sub#1, Sub#2 and Sub#3.

Example: 1.1.2 or 3.4.2.5

Note: 1.2.0.0 = 1.2.-1.-1 = 1.2

Absolute Time when the Command will be executed.

This Time relates to the Show Time. (OV_INVALID_TIME means as soon as possible)

Relative Time when the Command will be executed counting from when the command is issued
(OV_INVALID_TIME means no offset)

Fade Time (OV_INVALID_TIME means the Fade Time defined in the Sequencer is used)

Time from the beginning of the Cue to start playing the Cue when Fired
(OV_INVALID_TIME means the Cue starts from its beginning)

OVCCMK_CONTROL 1
OVCCMK_SHIFT

OVCCMK_ALT

OVCCMK_FADE 2 (= OVCCMK_SHIFT)
OVCCMK_RESET_PLAY 4
OVCCMK_PLAY_STOP 5
OVCCMK_PLAY_PAUSE 6

OVCCMK_PLAY_DEPRESS_ST 7
OVCCMK_PLAY_DEPRESS_PA 8

Any valid Windows Virtual Key Code

‘AMERGING
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The Ovation Keyboard Controller Commands Map

Keyboard Layout

Standard - General Purpose Mapping

Fire
Cue List

Start
Cue: List

Pause
Cue List

Erop
Cue List

Appendix Il : The Ovation Keyboard Controller Commands Map
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Hot Keys Only Mapping

Play ¢ Play 7
Step P

Note: The Ovation Keyboard does not map any Media Server Mode specific Commands.

Note: The keyboard keys can be changed easily with the key caps removal tool provided
with the keyboard. All the key caps required for both keyboard layouts are supplied with

the keyboard.

Changing Keyboard Mapping

To change the keyboard mapping between General Purpose and Hotkeys go to:
Settings > Application > Controller Units > Proprietary > OVKeyboard

Make sure that the Enable checkbox is ticked and choose the appropriate mapping with the radio buttons.
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Ovation Keyboard Commands mapping

Owvation Media
Sequencer
Connmands

CueFire
CueFireSequenced
CuePause
CueStop
CueStopAll

CueHotPress

CueAudition
CueAuditionStart
CueAuditionRe wind
CueAuditionStop
CueAuditionPlayPause
CueAuditionFastForward
CueAuditionEnd
CueAuditionReviewStart
CueAuditionReviewEnd
CueBrowse

CueSelect
CuesSelectlHext
CueSelectPrev
CuesSelectHextScene
CueSelectPrevScene

CueListSelect
CueListSelectHext
CueListSelectPrev
CueListSelectToggle

HotCueListSelect
HotCueListSelectHext
HotCueListSelectPrev
HotCueListSelectTogale

CueListFiresStart
CueListStart
CueListPause
CueListStop
CueListChase
CueListChaseToggle

Showlinit
ShowStart
ShowPause
ShowStop
ShowReset

OK
Cancel

SendModifierKey
SendVirtualkey

Undo
it
Copy
Paste
Save

SetMasterOwumtputGain
MuteMasterGutput

Mapped on
Standard
Keyboard

11043

Mo
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes

Mo

Mo
Yes
Yes
Yes
Yes

Mo

Mo

Mo
Yes

Mo

Mo

Mo
Yes

Yes
Yes
Yes
Yes
Mo
Mo

Yes
Yes
Yes
Yes
Mo

Yes
Yes

Yes
Mo

Mo
Yes
Yes
Yes
Yes

Mo

Mapped on
HotKeys
Keyhoard

250 Elems UEE B

110 43

Mo
Mo
Yes
Mo
Yes
Yes
Mo
Mo
Mo
Mo

Mo
Yes
Yes

Mo

Mo

Mo

Mo

Mo
Yes

Mo

Mo

Mo
Yes

Mo
Mo
Mo
Mo
Mo
Mo

Mo
Mo
Mo
Mo
Mo

Yes
Yes

Yes
Mo

Mo
Mo
Mo
Mo
Mo

Mo
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Buttons
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v [T ™

(T

Fikdldel

Select Cue List

Select Hat Ke

Fire Cue List

Start Cue List
Pause Cue List
Stop Cue List

Feady Show
Start Shosey
Pause Show
Stop Shoey

(0]
Cancel

[ Playy Reset  |Play Stop | Play Pause |Play Stop | Play Pause [Fade |

Cut
Copy
Paste
Save
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Appendix Il

MIDI and Midi Show Control

Midi Show Control Media Sequencer Mode Commands Mapping

Ovation Media Sequencer Commands MCS Command Cmd Param (Dec) | Cmd Param (Hex) Comments
CueFire Fire 8 8
CueFireSequenced Fire 9 9
CuePause Fire 10 A
CueStop Fire 11 B
CueStopAll Fire 12 C
CueHotPress Fire 48-95 30-5F Even : Down - Odd : Up
CueAudition Fire 32 20
CueAuditionStart Fire 33 21
CueAuditionRewind Fire 34 22
CueAuditionStop Fire 35 23
CueAuditionPlayPause Fire 36 24
CueAuditionFastForward Fire 37 25
CueAuditionEnd Fire 38 26
CueAuditionReviewStart Fire 39 27
CueAuditionReviewEnd Fire 40 28
CueBrowse Fire 41 29
CueSelect

CueSelectNext Fire 42 2A
CueSelectPrev Fire 43 2B
CueSelectNextScene Fire 44 2C
CueSelectPrevScene Fire 45 2E
CuelListSelect Fire

CuelListSelectNext Fire 17 11
CuelListSelectPrev Fire 18 12
CuelListSelectToggle Fire 19 13
HotCueListSelect Fire

HotCueListSelectNext Fire 22 16
HotCueListSelectPrev Fire 23 17
HotCueListSelectToggle Fire 24 18
CuelListFireStart Fire 26 1A
CuelistStart Fire 27 1B
CuelListPause Fire 28 1C
CueListStop Fire 29 1D
CuelListChase

CuelListChaseToggle Fire 30 1E
Showlnit Fire 1 1
ShowsStart Fire 2 2
ShowPause Fire S S
ShowStop Fire 4 4
ShowReset Fire 5 5
OK Fire 112 70
Cancel Fire 113 71
SendModifierKey Fire 96-111 60-6F Even : Down - Odd : Up
SendVirtualKey

Undo Fire 114 72
Cut Fire 115 73
Copy Fire 116 74
Paste Fire 117 75
Save Fire 118 76
SetMasterOutputGain

MuteMasterOutput Fire 119-120 7A-7B Mute - Unmute
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Midi Show Control Media Server Mode Commands mapping:

Ovation Media Server Commands MSC Command

CueAddAudio
CueAddVideo

Cueload
CueUnload
CueMakeReady Load

CueFire Go / Timed Go / Resume
CueFireSequenced
CuePause Stop
CueStop Go Off
CueStopAll
CueDim
CueUnDim

CueHotPress

CueAudition
CueAuditionStart
CueAuditionRewind
CueAuditionStop
CueAuditionPlayPause
CueAuditionFastForward
CueAuditionEnd
CueAuditionReviewStart
CueAuditionReviewEnd

CueBrowse

CueSelect

CueSelectNext Standby +
CueSelectPrev Standby -
CueSelectNextScene Sequence +
CueSelectPrevScene Sequence -
CuelistSelect Open Cue List

CuelListSelectNext
CuelistSelectPrev
CuelListSelectToggle

HotCueListSelect
HotCueListSelectNext
HotCuelListSelectPrev
HotCueListSelectToggle

‘AMERGING

CuelListFireStart
CuelistStart
CuelListPause
CuelListStop
CuelListSetTime
CuelListChase
CuelListChaseToggle

Showlnit
ShowsStart
ShowPause
ShowStop
ShowReset

Continued on next page

Go / Jam Clock
Start Clock

Stop Clock

Zero Clock / Set Clock
MTC Chase On / Off

Reset

Appendix Il : MIDI and Midi Show Control
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Ovation Media Server Commands MSC Command

Cancel

SendModifierKey
SendVirtualKey

Undo
Cut
Copy
Paste
Save

SetMasterOutputGain
MuteMasterOutput All Off / Restore

Note: Ovation is compatible with the MSC data specification with the following limita-
tion:

Sub-Cue (Child-Cue) level id is limited to 4
l.e.if 10.4.1.2.8.14 cue data is sent, Ovation will use the 10.4.1.2 cue identifier and Sub
Cue id 8.14 will be ignored

Sub-Cue list level id is limited to 1 all Sub-Cue list id will be ignored
l.e. If 1.2 cue list data is sent, Ovation will use the first cue list identifier. In that case 1

Cue list 0 is not supported

Cue path data is ignored
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General MIDI Media Sequencer Mode Commands Mapping
Note: If the tables are difficult to read please zoom in.

Ovation Media Sequencer Commands

CueFire
CueFireSequenced
CuePause
CueStop
CueStopAll

CueHotPress

CueAudition
CueAuditionStart
CueAuditionRewind
CueAuditionStop
CueAuditionPlayPause
CueAuditionFastForward
CueAuditionEnd
CueAuditionReviewStart
CueAuditionReviewEnd
CueBrowse

CueSelect
CueSelectNext
CueSelectPrev
CueSelectNextScene
CueSelectPrevScene

CuelistSelect
CuelistSelectNext
CuelistSelectPrev
CuelListSelectToggle

HotCueListSelect
HotCueListSelectNext
HotCueListSelectPrev
HotCuelListSelectToggle

CuelistFireStart
CuelistStart
CuelistPause
CuelistStop
CuelListChase
CuelistChaseToggle

Showlnit
ShowsStart
ShowPause
ShowStop
ShowReset

OK
Cancel

SendModifierKey
SendVirtualKey

Undo
Cut
Copy
Paste
Save

SetMasterOutputGain
MuteMasterOutput

Command

Control Change
Control Change
Control Change
Control Change
Control Change

Control Change

Control Change
Control Change
Control Change
Control Change
Control Change
Control Change
Control Change
Control Change
Control Change
Control Change

Control Change
Control Change
Control Change
Control Change
Control Change

Control Change
Control Change
Control Change
Control Change

Control Change
Control Change
Control Change
Control Change

Control Change
Control Change
Control Change
Control Change
Control Change
Control Change

Control Change
Control Change
Control Change
Control Change
Control Change

Control Change
Control Change

Control Change
Control Change

Control Change
Control Change
Control Change
Control Change
Control Change

Control Change
Control Change

Data 1

mappable
mappable
mappable
mappable
mappable

mappable

mappable
mappable
mappable
mappable
mappable
mappable
mappable
mappable
mappable
mappable

mappable
mappable
mappable
mappable
mappable

mappable
mappable
mappable
mappable

mappable
mappable
mappable
mappable

mappable
mappable
mappable
mappable
mappable
mappable

mappable
mappable
mappable
mappable
mappable

mappable
mappable

mappable
mappable

mappable
mappable
mappable
mappable
mappable

mappable
mappable

Data 2

0 = down otherwise up

the Cue #

the Cue List #

the Cue List #

0 = Chase On otherwise Chase Off

The master gain fader position 0 = Mute
0 = Unmute otherwise Mute

Comments

Note: Data 1 is a range of values from 0 to 63
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General MIDI Media Server Mode Commands Mapping

Ovation Media Server Commands GM Command Data 1 Comments

CueAddAudio
CueAddVideo

Cueload
CueUnload
CueMakeReady
CueFire Note On the Cue # depends on the Note On option
CueFireSequenced
CuePause Note Off the Cue # depends on the Note Off and Note On option
CueStop Note Off the Cue # depends on the Note Off and Note On option
CueStopAll
CueDim
CueUnDim

CueHotPress Note On / Note Off the Cue # depends on the Note On option

CueAudition
CueAuditionStart
CueAuditionRewind
CueAuditionStop
CueAuditionPlayPause
CueAuditionFastForward
CueAuditionEnd
CueAuditionReviewStart
CueAuditionReviewEnd
CueBrowse

CueSelect
CueSelectNext
CueSelectPrev
CueSelectNextScene
CueSelectPrevScene

CuelistSelect Program Change the CuelList #
CueListSelectNext
CuelListSelectPrev
CuelistSelectToggle

HotCueListSelect
HotCueListSelectNext
HotCueListSelectPrev
HotCuelListSelectToggle

CuelListFireStart
CuelistStart
CuelListPause
CuelListStop
CuelListSetTime
CuelListChase
CuelListChaseToggle

Showlnit
ShowsStart
ShowPause
ShowStop
ShowReset

OK
Cancel

SendModifierKey
SendVirtualKey

Undo
Cut
Copy
Paste
Save

SetMasterOutputGain
MuteMasterOutput

The MIDI channel is the Cue list Id or is ignored and the Selected Cue List is targeted. An option is available.
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MMC Media Sequencer Commands Mapping

Ovation Media Sequencer Commands MMC Command Cmd (Dec) Cmd (Hex) Comments
CueFire Play / Deferred Play 2,3 2,3

CueFireSequenced

CuePause Pause 9 9

CueStop Stop 1 1

CueStopAll

CueHotPress

CueAudition

CueAuditionStart
CueAuditionRewind
CueAuditionStop
CueAuditionPlayPause
CueAuditionFastForward
CueAuditionEnd
CueAuditionReviewStart
CueAuditionReviewEnd

CueBrowse

CueSelect

CueSelectNext Fast Forward 4 4
CueSelectPrev Rewind 5 5

CueSelectNextScene
CueSelectPrevScene

CuelListSelect

CuelistSelectNext Variable Play 69 45 positive value
CuelistSelectPrev Variable Play 69 45 negative value
CuelListSelectToggle Eject 10 A

HotCueListSelect
HotCueListSelectNext
HotCueListSelectPrev
HotCuelListSelectToggle

CuelListFireStart
CuelistStart
CuelListPause
CuelListStop
CuelListChase
CuelistChaseToggle

Showlnit
ShowsStart
ShowPause
ShowStop
ShowReset

OK
Cancel

SendModifierKey
SendVirtualKey

Undo
Cut
Copy
Paste
Save

SetMasterOutputGain
MuteMasterOutput
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Ovation Media Sequencer Commands Command Data 1 Data 2 Comments
CueFire Control Change | mappable

CueFireSequenced Control Change | mappable

CuePause Control Change | mappable

CueStop Control Change | mappable

CueStopAll Control Change | mappable

CueHotPress Control Change | mappable 0 = down otherwise up
CueAudition Control Change | mappable

CueAuditionStart Control Change | mappable

CueAuditionRewind Control Change | mappable

CueAuditionStop Control Change | mappable

CueAuditionPlayPause Control Change | mappable

CueAuditionFastForward Control Change | mappable

CueAuditionEnd Control Change | mappable

CueAuditionReviewStart Control Change | mappable

CueAuditionReviewEnd Control Change | mappable

CueBrowse Control Change | mappable

CueSelect Control Change | mappable the Cue #
CueSelectNext Control Change | mappable

CueSelectPrev Control Change | mappable

CueSelectNextScene Control Change | mappable

CueSelectPrevScene Control Change | mappable

CuelistSelect Control Change | mappable the Cue List #
CuelistSelectNext Control Change | mappable

CuelistSelectPrev Control Change | mappable

CuelListSelectToggle Control Change | mappable

HotCueListSelect Control Change | mappable the Cue List #
HotCueListSelectNext Control Change | mappable

HotCuelListSelectPrev Control Change | mappable

HotCuelListSelectToggle Control Change | mappable

CuelistFireStart Control Change | mappable

CuelListStart Control Change | mappable

CuelListPause Control Change | mappable

CueListStop Control Change | mappable

CuelListChase Control Change | mappable | 0= Chase On otherwise Chase Off
CuelistChaseToggle Control Change | mappable

Showlnit Control Change | mappable

ShowsStart Control Change | mappable

ShowPause Control Change | mappable

ShowStop Control Change | mappable

ShowReset Control Change | mappable

OK Control Change | mappable

Cancel Control Change | mappable

SendModifierKey Control Change | mappable

SendVirtualKey Control Change | mappable

Undo Control Change | mappable

Cut Control Change | mappable

Copy Control Change | mappable

Paste Control Change | mappable

Save Control Change | mappable

SetMasterOutputGain Control Change | mappable [The master gain fader position 0 = Mutej
MuteMasterOutput Control Change | mappable 0 = Unmute otherwise Mute

Note: Data 1 is a range of values from 0 to 63
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GM Media Server Commands Mapping

Ovation Media Server Commands GM Command Data 1 Comments

CueAddAudio
CueAddVideo

CueLoad
CueUnload
CueMakeReady
CueFire Note On the Cue # depends on the Note On option
CueFireSequenced
CuePause Note Off the Cue # depends on the Note Oft and Note On option
CueStop Note Off the Cue # depends on the Note Oft and Note On option
CueStopAll
CueDim
CueUnDim

CueHotPress Note On / Note Oft the Cue # depends on the Note On option

CueAudition
CueAuditionStart
CueAuditionRewind
CueAuditionStop
CueAuditionPlayPause
CueAuditionFastForward
CueAuditionEnd
CueAuditionReviewStart
CueAuditionReviewEnd
CueBrowse

CueSelect
CueSelectNext
CueSelectPrev
CueSelectNextScene
CueSelectPrevScene

CuelListSelect Program Change | the CueList#
CueListSelectNext
CuelListSelectPrev
CuelListSelectToggle

HotCueListSelect
HotCueListSelectNext
HotCueListSelectPrev
HotCueListSelectToggle

CuelListFireStart
CueListStart
CuelListPause
CuelListStop
CueListSetTime
CueListChase
CueListChaseToggle

Showlnit
ShowStart
ShowPause
ShowStop
ShowReset

OK
Cancel

SendModitierKey
SendVirtualKey

undo
Cut
Copy
Paste
Save

SetMasterOutputGain
MuteMasterOutput

Note: The MIDI channel is the Cue list Id or is ignored and the Selected Cue List is tar-
geted. An option is available.
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DMX Commands

Under Construction
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Appendix V

GPlI Commands

Ovation
Media Server Commands GPI Media Server Mapping
Param 1 Param 2 Param 3 Param 4 Comments
CueAddAudio CueList # Cue # Cue Sub#1l Cue Sub#2
CueAddVideo CueList # Cue # Cue Sub#1l Cue Sub#2
CuelLoad CueList # Cue # Cue Sub#1 Cue Sub#2
CueUnload CueList # Cue # Cue Sub#1l Cue Sub#2
CueMakeReady CueList # Cue # Cue Sub#l Cue Sub#2
CueFire CueList # Cue # Cue Sub#1l Cue Sub#2
CueFireSequenced CueList # Cue # Cue Sub#1l Cue Sub#2
CuePause CueList # Cue # Cue Sub#1l Cue Sub#2
CueStop CueList # Cue # Cue Sub#1 Cue Sub#2
CueStopAll
CueDim CueList # Cue # Cue Sub#1 Cue Sub#2
CueunDim CueList # Cue # Cue Sub#1l Cue Sub#2
CueHotPress CueList # Cue # Cue Sub#1 0= Down otherwise Up
CueAudition CueList # Cue # Cue Sub#1l Cue Sub#2
CueAuditionStart CueList # Cue # Cue Sub#1l Cue Sub#2
CueAuditionRewind CueList # Cue # Cue Sub#l Cue Sub#2
CueAuditionStop CueList # Cue # Cue Sub#1l Cue Sub#2
CueAuditionPlayPause CueList # Cue # Cue Sub#l Cue Sub#2
CueAuditionFastForward CueList # Cue # Cue Sub#1l Cue Sub#2
CueAuditionEnd CueList # Cue # Cue Sub#l Cue Sub#2
CueAuditionReviewStart CueLlist # Cue# Cue Sub#1 Cue Sub#2
CueAuditionReviewEnd CuelLlist # Cue # Cue Sub#1 Cue Sub#2
CueBrowse CueLlist # Cue# Cue Sub#1 Cue Sub#2
CueSelect CueList # Cue # Cue Sub#1 Cue Sub#2
CueSelectNext CueList #
CueSelectPrev CueList #
CueSelectNextScene CueList #
CueSelectPrevScene CueList #
CueListSelect CueList #

CuelListSelectNext
CuelListSelectPrev
CuelListSelectToggle

HotCueListSelect CueList #
HotCueListSelectNext
HotCueListSelectPrev
HotCueListSelectToggle

CuelLlistFireStart CueList # Cue # Cue Sub#1 Cue Sub#2
CuelLlistStart CueList #

CueListPause CueList #

CueListStop CueList #

CueListSetTime CueList #

CueListChase CueList # Chase Off = 0 otherwise Chase On
CuelistChaseToggle CueLlist #

Showlnit

ShowsStart

ShowPause

ShowStop

ShowReset

OK

Cancel

SendModifierKey Modifier Key Code Release=0 otherwise Pressed
SendVirtualKey Virtual Key Code  Release=0 otherwise Pressed
undo

Cut CueList #

Copy CueLlist #

Paste CueList #

Save

SetMasterOutputGain Gain [dB]

MuteMasterOutput Unmute = 0 otherwise Mute
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Parameters Explanation:

Modifier Key Code: OVCCMK_CONTROL
OVCCMK_SHIFT
OVCCMK_ALT

OVCCMK_FADE
OVCCMK_RESET_PLAY
OVCCMK_PLAY_STOP
OVCCMK_PLAY_PAUSE
OVCCMK_PLAY_DEPRESS_STOP
OVCCMK_PLAY_DEPRESS_PAUSE

Virtual Key Code:  Any valid Windows Virtual Key Code

Cuelist # If CuelList # equals OVSELECTED (-1) then the currently selected CuelList in the Sequencer is used for the command
Otherwise the Cue List Number as displayed in the Ovation Sequencer

Cue # If Cue # equals OVSELECTED (-1) then the currently selected Cue in the Sequencer is used for the command

2 (= OVCCMK_SHIFT)
4

o N o o
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Appendix Vi

Mouse Modifier Keys
This table shows the valid modifier keys which can be used in conjunction with some mouse operations

Show Control

Under construction

Hot Key Mode
Click on a Cue Fire Button
Fire Cue following Cue Properties Hot Key Mode None
Fire Cue following inverse of Cue Properties Hot Key Mode Ctrl

(for example Toggle Play / Stop becomes

Press Play / Release Stop)

Force Stop Alt
Add default Fade In and Out Shift
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Appendix VI

Web Server Commands

Please zoom in to view comfortably.

HTTP Media Sequencer Map

Definition of Commands and Parameters for controlling Ovation as a Media Sequencer through HTTP Commands

Ovation Media Sequencer

Commands Command Parameter 2 Parameter 3 Parameter 4 Parameter 5
CueFire <IP>:<Port>/Action?Command=Cue_Fire &Cuelist=<Cuelist> (*) &Cue=<Cue> (*) &Time=<n [ms]> (*) &TimeOffset=<n [ms]> (*)
CueFireSequenced <IP>:<Port>/Action?Command=Cue_FireSequenced &Cuelist=<Cuelist> (*) &Cue=<Cue> (*)

CuePause <IP>:<Port>/Action?Command=Cue_Pause &CuelList=<CuelList> (*) &Cue=<Cue> (*) &Time=<n [ms]> (*) &TimeOffset=<n [ms]> (*)
CueStop <IP>:<Port>/Action?Command=Cue_Stop &Cuelist=<CuelList> (*) &Cue=<Cue> (*) &Time=<n [ms]> (*) &TimeOffset=<n [ms]> (*)
CueStopAll <IP>:<Port>/Action?Command=Cue_StopAll

CueHotPress <IP>:<Port>/Action?Command=Cue_HotPress &Cuelist=<Cuelist> (*) &Cue=<Cue> (*) &Pressed=1 or 0

CueAudition <IP>:<Port>/Action?Command=Cue_Audition &Cuelist=<Cuelist> (*) &Cue=<Cue> (*)

CueAuditionStart
CueAuditionRewind
CueAuditionStop
CueAuditionPlayPause
CueAuditionFastForward
CueAuditionEnd
CueAuditionReview Start
CueAuditionReviewEnd
CueBrowse

CueSelect <IP>:<Port>/Action?Command=Cue_Select &Cuelist=<Cuelist> (*) &Cue=<Cue> (*)
CueSelectNext <IP>:<Port>/Action?Command=Cue_Select_Next &Cuelist=<Cuelist> (*)
CueSelectPrev <IP>:<Port>/Action?Command=Cue_Select_Prev &Cuelist=<Cuelist> (*)
CueSelectNextScene <IP>:<Port>/Action?Command=Cue_Select_NextScene &Cuelist=<CuelList> (*)
CueSelectPrevScene <IP>:<Port>/Action?Command=Cue_Select_PrevScene &Cuelist=<Cuelist> (*)
CuelistSelect <IP>:<Port>/Action?Command=Cuelist_Select &Cuelist=<Cuelist> (*)
CuelistSelectNext <IP>:<Port>/Action?Command=Cuelist_Select_Next

CuelListSelectPrev <IP>:<Port>/Action?Command=Cuelist_Select_Prev

CuelListSelectToggle <IP>:<Port>/Action?Command=Cuelist_Select_Toggle

HotCuelListSelect <IP>:<Port>/Action?Command=HotCuelList_Select &Cuelist=<CuelList> (*)
HotCuelistSelectNext <IP>:<Port>/Action?Command=HotCuelList_Select_Next

HotCuelListSelectPrev <IP>:<Port>/Action?Command=HotCuelist_Select_Prev

HotCuelistSelectToggle <IP>:<Port>/Action?Command=HotCuelist_Select_Toggle

CuelListFireStart <IP>:<Port>/Action?Command=Cuelist_FireStart &Cuelist=<Cuelist> (*) &Cue=<Cue> (*)
CuelistStart <IP>:<Port>/Action?Command=Cuelist_Start &Cuelist=<Cuelist> (*)

CuelistPause <IP>:<Port>/Action?Command=Cuelist_Pause &Cuelist=<Cuelist> (*)

CuelistStop <IP>:<Port>/Action?Command=Cuelist_Stop &Cuelist=<CuelList> (*)

CuelListChase <IP>:<Port>/Action?Command=Cuelist_Chase &Cuelist=<CuelList> (*) &ChaseOn=1 or 0
CuelListChaseToggle <IP>:<Port>/Action?Command=Cuelist_ChaseToggle &Cuelist=<CuelList> (*)

CuelistSetTime <IP>:<Port>/Action?Command=Cuelist_SetTime &Cuelist=<Cuelist> (*) &Time=<n [ms]>
Show Init <IP>:<Port>/Action?Command=Show_Init

Show Start <IP>:<Port>/Action?Command=Show_Start

ShowPause <IP>:<Port>/Action?Command=Show_Pause

ShowStop <IP>:<Port>/Action?Command=Show_Stop

ShowReset

oK
Cancel

SendModifierKey
SendVirtualKey

Undo
Cut
Copy
Paste
Save

SetMasterOutputGain <IP>:<Port>/Action?Command=Master_OutputGain &Gain=<n [dB]>
MuteMasterOutput <IP>:<Port>/Action?Command=Master_Mute &Mute=1 or 0

Parameter details:

*) Optional parameter

<IP> IP Address of the machine running the Ovation Sequencer

<Port> Port number as setin the Ovation All Settings > Controller Units > Proprietary > Web Server Page > HTTP Port
<Cuelist> The Cue List Index (0 based, i.e. Cue List Number - 1)

-1 indicates the currently selected Cue List (Default if the <CuelList> parameter is not set)

<Cue> The Cue Number, for example Cue=1.1.2 or Cue=3.4.2.5
-1 indicates the currently selected Cue, for example Cue=-1 (Default if the <Cue> parameter is not set)
-2 in the second sub digit indicates that the first digit is the Cue Index in the Cue Listinstead of the Cue Number, for example Cue=5.-2

Time Absolute Time in [ms] when the Command will be executed. This Time relates to the Show Time.
TimeOffset Relative Time in [ms] when the Command will be executed counting from when the command is issued
Fade Fade Time in [ms]

ProgressOffsetTime Time in [ms] from the beginning of the Cue to start playing the Cue when Fired
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HTTP Media Server Map

Definition of Commands and Parameters for controlling Ovation as a Media Server through HTTP Commands

Ovation
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Ovation Media Sequencer
Commands Command Parameter 2 Parameter 3 Parameter 4 Parameter 5
CueAddAudio <IP>:<Port>/Action?Command=Cue_Fire &Cuelist=<Cuelist> (*) &Cue=<Cue> (*) &Time=<n [ms]> (*) &TimeOffset=<n [ms]> (*)
CueAddVideo
Cueload
CueUnload
CueFire <IP>:<Port>/Action?Command=Cue_Fire &Cuelist=<Cuelist> (*) &Cue=<Cue> (*) &Time=<n [ms]> (*) &TimeOffset=<n [ms]> (*)
CueFireSequenced <IP>:<Port>/Action?Command=Cue_FireSequenced &Cuelist=<CuelList> (*) &Cue=<Cue> (*)
CuePause <IP>:<Port>/Action?Command=Cue_Pause &Cuelist=<Cuelist> (*) &Cue=<Cue> (*) &Time=<n [ms]> (*) &TimeOffset=<n [ms]> (*)
CueStop <IP>:<Port>/Action?Command=Cue_Stop &Cuelist=<Cuelist> (*) &Cue=<Cue> (*) &Time=<n [ms]> (*) &TimeOffset=<n [ms]> (*)
CueStopAll <IP>:<Port>/Action?Command=Cue_StopAll
CueDim <IP>:<Port>/Action?Command=Cue_Dim &Cuelist=<Cuelist> (*) &Cue=<Cue> (*) &Time=<n [ms]> (*) &TimeOffset=<n [ms]> (*)
CueUnDim <IP>:<Port>/Action?Command=Cue_UnDim &Cuelist=<Cuelist> (*) &Cue=<Cue> (*) &Time=<n [ms]> (*) &TimeOffset=<n [ms]> (*)
CueHotPress <IP>:<Port>/Action?Command=Cue_HotPress &Cuelist=<Cuelist> (*) &Cue=<Cue> (*) &Pressed=1 or 0
CueAudition <IP>:<Port>/Action?Command=Cue_Audition &Cuelist=<Cuelist> (*) &Cue=<Cue> (*)
CueAuditionStart
CueAuditionRewind
CueAuditionStop
CueAuditionPlayPause
CueAuditionFastForward
CueAuditionEnd
CueAuditionReview Start
CueAuditionReviewEnd
CueBrowse
CueSelect <IP>:<Port>/Action?Command=Cue_Select &Cuelist=<CuelList> (*) &Cue=<Cue> (*)
CueSelectNext <IP>:<Port>/Action?Command=Cue_Select_Next &Cuelist=<Cuelist> (*)
CueSelectPrev <IP>:<Port>/Action?Command=Cue_Select_Prev &Cuelist=<CuelList> (*)
CueSelectNextScene <IP>:<Port>/Action?Command=Cue_Select_NextScene &Cuelist=<Cuelist> (*)
CueSelectPrevScene <IP>:<Port>/Action?Command=Cue_Select_PrevScene &Cuelist=<CuelList> (*)
CuelistSelect <IP>:<Port>/Action?Command=Cuelist_Select &Cuelist=<CuelList> (*)
CuelListSelectNext <IP>:<Port>/Action?Command=Cuelist_Select_Next
CuelistSelectPrev <IP>:<Port>/Action?Command=Cuelist_Select_Prev
CuelistSelectToggle <IP>:<Port>/Action?Command=Cuelist_Select_Toggle
HotCuelistSelect <IP>:<Port>/Action?Command=HotCuelist_Select &Cuelist=<Cuelist> (*)
HotCuelListSelectNext <IP>:<Port>/Action?Command=HotCuelist_Select_Next
HotCuelListSelectPrev <IP>:<Port>/Action?Command=HotCuelist_Select_Prev
HotCuelListSelectToggle |<IP>:<Port>/Action?Command=HotCuelList_Select_Toggle
CuelistFireStart <IP>:<Port>/Action?Command=Cuelist_FireStart &Cuelist=<CuelList> (*) &Cue=<Cue> (*)
CuelistStart <IP>:<Port>/Action?Command=Cuelist_Start &Cuelist=<Cuelist> (*)
CuelListPause <IP>:<Port>/Action?Command=Cuelist_Pause &Cuelist=<CuelList> (*)
CuelListStop <IP>:<Port>/Action?Command=CuelList_Stop &Cuelist=<Cuelist> (*)
CuelistChase <IP>:<Port>/Action?Command=Cuelist_Chase &Cuelist=<CuelList> (*) &ChaseOn=1 or 0
CuelListChaseToggle <IP>:<Port>/Action?Command=Cuelist_ChaseToggle &Cuelist=<Cuelist> (*)
CuelistSetTime <IP>:<Port>/Action?Command=Cuelist_SetTime &Cuelist=<Cuelist> (*) &Time=<n [ms]>
Show Init <IP>:<Port>/Action?Command=Show_Init
Show Start <IP>:<Port>/Action?Command=Show_Start
ShowPause <IP>:<Port>/Action?Command=Show_Pause
ShowStop <IP>:<Port>/Action?Command=Show_Stop
ShowReset
OK
Cancel
SendModifierKey
SendVirtualKey
Undo
Cut
Copy
Paste
Save
Parameters details:
*) Optional parameter
<Ip> IP Address of the machine running the Ovation Sequencer
<Port> Port number as set in the Ovation All Settings > Controller Units > Proprietary > Web Server Page > HTTP Port
<CuelList> The Cue List Index (0 based, i.e. Cue List Number - 1)
-1 indicates the currently selected Cue List (Default if the <CueList> parameter is not set)
<Cue> The Cue Number, for example Cue=1.1.2 or Cue=3.4.2.5
-1 indicates the currently selected Cue, for example Cue=-1 (Default if the <Cue> parameter is not set)
-2 in the second sub digit indicates that the first digit is the Cue Index in the Cue List instead of the Cue Number, for example Cue=5.-2
Time Absolute Time in [ms] when the Command will be executed. This Time relates to the Show Time.
TimeOffset Relative Time in [ms] when the Command will be executed counting from when the command is issued
Fade, Fadeln, FadeOut Fade Time in [ms]
ProgressOffsetTime Time in [ms] from the beginning of the Cue to start playing the Cue when Fired
PathName URLs or PathNames can optionally be converted with escaped characters (for example White Spaces = %20)
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HTTP Request Response
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Show Request Command:

<IP>:<Port>/Request?Show

JSON Response:

{
Host : "192.168.1.34:888",
Show :
{

Title : "Test.ovs",

PathName : "D:\Projects\Ovation\Test.ovs",
ShowTimeCueFireButtons : 0,

State : "Running",

ShowTime : "00:00:02",

TimeCodes :
[
{
Name : "LTC 1",
Type : "Generator",
TimeCode : "00:01:09:00"
}
{
Name : "MTC 1",
Type : "Source",
TimeCode : "00:00:00:00"
}
1
Cuelists :
[
{
Index : 0,
Name : "Standard Cue List",
Number : "1",
Mode : 0,
HotKeysColumns : -1,
Selected : 1,
HotSelected : 0,
TitleColor : "60e6b4",
Cues :
[
{
}
]
}
{
Index : 1,
Name : "Timed Cue List",
Number : "2",
Mode : 1,
HotKeysColumns : -1,
Selected : 0,
HotSelected : 0,
CuelistTime : "00:00:00",
Chasing : 0,
Running : 0,
Paused : 0,
TitleColor : "000000",
Cues :
[
{
}
]
}
{

Continued on next page:
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Standard Cue List

Index : 0,

Name : "11 Don't Kill It Carol",
Number : "1",

GoTime : "Invalid",

Selected : 1,

Length : "00:06:14",

State : "Ready",
StateBackgroundColor : "a495b2",
StateBorderColor : "a495b2",
Progress : 0, Percent
ProgressCounters : "

Timed Cue List

Index : 0,

Name : "Million Miles From Home",
Number : "1",

GoTime : 00:01:00:000,

Selected : 1,

Length : "00:03:58",

State : "Asleep”,
StateBackgroundColor : "9f9b93",
StateBorderColor : "9f9b93",
Progress : 0, Percent
ProgressCounters : "

Page 230




Ovation

MEDIA SERVER & SEQUENCER

ShowDirty : 1

Index : 2,

Name : "Hot Keys",
Number : "3",

Mode : 2,
HotKeysColumns : -1,
Selected : 0,
HotSelected : 1,
TitleColor : "000000",

Cues :
[
{
}
1
}
{
Index : 3,
Name : "Custom Cue List",
Number : "4",
Mode : 3,
HotKeysColumns : -1,
Selected : 0,
HotSelected : 0,
TitleColor : "000000",
Cues :
[
{
}
]
}

Hot Keys Cue List

Index : 0,
Name : "Trust_Antisocial”,
Number : "1",

GoTime : "Invalid",
HotKeyNumber : 1,
HotRectLeft : 8,
HotRectRight : 207,
HotRectTop : 8,
HotRectBottom : 207,
Selected : 1,

Length : "00:04:32",

State : "Ready",
StateBackgroundColor : "b26f43",
StateBorderColor : "b26f43",
Progress : 0, Percent
ProgressCounters : ""

Custom Keys Cue List

Index : 0,

Name : "19 Banquet",
Number : "3.2",

GoTime : "Invalid",
CustomRectLeft : 60,
CustomRectRight : 360,
CustomRectTop : 40,
CustomRectBottom : 140,
CustomColor : "00cc99",
CustomFont : ",
CustomFontColor : "000000",
Selected : 1,

Length : "00:05:15",

State : "Ready",
StateBackgroundColor : "008e6b",
StateBorderColor : "008e6b",
Progress : 0, Percent
ProgressCounters : ""

Show has changed

meaning that a Show Request
is required when received in a
Cues_Status response
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Cues Status Request Command:

<IP>:<Port>/Request?Cues_Status

JSON Response:

{
Host:"192.168.1.34:888"
Show :
{
}
}

State : "Running",

ShowTime : "00:01:44",

TimeCodes :

[

Cuelists :

ShowDirty : 0

{
Name : "LTC 1",
Type : "Generator",
TimeCode : "00:01:09:00"
}
{
Name : "MTC 1",
Type : "Source”,
TimeCode : "00:00:00:00"
}
{
Index : 0,
: "Standard Cue List",
t1,
Mode : 0,
Selected : 1,
HotSelected : 0,
TitleColor : "60e6b4",
Cues :
[
{
}
1
}
{
Index : 1,
:"Timed Cue List",
12,
01,
Selected : 0,
HotSelected : 0,
CuelistTime : "00:00:00",
Chasing : 0,
Running : 0,
Paused : 0,
TitleColor : "000000",
Cues :
|
}
{
Hot Keys",
1 "3,
Mode : 2,
Selected : 0,
HotSelected : 1,
TitleColor : "000000",
Cues :
|
}
{
Index : 3,
Name : "Custom Cue List",
Number : "4",
Mode : 3,
Selected : 0,
HotSelected : 0,
TitleColor : "000000",
Cues :
j
}

Comments

Index : 0,

Selected : 1,

Length : "00:06:14",

State : "Playing",

StateBackgroundColor : "45b259",
StateBorderColor : "45b259",

Progress : 6, Percent

ProgressCounters : "00:00:23 - 00:05:50"
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A
AAC 193
Active Cue

Show Mode 81
Show Mode With Merged Toolbars 82
Active Cue Window 76
83
Compose Mode 76
Cue Trimmer 79
Locked Mode 78
Pinned Mode 76
Review while trimming 80
Show Mode 81
Trim In/Out Audition Timings 157
Trim with the Mouse 80
Advanced Features 201
Appendix 1 208
Appendix |
OVController Commands 208
Appendix Il
Keyboard Controller Commands Map 213
Appendix Il The Ovation Keyboard OVController Com-
mands Map 213
Appendix I
MIDI and Midi Show Control Commands Mapping 216
Appendix Il MIDI and Midi Show Control OVController
Commands Map 216
Appendix IV
DMX Commands 224
Appendix IV DMX Commands 224
Appendix V
GPI Commands 225
Appendix V GPI Commands 225
Appendix VI
Mouse Modifier Key 227
Application Delay Launch 91
Application Settings 153
General 153
Archive 119
Audio 29
Audio Bridge 56
Audio Connections 188
Audio Control 120
Audio Control Pane 120
Audio File Support 193
Audio Formats Supported 12
Audio Gain Matrix 125
Audio Output Slots 124
Audio Syncronization 141
Audition 32
Player Settings 156
Selected Cue 32
Audition Drop-down 68
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Audition Jump 33, 67
Audition Toolbar 67, 80
Auto Start Show 91
Automatic Cue Numbering 95
Automation 29, 52
Apply Snapshot 54
Copy and Paste Snapshot 54
Erase a Snapshot 54
Glide 54
Store a Snapshot 52

B

Backup/Archive 119
BlackMagic video card drivers 190

C

CD Import

Online database of track names 49
CD Tracks

Import 44
CD Tracks Import 47
Changing Keyboard Mapping 214
Changing or re-entering a Key 191
Chase Timed List 27
Codecs 193
Column to Audio Slot Mapping 96
Combined Panes 65
Commands 29
Compose Mode 31
Compound Cues 51
Compressed Audio File Formats 193
Compressed Audio Formats Mounting Rules 194
Compressed Audio Support 193
Compressed Media 155
Computer 186
Conditional Rules 113
Consolidation

Recursive 119

Show 116
Consolidation Process 116
Context Menu

Cue / Cue List 44
Context Menus 61
Control Surfaces 61
Controlled Stations Settings 166
Controller 204

Buttons and Toolbars 205

Menus 206
Controller Settings 166
Controller Units

GPI 177

Proprietary 167

Settings 166



Conventions 13
Create Cue List Toolbar 73
cross-fade 113
Cue
Audio Gain Matrix 125
Red Border 35
Cue / Cue List Context Menu 44
Cue # corresponds to the Cue | 178
Cue # corresponds to the Cue Inde 178
Cue Audition Settings 156
Cue Browser Cue List 42
Cue Capabilities 50
Cue Fire Buttons 35, 92
Cue Gain 121
Cue List
Detail 37
Pane 33
Properties 94
Selecting 37
Types 36
Cue List Menu 131
Cue List Properties 94
Audio Section 97
Cue List Section 94
Custom Keys Section 96
Hot Keys Section 95
TimeCode Generator Section 95
Timed Cue List Section 95
Cue List Toolbar 72
Cue Lists 32
Hidden 95
Multiple 32
Cue Menu 133
Cue Properties 98
Audio Section 102
COM Command Section 105
Cue Section 99
Custom Key Section 101
GPO Section 105
Hot Key Section 100
IP Command Section 105
Markers Section 99
Microphone Switch Section 102
MIDI Command Section 103
MIDI File Section 103
Mixer Automation Section 107
MMC Section 103
Shell Command / Script / Batch Section 106
Sony P2 / RS422 Section 105
TimeCode Generator Section 103
Timed Cue Section 100
Cue Toolbar 73
Cue Trimmer 79
Cuelist
Fire Toolbar 36
Cues 43
Changing Properties for Multiple Cues 185
Compound 51
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Copying 44
Empty 51
GPI 51
Microphone Switch 51
MIDI 51
Mixer Automation 51
Multiple, Changing Properties 185
Selecting 44
Custom Keyboard Shortcuts 199
Custom Keys
Color and Font 40
Design Mode 40
Grid Size 40
Custom Keys Cue List 40

D

Dataton Synchronization 51, 110, 177
Default 184
Stop Fade Out 184
Default Keyboard Shortcuts 195
Default Player 184
Delay Compensation Policy 148
Delay Launch 29, 91
Digital Audio Synchronization and TimeCode 189
Disable Mix Down 146
Disable Punch in/fout 146
DMX 512 / CMX Lighting Control 29
DMX Commands 224
Documentation 13
Drag & Drop 184
drag and drop 44
Driver Signing 190
DSD Peak Filter 145
DSP Power Saving 146
DSP Time Saving 146

E

Edit Toolbar 33
Editing with Pyramix 56
Effective Sampling Rate 141
Effective TC Frame Rate 141
Effective Video Frame Rate 141
EMC Mixer remote control configuration 151
Emergency - Show Menus and Toolbars 75
Empty Cue
Long 34
Short 34
Empty Cues 51
Enabling Ovation 191
Entering Keys 191
Ethernet 162
Evaluation Mode 12
External Applications 55
External Audio D/A-A/D Converter Boxes 187
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F

Fade Modifier 184
Files
Ovation 129
Fire 135
Fire Buttons, Cue 35
Fire Command 61
Fire Toolbar 74
Fire/Start Timed List 28
flac 193
FLAC Decoding 193
Flashing Mode 92
Flux VS3/V3 plug-ins 190
Focused Cue Flashing Mode 92
Formats & Sync 140
Presets 141
Frequencies 141

G

Gain Matrix 125

General MIDI Command 51, 107

General MIDI Media Sequencer Mode Commands Map-
ping 219

General MIDI Media Server Mode Commands Mapping
220

General Settings 140

GM Media Sequencer Commands Mapping 222

GM Media Server Commands Mapping 223

GPI Commands 225

GPI Trigger Options 179

GPI/O Interfaces 164

GPO Cue Properties 105

GPO output 29

H

Hard Disk Space Requirements 186
HDTDM 187
Help 13, 137
HeptaCon Sample Rate Converter. 154
Hot Browser Cue List 43
Hot Cues - Stopping 38
Hot Keys

Column to Audio Slot Mapping 39
Hot Keys Column to Audio Slot Mapping 96
Hot Keys Cue List 38

Columns 39

Design Mode 38
Hot Keys Mode 23
HTTP Media Sequencer Map 228
HTTP Media Server Map 229
HTTP Request Response 230

I/O Interfaces 142
Icons
Rules 114
Import CD Tracks 44
Import Key 191
Installer 191
Installing Ovation 190
Interaction Rules 111
Internal Buses 147
Internet Protocol Options 176
Introduction 10
P
Controller Unit Settings 176
Player Unit settings 160
port numbers 158
TC/IP Connection Settings 157
IP Address / Server Name Considerations 158
IP Command 51, 108
iTunes 184

K

Keyboard Shortcuts 61, 195
Custom 199
Default 195

L

Latency 12

Launching Ovation 29
Level Meter 144

Link Offsets/Start Times 83
Link Offsets/StartTimes 135
Lock in Active Cue Window 78
Lock Mixer 91

Logging 92

Long Empty Cue 34
Looping 87

Loops 113

M

Main Window 62, 63
Marker Button 79
Markers 85
in Cue Properties 86
Interaction Rules 87
Menu 85
Master Sync 141
Media 29
Media Management 30
Media Manager Settings 153
Media Sequencer Mode available Commands 209
Media Server Mode available Commands 211

Menu
Cue 133
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Cue List 131
Fire 135
Help 137
View 136
Menus 130
Meter Alignment level 144
Meter Decay integration time 145
Meter Headroom setting 144
Meter Permanent Overload 144
Meter Permanent Peak 145
Microphone Switch Cues 51
MIDI and Midi Show Control OVController Commands
Map 216
MIDI Command 107
MIDI Command Learn 108
MIDI Connections 189
MIDI output 29
Midi Player Settings 159
MIDI Settings Player Units 159
Midi Show Control Media Sequencer Mode Commands
Mapping 216
Midi Show Control Media Server Mode Commands map-
ping 217
Minimize Player 204, 207
Mirror all Commands to Remote Ovation Sequencers 201
Mixer 52
Configuration 17
Frozen 91
Lock 91
Record 60
Snapshot Automation 52
Mixer Automation 107
Mixer Automation Cues 51
Mixer Settings 147
Mixing Console
Remote Control 150
Settings 143
MMC Media Sequencer Commands Mapping 221
Modes 31
Mouse Modifier Keys 61, 227
Moving and Copying Cues 44
MP3 193
MT ASIO Bridge 56
MT Security Settings 191
Multi-board installation 187
Multiple Cue Lists 32
Multi-Sequencer Synchronization 30, 51, 93, 109
Mykerinos 187
Back-plate 188
Board /10 187
Board Installation 187

N

Nested and Combined Panes 63
Nested Panes 63

New Show 15
New Users 14
Numeric Fields 89

O

OASIS Mixer remote configuration 151
Ogg Vorbis 193
On-board Analog Audio /O 187
Operating System 186
Other Applications 186
Output Routing 18
Output Slots 124
OV Controller 204
Files 204
User Interface 205
OV Player
Buttons and Toolbars 202
Files 201
Main Screen 202
Media Paths 154
Menus 203
Session menu 203
Toolbars 203
User Interface 202
OV Players 201
Ovation
Files 129
Menus 130
Ovation Keyboard
Settings 167
Ovation Keyboard Media Sequencer Mode Commands
mapping 215
Ovation Keyboard OVController Commands Map 213
Ovation Webserver 180
OVController
Buttons and Toolbars 205
Files 204
Help menu 207
Main Screen 205
Menus 206
User Interface 205
View menu 207
OVController Commands 208
Overview 12
OVKeyboard Settings 167
OVPlayer
Help menu 204
Session menu 206
View menu 204

P

Packaging

Show 116
Packaging Process 117
Panes 63
Panning 18
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Parent Button 43
Parent button 42
Password 91
Pause Timed List 28
Peak and Overload Hold Time 144
Peak level indicator 145
Pin in Active Cue Window 76
Player

Buttons and Toolbars 202

Default 184

Files 201

Menus 203

User Interface 202
Player Units 158

coM 161

GPO 164

Settings 158
Player/Recorder Mode 146
Plug-ins Settings 149
Power Management 186
Precedence 89
Properties Fields 89
Properties Panes 89
Pull-Down 142
Pull-Up 142
Pyramix

Clip Gain 57

Editing Cues in 56

Envelope 57

Q

Query Database 49
QUICKSTART 14

R

RAP (Ross Audio Protocol) 152
Real-time Sampling Rate Conversion 154
Record Audio 58
Record Mixer 60
Recording 58
Recursive Consolidation 119
Redundant Control 201
Refresh buton 42
Refresh Button 43
REMOTE CONTROL
Dataton Synchronization 51, 110
General MIDI Command 51, 107
IP Command 51, 108
Multi-Sequencer Synchronization 51, 109
Remote Control 30
Mixing Console 150
Remote Controlled Ovations 166
replace audio 184
Review while trimming 80
Ross Audio Protocol 152
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Routing Settings 143
Rule
Adding 112
Change Order 112
Removing 112
Updating 112
Rules 184
at Marker 113
Conditional 113
Form 112
Loops 113
Shorthand 114

S

SafeNet dongle 191
Sample and TC Rate Warnings 141
Sample Rate Converter 154
Sampling Rate 141
Sampling Rate Conversion 154
Save Show As Template 130
Save Special 130
Scenes 52
Scope 12
Search Cues Function 42
Security Keys 192
Selecting Cues 44
Settings 137, 138

Application 153

Compressed Media 155
Controller 166

Remote Controlled Ovations 166
Controller Units 166

COM 173

COM (RS422) 173

GPI 177

IP 176

MIDI 171

OVKeyboard 167

Proprietary 167

Web Server 169
Controller units

Proprietary 167
General 153

Audition 156

TC/IP Connections 157
Media Manager 153
Player Units 158

Ethernet 162

GPO 164

IP 160

MIDI 159



Player units
COM 161
Ethernet
Sony P2 over IP 163
Buttons 139
Overview 138
Show 140
General 140
Formats & Sync 140
I/0O Interfaces 142
Routing 143
Mixer
Plug-ins Settings 149
Mixing Console 143
Allocation 143
DSP Power Saving 146
Level Meter 144
Mixer Settings 147
Remote Control 150

TimeCode 143
Toolbar 75
Settings hierarchy 184
Shell Commands/Scripts/Batch files output 29
Short Empty Cue 34
Show 32
Auto Start 91
Consolidate 116
Consolidation 116
Controls 69
Package 117
Validation Tool 115
Show Logging 92
Show Menu 130
Show Menus and Toolbars in Emergency 75
Show Mode 31
Show Password 91
Show Properties 90
Multi-Sequencer Synchronization Section 93
Show Section 91
Show Start Time 91
Show Time Mode Section 91
Show Time Options 91
TimeCode Generator Section 92
Show Toolbar 71
Sibling 113
Simple Rules 111
Simple Show 14
Slots Allocation 143
Snapshot Automation 52
Software Key 191
Sony P2 / RS422 output 29
Sony P2 over IP
Prerequisites 162
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Settings 163
Sony P2 Protocol controller 173
Special Modes 146
Standard Cue List 37
Start Show 31
Start Timed List 28
Starting a Show With Sysex 185
Starting Pyramix 192
Stereo Pan Law 147
Stop Timed List 28
Stopping Hot Cues 38
Strip Meters
Characteristics 144
Support 13
Suppress
Popups Confirmations 92
Saving Confirmations 92
Show Mode Confirmations 92
Sync, Video and Time Code Connections 189
System Requirements 186

T

Time Code and Video Sync Option 188
TimeCode Reader 122
TimeCode Settings 143
Timed Cue List 25, 38
Timed List

Chase 27

Fire/Start 28

Pause 28

Start 28

Stop 28
Tips and Tricks 184
Toolbar

Create Cue List 73

Cue 73

Fire 74

Settings 75
Toolbar Context Menu 66
Toolbars 66
ToolTips 13
Triggering Hot Keys 40
Trim with the Mouse 80

U

User Interface 61
User Interface Options 61

\%

Varispeed 142

VB VS3 plug-ins 190

Video/TimeCode Synchronization 142
View Menu 136

Virtual COM Port selection conflict 158
VS3 Control Panel 56
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W Webserver 180
Web Server %
Settings 169
Web Server Commands 228 YourPersonalKey 191
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